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Warranty

Each instrument manufactured by GE Infrastructure Sensing, 
Inc.  is warranted to be free from defects in material and 
workmanship. Liability under this warranty is limited to 
restoring the instrument to normal operation or replacing the 
instrument, at the sole discretion of GE Infrastructure Sensing, 
Inc. Fuses and batteries are specifically excluded from any 
liability. This warranty is effective from the date of delivery to 
the original purchaser. If GE Infrastructure Sensing, Inc. 
determines that the equipment was defective, the warranty 
period is:

• one year from delivery for electronic or mechanical failures

• one year from delivery for sensor shelf life

If GE Infrastructure Sensing, Inc. determines that the 
equipment was damaged by misuse, improper installation, the 
use of unauthorized replacement parts, or operating 
conditions outside the guidelines specified by GE 
Infrastructure Sensing, Inc. , the repairs are not covered under 
this warranty.

The warranties set forth herein are exclusive and are in lieu 
of all other warranties whether statutory, express or 

implied (including warranties or merchantability and fitness 
for a particular purpose, and warranties arising from course 

of dealing or usage or trade).
iii
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Return Policy

If a GE Infrastructure Sensing, Inc. instrument malfunctions 
within the warranty period, the following procedure must be 
completed:

1. Notify GE Infrastructure Sensing, Inc., giving full details of 
the problem, and provide the model number and serial 
number of the instrument. If the nature of the problem 
indicates the need for factory service, GE Infrastructure 
Sensing, Inc. will issue a RETURN AUTHORIZATION NUMBER 
(RAN), and shipping instructions for the return of the 
instrument to a service center will be provided.

2. If GE Infrastructure Sensing, Inc. instructs you to send your 
instrument to a service center, it must be shipped prepaid 
to the authorized repair station indicated in the shipping 
instructions.

3. Upon receipt, GE Infrastructure Sensing, Inc. will evaluate 
the instrument to determine the cause of the malfunction.

Then, one of the following courses of action will then be taken:

• If the damage is covered under the terms of the warranty, 
the instrument will be repaired at no cost to the owner and 
returned.

• If GE Infrastructure Sensing, Inc. determines that the 
damage is not covered under the terms of the warranty, or 
if the warranty has expired, an estimate for the cost of the 
repairs at standard rates will be provided. Upon receipt of 
the owner’s approval to proceed, the instrument will be 
repaired and returned.
iv
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Chapter 1

Features and Capabilities

The TransPort® Model PT878GC is a transit-time clamp-on gas 
flowmeter which combines all the features of a full-size gas 
flowmeter with the advantages of a portable instrument.

This section describes the TransPort features and general system,  
and explains the theory of operation.

Overview

The PT878GC is available in two models. While the PT878GC-
01 covers pipe sizes from 3/4 in. to 12 in. (20 to 300 mm), the 
PT878GC-02 covers pipe sizes from 4 to 24 in. (100 to 300 mm). 
(To identify your PT878GC, refer to the label on the back of the 
electronics unit, shown in Figure 3-2 on page 3-3.) The flowmeter 
provides one linear 0/4-20 mA analog output of flow velocities or 
volumetric flow rate of clean, dry gases, measuring velocities 
from ±1 to ±120 ft/sec (±0.3 to ±40 m/sec), along with one 
selectable frequency or pulsed totalizer output. Figure 1-1 
illustrates the PT878GC in use on a typical pipe, along with the 
case for the PT878GC and accessories.

Figure 1-1: PT878GC in Use and in Case
Features and Capabilities 1-1
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Overview (cont.)

The TransPort has the ability to store site data in files which can 
be accessed at a later time. Within the Main Menu, a set of forms 
(windows) asks you all the necessary setup information for a 
particular site. Once you answer the necessary questions, you 
simply save the information to a file.

The TransPort stores these files and other data in non-volatile 
memory, which retains the information even if power is turned 
off. The flowmeter itself runs on rechargeable or alkaline 
batteries for up to 8 hours.

This small, lightweight flowmeter displays measurements in both 
numeric and graphical form on a 240 x 200 pixel, EL-backlit 
LCD graphic screen. The TransPort also has the capability of 
logging over 100,000 flow data points internally.

Using an infrared communications port, the TransPort can 
transmit or print logged data, as well as site files, real time data 
and other stored data.  

To assist you, the TransPort is fully equipped with context-
sensitive on-line help which is accessible at any time by simply 
pressing the  “?” (Help) key. Internal diagnostic and 
troubleshooting features help isolate and remedy common 
flowcell and transducer problems.
1-2 Features and Capabilities
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System Description

The TransPort is only one part of the flowmeter system. The other 
part of the system is the flowcell, which consists of the pipe and 
the transducers. 

The Flowcell

The flowcell is that part of the system that uses ultrasonic pulses 
to interrogate the flow. It consists of the flowcell pipe and the 
transducers.

A. FLOWCELL PIPE - The flowcell can either be created in the 
existing piping (for example, by clamping non-wetted 
transducers onto the pipe), or inserted as a substitute pipe 
section (spoolpiece). The flowcell must provide mechanical 
support for the transducers and assure stable conditions for 
accurate flow measurement.

B. TRANSDUCERS - The transducers convert electrical energy 
into ultrasonic pulses when in a transmit cycle, and convert 
the ultrasonic pulses back to electrical energy when in a 
receive cycle. In other words, they act like loudspeakers when 
transmitting the signal and microphones when receiving it. In 
the TransPort system, each transducer acts as both a receiver 
and transmitter, since a series of ultrasonic pulses are 
alternately sent upstream and then downstream through the 
flowcell.
Features and Capabilities 1-3
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Electronics Package

The TransPort consists of circuits that generate, receive, and 
measure the travel time of the ultrasonic pulses. It also contains a 
microcomputer that controls operation and calculates flow 
measurement parameters. Specific circuits function as follows:

A. TRANSMIT SIGNAL GENERATOR - The transmit signal 
generator, under control of the microcomputer and timing 
circuit, synthesizes the signal that drives the transmitter.

B. TRANSMITTER - The transmitter amplifies the signals from 
the transmit signal generator to a signal that drives the 
transmit transducer.

C. RECEIVER - The receiver amplifies the received signals to a 
level suitable for the data acquisition circuitry.

D. DATA ACQUISITION - The data acquisition circuitry 
digitizes the received signal and stores it in a buffer for 
processing by the microcomputer.

E. TIMING CIRCUIT - The timing circuit generates the 
transmitter frequency, receive window, controls the data 
acquisition circuit and the direction of the transmission.

F.  MICROCOMPUTER - The microcomputer controls the 
TransPort flowmeter’s operation and calculates flow 
measurements derived from the transmitted and digitized 
received signals. Also, the microcomputer continually checks 
for faults and allows the use of built-in diagnostics for 
troubleshooting.

G.  INPUT/OUTPUT - The input/output circuitry allows the 
flowmeter to indicate the measured flow with the 
0/4 to 20-mA current loop, and to output to a printer or other 
remote device.
1-4 Features and Capabilities
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Theory of Operation

The TransPort is a transit-time ultrasonic flowmeter. When 
ultrasonic pulses are transmitted through a moving liquid or gas, 
the pulses that travel in the same direction as the fluid flow 
(downstream) travel slightly faster than the pulses that travel 
against the flow (upstream). The TransPort uses various digital 
signal processing techniques, including cross-correlation, to 
determine transit times and then uses the difference in transit 
times to calculate flow velocity.

During operation, two transducers serve as both ultrasonic signal 
generators and receivers. When mounted on a pipe, they are in 
acoustic communication with each other, so that each transducer 
can receive ultrasonic signals transmitted by the other transducer. 
Each transducer thus functions as a transmitter generating a 
certain number of acoustic pulses, and as a receiver for an 
identical number of pulses.

The flowmeter measures the time interval between transmission 
and reception of the ultrasonic signals in both directions. When 
the gas in the pipe is not flowing, the transit-time downstream 
equals the transit-time upstream. When the gas is flowing, the 
transit-time downstream is less than the transit-time upstream. 
The difference between the downstream and upstream transit-
times is proportional to the velocity of the flowing gas, and its 
sign indicates the direction of flow.
Features and Capabilities 1-5



April 2009
Chapter 2

Initial Setup

Before making measurements, you must prepare the TransPort 
for operation. This includes the following procedures:

• Making Electrical Connections

• Charging and/or Replacing Batteries

• Powering On and Off

• Using the Screen and Keypad

• Obtaining On-Line Help

Figure 2-1 below shows the PT878GC in its specially designed 
case. 

Figure 2-1: The PT878GC and Accessories
Initial Setup 2-1
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Making Electrical Connections

Before making measurements with the TransPort, you must make 
all the necessary connections to the unit. This section describes 
how to connect the following:

• Power
• Transducer
• Analog Input/Output
• Infrared Interface

Make all connections to the top of the TransPort unit as shown in 
Figure 2-2 below. Please note that you only need to make the 
proper transducer connections. The other connections are 
required for particular functions, but are not necessary for basic 
operation.

Figure 2-2: Connection Locations

XDCR

DownstreamUpstream

Infrared
Transceiver

 Input/Output
(See Table 2-1

Power

 on page 2-4)
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Power Connections

The PT878GC is powered by either a 100-120/200-260 VAC wall 
mount plug-in module, or by 5 internal Cs-size NiCad high-
energy rechargeable batteries or by a pack of 3.0 Ahr NiMH 
batteries. (An optional power supplement, part #703-1283, uses 6 
AA alkaline batteries.) When you receive the PT878GC, the 
batteries are not charged; therefore, to make remote 
measurements using the batteries, follow the instructions on 
page 2-5 to charge the batteries. In either case, you must connect 
the power cord to the appropriate terminal as shown in Figure 2-2 
above.

!WARNING!
 To ensure the safe operation of the TransPort, you 

must install and operate it as described in this manual. 
In addition, be sure to follow all applicable safety codes 

and regulations for installing electrical equipment in 
your area.

Transducer Connections

The transducer cables connect to the TransPort with LEMO® 
coaxial type connectors. Each color-coded cable has a collar 
labeled UPSTREAM or DOWNSTREAM. Make transducer 
cable connections to the top of the flowmeter as shown in Figure 
2-2 on the previous page. Transducer installation is discussed 
separately in Chapter 3.

Analog Input/Output Connections

The TransPort provides one 0/4-20 mA current output and two 
4 to 20-mA analog inputs with switchable 16-V supply for
loop- powered temperature transmitters. Connect the inputs/
outputs using a LEMO® multi-pin connector as shown in Figure 
2-2 on the previous page. The pin numbers for the connector and 
the color code for the standard input/output cable are shown in 
Table 2-1 on the next page.
Initial Setup 2-3
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Analog Input/Output Connections (cont.)

The Infrared Wireless Interface

The PT878GC comes equipped with an internal infrared 
transceiver (see Figure 2-2 on page 2-2) that enables 
communication between the meter and other IR devices, 
particularly the IR ports or dongles (IR to RS232 adapters) of 
Windows®-based PCs. Users can send and receive site and log 
data.  The PT878GC was designed for use with products that 
comply to the IrDA protocol. For more information on 
establishing IR communications between the PT878GC and your 
PC, refer to Appendix B.

Table 2-1:   Cable Assembly for Analog Inputs/Outputs
Pin Number Wire Color Description

1  Black  Analog Out 1
2  Red 16 V (switched)
3 White Input A (Temperature or Pressure)
4 Yellow Input B (Temperature or Pressure)
5 Green Analog Ground
6 Orange Digital Output 
7 Blue Digital Ground 
8 Violet Receive Monitor
2-4 Initial Setup
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Charging and/or Replacing Batteries
The PT878GC comes with self-contained, built-in rechargeable 
batteries to support portable operation. For optimum 
performance, these batteries require a minimum of maintenance.

Charging the Batteries

When you receive the PT878GC, you will need to initially charge 
the batteries. The batteries must be charged up to 8 hours to 
receive the maximum charge. When fully charged, the batteries 
provide 8 hours of continuous operation. An internal battery 
gauge indicates the remaining power in the batteries.
To charge the batteries, simply plug the AC power module cord 
into the power jack (shown in Figure 2-2 on page 2-2) and be sure 
the battery pack is installed. When the PT878GC is plugged into 
line voltage, the internal battery charger automatically charges 
the batteries, whether the PT878GC is on or off. If the PT878GC 
is on, the Battery icon in the upper right corner of the screen 
indicates battery status (as shown in Table 2-2 below).

IMPORTANT: For CE compliance, the PT878GC is classified 
as a battery-powered device, not to be used with 
the AC adaptor.

Table 2-2:  Battery Status Icons
Icon Battery Status

Full battery
Partially full battery
Empty battery
Fully charged battery,
connected to AC power
Charging battery

Discharging battery

Failure/missing battery
Notification to check battery 
form (see page 7-5)
Initial Setup 2-5
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Replacing the Batteries

Caution!
 Replace batteries only with the specified rechargeable 

batteries. The battery charges when the unit is off.  Do not 
attempt to recharge non-rechargeable batteries.  

If you need to replace the rechargeable batteries, use 5 Cs-size 
NiCad high energy rechargeable batteries (GE Sensing Part 
Number 200-058) or 3.0 Ahr NiMH batteries (part number 200-
081). To replace the batteries, remove the rubber boot, open the 
panel located on the back of the PT878GC unit, disconnect the 
batteries, and replace with new ones (see Figure 2-3 below). 

Figure 2-3: Rear View of PT878GC

To further extend the battery power on the PT878GC, the GE 
Sensing Part #705-1283 power pack option uses 6 AA alkaline 
batteries.

Battery Location
(Behind Panel)
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Powering On and Off

To operate the PT878GC, the power cord must be plugged into 
line voltage or the battery must be charged as described 
previously.

IMPORTANT: For CE compliance, the PT878GC is classified 
as a battery-powered device, and cannot be used 
with the AC adaptor.

To turn the meter on, press the red button in the upper-right-hand 
corner of the keypad. Immediately upon power up the PT878GC 
emits a short beep and displays a “PCI Loader” message. It then 
validates the instrument programming, and then displays the GE 
Sensing logo and the software version and emits a long beep. If 
the meter fails any of these tests, contact GE Sensing.

Caution!
If the meter fails the backup battery test, you must send 
the unit back to the factory for a battery replacement. 

Make sure you keep the NiCad batteries charged until you 
are ready to ship the unit back to the factory. Before 

shipping, print out all the log and site data, or transfer it to 
your PC, as this data will be lost during the service 

procedure.  
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Powering On and Off (cont.)

After the meter conducts all the self checks, the screen then 
appears similar to the one shown in Figure 2-4 below.  

Figure 2-4: Screen After Powering On

2004/11/30    09:53 AM

Velocity, ft/s Signal, dB

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

ABC.SIT
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Powering On and Off (cont.)

To turn the PT878GC off, press the red key for 3 seconds. The 
screen now appears similar to Figure 2-5 below. 

Figure 2-5: The Shutdown Menu

Three options are available:

• Press [F1] to shut down the PT878GC, turning it completely 
off.

• Press [F2] to send the PT878GC into sleep mode. In this mode, 
some of the power supplies shut down, but the PT878GC 
remains in a standby mode. Users can resume taking 
measurements immediately by pressing the power button.

• Press [F3] to cancel the command and return the PT878GC to 
normal operation.

If the PT878GC locks up, you can reset it by holding the power 
key (the red key in the upper right corner) for 15 seconds.

Velocity, ft/s Signal, dB

Delta-T, ns Volume, l/s

Resume

SHUTDOWN: Meter OFF
SLEEP: Meter Idle
CANCEL: Resume Operations 

Shutdown Sleep
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Using the Screen and Keypad

The essential features for operating the TransPort are the screen 
and keypad. Although these features are common on portable 
instruments, the PT878GC design offers unique features to 
simplify and speed operation.

Screen

The primary function of the screen is to display information in 
order for you to accurately and easily take measurements. The 
TransPort screen consists of seven parts (see Figure 2-6 below).

Figure 2-6: The PT878GC Screen in Operate Mode

The top line of the screen is the status bar, which normally 
displays the time, date and current site. However, when you press 
[MENU] (the menu key), the Menu Bar replaces the status bar.  

2000/11/30    09:53 AM

Velocity, ft/s Signal, dB

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

Status Bar
(alternates with 

Error Messages
Function Keys

Menu Bar)
DEFAULT

Current
Site

Battery
Status

System

(Work
Area)

Tray
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Screen (cont).

The middle of the screen is the work area, which displays the 
measured parameters, numeric measurements, and both bar and 
line graphs. (When you enter a selection on the Main Menu 
discussed in Chapter 4, Programming Site Data, this area 
displays menu prompts.)  A line at the bottom of the area also 
displays error code messages, which are described in more detail 
in Chapter 10, Diagnostics and Troubleshooting.

The system tray, shown in Figure 2-6 on page 2-10, displays 
icons that indicate meter operations not otherwise shown. Table 
2-3 below lists the icons and their meanings.

The bottom of the screen displays the three feature key options: 
F1, F2 and F3. The feature keys have different functions, 
depending on the task you are performing.

Table 2-3:  Icons in the System Tray
Icon Function Meaning

IR Transfer IR data transfer in progress.

Alert Indicates the meter encoun-
tered an error in operation.

Log Running Indicates a log is running 
(marks).

Log Pending Indicates a log is pending (no 
marks).

Stopwatch Calibration Gate Operation: 
Watch is stopped when the 
gate is closed, or runs when it 
is open. (See page 3-46.)

Snapshot
(To file)

Indicates that the Snapshot 
function has been activated, 
so users can take screen cap-
tures (see page 6-23).

(To Printer)
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Keypad

The PT878GC keypad has 25 keys. The functions for each key 
are as follows (see Figure 2-7 on the next page):

• 3 function keys ([F1], [F2], [F3]) —  enable you to select the 
special functions which appear at the bottom of the screen.

• 12 numeric keys (including - and .) —  enable you to enter 
numeric data.

• 4  arrow keys ([ ], [ ], [ ], [ ]) — enable you to move 
through the menu options.

•  [?] — Help key enables you to access on-line help.

• [MENU] — Menu key enables you to access the Menu Bar.

• [ENTER]  —  enables you to enter a particular menu, and enters 
selected values into the TransPort memory.

• [SEL] — enables you to move between data measurements on 
the screen.

• [ESC] — enables you to exit menus or menu options at any 
time; cancels numeric entry.

• Red key [    ] turns the power on or off, and toggles the 
backlight on or off.
2-12 Initial Setup
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Keypad (cont.)

Figure 2-7: The TransPort PT878GC Keypad
Initial Setup 2-13
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Obtaining On-Line Help

The TransPort offers on-line help screens that describe various 
features. You can access on-line help at any time by pressing the 
[?] key. The screen appears similar to Figure 2-8 below.

Figure 2-8: The Main Help Menu

Use the three function keys and the [ ] and [ ] arrow keys to 
navigate to the desired menu, and press [ENTER]. Repeat this 
procedure to access the desired topic within the menu. When you 
have finished using the Help menu:.

• Press [F1], Back, to move back one level.

• Press [F2], TOC, to return to the Table of Contents.

• Press [F3], Close, to return to the previous screen.

Velocity, ft/s Signal, dB
Help

Table of Contents

Back TOC Close

Site Menu 
Program Menu 
Meter Menu 
Log Menu
Service Menu 
Miscellaneous

Use the arrows and the enter key to
select from the links below. Press [F2]
to return to the TOC.

About
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Chapter 3

Installing the Dampening Material, 
Transducers and Fixtures

Since the PT878GC is specifically designed for gas measurement 
with clamp-on transducers, it requires the use of specially 
designed fixtures and dampening material to maintain the highest 
possible measurement accuracy. GE Sensing supplies the CFG 
series of fixtures: 

• The V1 clamping fixture for pipes with diameters between 
0.75 and 1.25 in. (20 to 30 mm).

• The V4 clamping fixture for pipes with diameters between 
1.25 and 4 in. (30 to 100 mm). 

• The V8 clamping fixture for pipes from 4 to 8 in. (100 to 
200 mm).

• The V12 clamping fixture for pipes from 8 to 12 in. (200 to 
300 mm).

• The PI clamping fixture for pipes from 12 to 24 in. (300 to 
600 mm).

Figure 3-1 on the next page illustrates the V series and PI fixture 
assemblies. Complete the steps in the following sections to 
position and install the transducers, fixtures and dampening 
material.
Installing the Dampening Material, Transducers and Fixtures 3-1
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Figure 3-1: The V Series and PI Fixtures

Choosing the transducer installation locations on the pipe is an 
important aspect of proper flow measurement. Specifications 
assume a fully developed flow profile typically requiring 20 
diameters upstream and 10 diameters downstream of straight pipe 
run. In addition, pipes 2 in. and under require an installation 
location with a minimum of 10 ft (3 m) of continuous straight 
pipe without flanges, welds or coupling joints.

PI Fixture
Layout Wrap

Chain
Strap

Dummy
Block

CFG-V4

CFG-V1

CFG-V8 CFG-V12

CFG-V1

CFG-V8
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Application Requirements

Before you begin to use the PT878GC, you should ensure that 
your meter can handle the frequencies required for your particular 
application. To check the capabilities of your particular 
PT878GC, refer to the back label of the PT878GC, shown in 
Figure 3-2 below. The gray label below “Communication” lists 
the meter type and transducer frequency the PT878GC can 
support. 

Figure 3-2: PT878GC Back Label

In addition to checking the available frequencies, you should 
determine that your application meets the minimum gas pressure 
and maximum flow velocity range requirements for optimal 
measurements, given the pipe size and pipe thickness. The tables 
on the following pages list the minimum pipe sizes, schedules, 
and pressures for use with the PT878GC. 
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Application Requirements (cont.)

• For air, nitrogen, oxygen or argon, refer to Table 3-1 on the 
next page. 

• For natural gas, refer to Table 3-2 on page 3-7. 

• For steam, refer to Table 3-3 on page 3-9. 

1. Find the pipe size of your application

2. Then find the pipe wall thickness of your application.

3. With the pipe size and pipe wall thickness, determine if your 
application meets the minimum pressure requirements. 

4. Use the same row in the appropriate table to determine the 
maximum flow velocity capability of the PT878GC. For 
reference, the table provides the recommended number of 
traverses and transducer frequency for your application. 

Note: All provided data is based on metal pipes; plastic pipes 
have a minimum pressure requirement of ambient air or 
any non-attenuating gas with a minimum density of 0.074 
lbs/cf (1.185 kg/m3). Consult the factory for applications 
involving natural gas with sulfur or high carbon dioxide 
content, or for applications not listed in the tables.
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Table 3-1:  PT878GC Installation Requirements for Air, Nitrogen, Oxygen or Argon

ity, ft/s (m/s)

 
e

Four 
Traverse

Five 
Traverse

) — 90 (27.4)
) — 90 (27.4)
) — 57 (17.4)
) — 45 (13.7)
) 46 (14.0) —

) 35 (10.7) —

) — —

)
5) 
)

5) 
)
) — —
)
)
)
)
)
) — —
)
)
)
)
)
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Pipe Size ANSI (DIN) Pipe Wall Inches (mm)
Transducer 

MHz
Min. Pressure 

psig (bar)

Maximum Veloc

Single 
Traverse

Dual 
Traverse

Triple
Travers

3/4 (20) <0.07 (1.8) 1 60 (5.1) — — 90 (27.4
1 (25) <0.14 (3.6) 1 60 (5.1) — — 90 (27.4

1 1/2 (40) <0.15 (3.8) 1 60 (5.1) — — 90 (27.4
2 (50) <0.16 (4.1) 1 60 (5.1) 90 (27.4) — 75 (22.9
3 (75) <0.2 1 60 (5.1) 120 (36.6) — 69 (21.0

<0.22 (5.6) 0.5
4 (100) <0.2 1 60 (5.1) 120 (36.6) — 53 (16.2

<0.24 (6.1) 0.5 60 (5.1)
<0.34 (8.6) 0.5 180 (13.4)
<0.68 (17.3) 0.5 300 (21.7)

6 (150) <0.2 1 60 (5.1) 90 (27.4) 72 (22.0) 54 (16.5
<0.28 (7.2) 0.5 60 (5.1)

0.2 200 (13.6) 135  (41.5) 108 (32.9) 81 (24.7
<0.44 (11.2) 0.5 180 (13.4) 90  (27.4) 72  (22.0) 54  (16.

0.2 600 (40.8) 135  (41.5) 108 (32.9) 81 (24.7
<0.87 (22.1) 0.5 300 (21.7) 90  (27.4) 72  (22.0) 54  (16.

0.2 1000 (68) 135  (41.5) 108 (32.9) 81 (24.7
8 (200) <0.33 (8.4) 0.5 60 (5.1) 80 (24.4) 64 (19.5) 48 (14.6

0.2 200 (13.6) 120 (36.6) 96 (29.3) 72 (21.9
<0.50 (12.7) 0.5 180 (13.4) 80 (24.4) 64 (19.5) 48 (14.6

0.2 600 (40.8) 120 (36.6) 96 (29.3) 72 (21.9
<0.88 (22.4) 0.5 300 (21.7) 80 (24.4) 64 (19.5) 48 (14.6

0.2 1000 (68) 120 (36.6) 96 (29.3) 72 (21.9
10 (250) <0.37 (9.4) 0.5 60 (5.1) 70 (21.3) 56 (17.1) 42 (12.8

0.2 200 (13.6) 105 (32) 84 (25.6) 63 (19.2
<0.50 (12.7) 0.5 180 (13.4) 70 (21.3) 56 (17.1) 42 (12.8

0.2 600 (40.8) 105 (32) 84 (25.6) 63 (19.2
<1.00 (25.4) 0.5 300 (21.7) 70 (21.3) 56 (17.1) 42 (12.8

0.2 1000 (68) 105 (32) 84 (25.6) 63 (19.2
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) — —
)
)
)
)
)

) — —

) — —

) — —

) — —

) — —

Table 3-1:  PT878GC Installation Requirements for Air, Nitrogen, Oxygen or Argon (Continued)

ity, ft/s (m/s)

 
e

Four 
Traverse

Five 
Traverse
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12 (300) <0.38 (9.7) 0.5 60 (5.1) 55 (16.8) 44 (13.4) 33 (10.1
0.2 200 (13.6) 82 (25) 66 (20.1) 49 (14.9

<0.50 (12.7) 0.5 180 (13.4) 55 (16.8) 44 (13.4) 33 (10.1
0.2 600 (40.8) 82 (25) 66 (20.1) 49 (14.9

<1.00 (25.4) 0.5 300 (21.7) 55 (16.8) 44 (13.4) 33 (10.1
0.2 1000 (68) 82 (25) 66 (20.1) 49 (14.9

14 (350) <0.38 (9.7) 0.2 90 (7.2) 87 (26.5) 70 (21.3) 52 (15.9
<0.50 (12.7) 0.2 270 (19.6)

16 (400) <0.38 (9.7) 0.2 90 (7.2) 76 (23.2) 61 (18.9) 45 (13.7
<0.50 (12.7) 0.2 270 (19.6)

18 (450) <0.38 (9.7) 0.2 90 (7.2) 67 (20.4) 54 (16.5) 40 (12.2
<0.50 (12.7) 0.2 270 (19.6)

20 (500) <0.38 (9.7) 0.2 90 (7.2) 60 (18.3) 48 (14.6) 36 (11.0
<0.50 (12.7) 0.2 270 (19.6)

24 (600) <0.38 (9.7) 0.2 90 (7.2) 49 (14.9) 39 (11.9) 29 (8.8
<0.50 (12.7) 0.2 270 (19.6)

Pipe Size ANSI (DIN) Pipe Wall Inches (mm)
Transducer 

MHz
Min. Pressure 

psig (bar)

Maximum Veloc

Single 
Traverse

Dual 
Traverse

Triple
Travers
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Table 3-2:  PT878GC Installation Requirements for Natural Gas

s (m/s)

le Traverse Four Traverse
6 (20.5)
2 (22.0) 48 (14.6)
2 (22.0) 48 (14.6)

2 (22.0)
08 (32.9)
2 (22.0)

08 (32.9)
2 (22.0)

08 (32.9)
0 (18.3)
0 (27.4)
0 (18.3)
0 (27.4)
0 (18.3)
0 (27.4)
1 (15.6)
5 (22.0)
1 (15.6)
5 (22.0)
1 (15.6)
5 (22.0)
2 (12.8)
3 (19.2)
2 (12.8)
3 (19.2)
2 (12.8)
3 (19.2)
2 (18.9)

4 (16.5)
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Pipe Size ANSI 
(DIN)

Pipe Wall Inches 
(mm)

Transducer 
MHz

Min. Pressure 
psig (bar)

Maximum Velocity, ft/

Single Traverse Dual Traverse Trip
2 (50) <0.16 (4.1) 0.5 200 (14.8) 110 (33.5) 88 (26.8) 6
3 (75) <0.22 (5.6) 0.5 200 (14.8) 120 (36.6) 96 (29.3) 7

4 (100) <0.24 (6.1) 0.5 150 (11.4) 120 (36.6) 96 (29.3) 7
<0.34 (8.6) 0.5 400 (28.6)

<0.68 (17.3) 0.5 800 (56.2)
6 (150) <0.28 (7.2) 0.5 150 (11.4) 120 (36.6) 96 (29.3) 7

0.2 250 (17) 180 (54.9) 144 (43.9) 1
<0.44 (11.2) 0.5 400 (28.6) 120 (36.6) 96 (29.3) 7

0.2 500 (34) 180 (54.9) 144 (43.9) 1
<0.87 (22.1) 0.5 800 (56.2) 120 (36.6) 96 (29.3) 7

0.2 1000 (68) 180 (54.9) 144 (43.9) 1
8 (200) <0.33 (8.4) 0.5 175 (13.1) 100 (30.5) 80 (24.4) 6

0.2 250 (17) 150 (45.7) 120 (36.6) 9
<0.50 (12.7) 0.5 400 (28.6) 100 (30.5) 80 (24.4) 6

0.2 500 (34) 150 (45.7) 120 (36.6) 9
<0.88 (22.4) 0.5 800 (56.2) 100 (30.5) 80 (24.4) 6

0.2 1000 (68) 150 (45.7) 120 (36.6) 9
10 (250) <0.37 (9.4) 0.5 200 (14.8) 85 (25.9) 68 (20.7) 5

0.2 300 (20.4) 126 (38.4) 102 (31.1) 7
<0.50 (12.7) 0.5 500 (35.5) 85 (25.9) 68 (20.7) 5

0.2 600 (40.8) 126 (38.4) 109 (31.1) 7
<1.00 (25.4) 0.5 800 (56.2) 85 (25.9) 68 (20.7) 5

0.2 1200 (81.6) 126 (38.4) 102 (31.1) 7
12 (300) <0.38 (9.7) 0.5 200 (14.8) 70 (21.3) 56 (17.1) 4

0.2 300 (20.4) 105 (32) 84  (25.6) 6
<0.50 (12.7) 0.5 500 (35.5) 70 (21.3) 56 (17.1) 4

0.2 600 (40.8) 105 (32) 84  (25.6) 6
<1.00 (25.4) 0.5 800 (56.2) 70 (21.3) 56 (17.1) 4

0.2 1200 (81.6) 105 (32) 84  (25.6) 6
14 (350) <0.38 (9.7) 0.2 300 (21.7) 103 (31.4) 77 (23.5) 6

<0.50 (12.7) 0.2 800 (56.2)
16 (400) <0.38 (9.7) 0.2 300 (21.7) 90 (27.4) 67 (20.4) 5

<0.50 (12.7) 0.2 800 (56.2)
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7 (14.3)

2 (12.8)

4 (10.4)

Table 3-2:  PT878GC Installation Requirements for Natural Gas (Continued)

s (m/s)

le Traverse Four Traverse
Installing the Dampening Material, Transducers and Fixtures

18 (450) <0.38 (9.7) 0.2 300 (21.7) 78 (23.8) 59 (18.0) 4
<0.50 (12.7) 0.2 800 (56.2)

20 (500) <0.38 (9.7) 0.2 300 (21.7) 70 (21.3) 52 (15.9) 4
<0.50 (12.7) 0.2 800 (56.2)

24 (600) <0.38 (9.7) 0.2 300 (21.7) 56 (17.1) 42 (12.8) 3
<0.50 (12.7) 0.2 800 (56.2)

Pipe Size ANSI 
(DIN)

Pipe Wall Inches 
(mm)

Transducer 
MHz

Min. Pressure 
psig (bar)

Maximum Velocity, ft/

Single Traverse Dual Traverse Trip
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Table 3-3:  PT878GC Installation Requirements for Steam

Pipe 
Size in. 
(mm)

Pipe Wall 
Inches 
(mm)

Transducer 
(MHz)

Min. 
Pressure  
psig (bar)

Maximum 
Flow 

Velocity 
ft/s (m/s)

Single 
Traverse

3 (80) <0.22 (5.6) 0.5 110 (8.6) 120 (36.6)
<0.3 (7.6) 0.5 200 (14.8)

4 (100) <0.24 (6.1) 0.5 110 (8.6) 120 (36.6)
<0.34 (8.6) 0.5 200 (14.8)

6 (150) <0.28 (7.2) 0.5 110 (8.6) 120 (36.6)
<0.44 (11.2) 0.5 200 (14.8)

8 (200) <0.33 (8.4) 0.5 120 (9.3) 100 (30.5)
<0.5 (12.7) 0.5 200 (14.8)

10 (250) <0.37 (9.4) 0.5 130 (10.0) 85 (25.9)
<0.5 (12.7) 0.5 200 (14.8)

12 (300) <0.38 (9.7) 0.5 140 (10.7) 70 (21.3)
<0.5 (12.7) 0.5 200 (14.8)
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Preparing the Pipe

1. Locate a transducer measurement point with 20 diameters of 
upstream straight run pipe and 10 diameters of downstream 
straight run pipe. In addition, the point should be at least 10 
diameters from any butt welds or flanges. Keep appropriate 
clearance on either side of the pipe for easy transducer 
installation:

• 150 mm (6 in.) if you are not using a junction box, or

• 225 mm (9 in.) if you are using a junction box.
In general, transducers are installed 180° apart on opposite sides 
of the pipe and in a horizontal plane (at 3 and 9 o’clock). Figure 
3-3 below illustrates the desired acoustic signal projection path 
for general installation; however, additional pipe surveys may 
provide data that can lead to modifications for optimal 
installation.

Figure 3-3:  Desired Projection of Acoustical Signal Path

Transducer Transducer

Pipe

Signal Path

End View
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Performing a Pipe Survey

Finding a location where the pipe is concentric is important for 
optimum accuracy and performance. If possible, perform a pipe 
survey with an ultrasonic thickness gauge to find the best 
location.

2. Clear rust or loose paint and measure the wall thickness at five 
points along the pipe axis at 25 mm (1-in.) intervals using an 
ultrasonic thickness gauge, as shown in Figure 3-4 below. 
Check each point three times and record the mean values. If 
the maximum variation between the five points exceeds 0.25 
mm (0.010 in.), find another location.

Figure 3-4: Measuring Thickness Along the Pipe Axis

3. Measure the outside diameter (OD) of the pipe using a tape 
measure or the supplied layout wrap. Using the entire layout 
tape, mark two circumferential lines along the edges of the 
wrap, as shown in Figure 3-5 below.

Figure 3-5: Measuring and Marking Circumference Lines
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Performing a Pipe Survey (cont.)

4. Now measure the OD and the wall thickness at eight points 
along the pipe circumference at 45° intervals (shown in Figure 
3-6 below), three times per point, and record the mean values.

Figure 3-6: Measuring the OD and Pipe Wall Thickness

5. Prepare the pipe for the dampening material by removing any 
rust or loose paint and sanding down any rough spots in an 
area 12 in. long around the circumference of the pipe. Take 
care to preserve the original pipe curvature.

6. At the approximate location of each transducer, prepare an 
area 100 mm (4 in.) long by 50 mm (2 in.) wide for CRV type 
transducers and 100 mm (4 in.) wide for CRW type 
transducers. Remove any paint or rust, and polish the cleared 
area, taking care to preserve the original curvature of the pipe.

Note: If the paint is in a thin, smooth layer, removal is not 
necessary.

OD1

OD2

OD3

OD4

W1

W2

W3

W4

W8

W7

W6

W5
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Obtaining the Transducer Spacing

1. Using the measured OD and the pipe wall thickness, program 
the PT878GC (discussed in Chapter 4, Programming Site 
Data) to determine the required transducer spacing. 

2. To determine the PT878GC correction factor, calculate the 
mean inside pipe diameter (ID) and the pipe ID at the 
transducer locations. Then divide the square of the mean ID 
by the square of the ID at the transducer location, as shown in 
the equations below, where ODX is the outside diameter at a 
given point, and WX is the wall thickness at a given point (as 
shown in Figure 3-6 on the previous page).

3. Program the value into the PT878GC.

Note: See Chapter 4, Programming Site Data, pages 4-3 to 4-16, 
for more details on programming.

Based on the pipe OD, proceed to the appropriate section:

• If the pipe is < 12” (300 mm), see the section Installing the V 
Series Clamping Fixture and Transducers on the next page. 

• If the pipe is > 12” (300 mm), go to Installing the PI Fixture 
and Transducers on page 3-18.

mean ID OD1 W1 W5+( )–( ) OD2 W2 W6+( )–( )
OD3 W3 W7+( )–( ) OD4 W4 W8+( )–( )

+
+ +

(
) 4⁄

=

Kfor non-concentric pipe
Mean ID2( )

ID at transducer location( )2
-------------------------------------------------------------------=
Installing the Dampening Material, Transducers and Fixtures 3-13



April 2009
Installing the V Series Clamping Fixture and 
Transducers

Note: A complete installation involves the clamping fixture, 
transducers and dampening material. To apply 
dampening material, refer to Installing Dampening 
Material on page 3-25.

To install the V Series clamping fixture and transducers, complete 
the following steps:

Installing the Fixture

1. Position the half of the clamping fixture with the threaded 
rods around the pipe, as shown in Figure 3-7 below. Orient the 
fixture in the 3 o’clock position on a horizontal pipe. 

2. Position the mating half of the fixture over the threaded rods 
in the 9 o’clock position. Figure 3-7 below shows the two 
mounted halves. 

Note: If you are using a V4 fixture with a 1.5 to 2-in. pipe, GE 
Sensing suggests removing the set screws and the 
mounting bracket, rotating them and the transducer yoke 
180°,  and replacing the bracket, yoke and screws for a 
more secure fit.

Figure 3-7: Mounting the Two Halves of the Fixture
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Installing the Fixture (cont.)

The two fixture halves have measuring scales; ensure that the 
scales are on the same side of the fixture, so that both zeros start 
at the same origin, as shown in Figure 3-8 below.

Figure 3-8: Fixture with Scale Origins Properly Aligned

3. Install the four nuts onto the threaded rods with the convex 
side of the nut facing the fixture. Hand tighten the nuts on 
each V block evenly, as shown in Figure 3-9 below. Do not 
use a cross tightening pattern on the four installation nuts.

Figure 3-9: Installing Nuts onto the Fixture

0        1         2         3

0        1         2         3
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Installing the Transducers

1. Apply a bead of couplant 6 mm (0.25 in.) wide along the 
entire length of each transducer face, as shown in Figure 3-10 
below. 

Figure 3-10: Couplant on Transducer Face

Note: Do not slide the transducer with couplant along the 
surface of the pipe when mounting the transducer.

2. Set the first mounting block (either left edge or right edge) at a 
convenient number on the scale, such as 1 in. or 1 cm. Install 
the first transducer with the BNC connector pointing away 
from the center of the V block fixture. Hold down the 
transducer mounting screw onto the insert, which in turn 
applies pressure to the transducer. Use a handtight grip to set 
the transducer in contact with the pipe, as shown in Figure 3-
11 below. Use a wrench to tighten the backing nut to prevent 
loosening due to vibration and thermal expansion. 

IMPORTANT:  Do not use a wrench or pliers on the screw.

Figure 3-11: Installing the First Transducer
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Installing the Transducers (cont.)

3. Slide the second mounting block to the calculated spacing 
plus the initial scale number selected for the first mounting 
block. For example:

a. Initial convenient number for the first mounting block = 
5 cm or 2 in.

b. Spacing as calculated by the PT878GC = 0.5 in. or 12.5 
mm

c. Second mounting block final location = 1 + 0.5 in. = 1.5 in. 
or 1 cm + 1.25 cm = 2.25 cm

The overall spacing between yokes should be left edge to left 
edge, or right edge to right edge. Figure 3-12 below shows typical
positioning.

Figure 3-12: Top View of V4 Fixture 
with Both Transducers

4. In a similar manner, install the second transducer as shown in 
Figure 3-12 above.

S

S
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Installing the PI Fixture and Transducers

The PI clamping fixture holds transducers on pipes from 8 to 24 
in. in diameter. It comes with either a chain or strap, depending 
on the selection made with the initial order from GE Sensing. To 
install the fixture and transducers, complete the following steps:

Surveying the Pipe

1. Measure the pipe circumference to an accuracy of ±2 mm  
(±1/16 in.) 

IMPORTANT: Do not use a calculated value or a nominal value 
for the circumference.

2. Tightly wrap the layout tape once around the entire pipe and 
line up the edges. Using the tape as a template guide for 
marks, mark scribe lines around the entire circumference of 
the pipe, as shown in Figure 3-13 below.

Figure 3-13: Marking Circumferential Lines on the Pipe

3. Line up the zero scale of the layout tape at the desired location 
of the first transducer. (For a typical installation, this point 
will be the 3 o’clock position on a horizontal pipe.) Mark each 
of the two circumferential lines at the zero point. Connect 
each of these marks using a straight edge (for example, the 
edge of the layout tape) as shown in Figure 3-14 on the next 
page.
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Surveying the Pipe (cont.)

Figure 3-14: Marking the 3 o’Clock Position

4. To find the coinciding point on the opposite site of the pipe 
(180° away from each other), divide the measured 
circumference by 2 and measure this distance along the 
circumferential lines from the zero point, as shown in Figure 
3-15 below. Place marks on both sides of the circumferential 
lines made with the layout tape and connect the marks.

Figure 3-15: Marking the 9 o’Clock Position

Make sure to take the 180° point measurement from both over the 
top of the pipe and under the bottom of the pipe (on a horizontal 
pipe) to ensure reciprocity of the installation. Figure 3-16 on the 
next page shows the appropriate way to measure the 180° point.
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Surveying the Pipe (cont.)

Figure 3-16: Measuring the 180° Point 
from Top and Bottom
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Installing the First Bracket with a Chain or Strap

The following steps describe how to install the PI fixture with a 
supplied chain or strap.

1. Carefully wrap the chain or strap around the pipe, taking care 
not to twist it.

2. Loosen the wing nuts up to the end of the J-hooks. Then hook 
the chain into the tightest links and loosely hand tighten the 
wing nuts. If you are using a strap, insert the J-hook into the 
smaller round hole on the strap.

3. Line up one edge of the CFG-PI holder bracket with the origin 
scribe line and fully tighten the chain or strap (see Figures 
3-17 and 3-18 below).

Figure 3-17: Lining up the First Bracket

4. Install the transducer dummy block to verify the 
circumferential and axial location. Center the indicator line on 
the block to line up with the scribed mark (see Figure 3-18 
below).

Figure 3-18: Positioning the CFG-PI Holder Bracket

5. Loosen the transducer hold-down screw and tighten the J-
hooks on the clamping fixture. Be sure the bracket has not 
moved from its position.

Front  Edge of
Holder Bracket

Origin Scribe Line
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Installing the Second Bracket with a Chain or Strap

Note: The following step requires the transducer spacing 
discussed on page 3-7.

1. Measure the spacing from the zero point (the point of 
circumferential origin). Mark the spacing point with a 
crosshair on the opposite side of the pipe, 180° from the zero 
point (as shown in Figure 3-19 below).

Figure 3-19: Measuring and Marking Spacing

2. Carefully wrap the chain or strap around the pipe, taking care 
not to twist it.

3. Loosen the wing nuts up to the end of the J-hooks. Then hook 
the chain into the tightest links and firmly hand tighten the 
wing nuts.

4. Line up the other edge of the CFG-PI holder bracket with the 
scribe line and tighten the chain or strap, as shown in Figure 
3-20 below.

Figure 3-20: Lining up the Rear Edge of the Bracket with the 
180° Scribe Line

Rear Edge of
Second Block

Mark on Opposite
  Scribe Line
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Installing the Second Bracket (cont.)

The spacing should now appear similar to that shown in Figure 
3-21 below.

Figure 3-21: The Installed CFG-PI Fixture, 
with Calculated Spacing

Installing the Transducers

1. Check to be sure the second CFG-PI holder bracket is 
correctly positioned. 

2. Apply a bead of CPL-16 couplant 6 mm (0.25 in.) wide on 
each transducer face. (See Figure 3-22 below.)

Figure 3-22: Couplant on Transducer Face

S
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Installing the Second Bracket (cont.)

Note: Do not slide the transducer with couplant along the 
surface of the pipe when mounting the transducer.

3. With one hand, mount one transducer into the PI fixture. With 
the other hand, tighten the transducer hold down screw, 
gradually pushing the transducer down to the pipe surface. 
Use a wrench to tighten the backing nut to prevent loosening 
due to vibration and thermal expansion. 

IMPORTANT: Do not use pliers or a wrench on the thumbscrew.

4. Repeat step 3 for the other transducer.
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Installing Dampening Material

GE Sensing strongly recommends applying DMP dampening 
material in ALL clamp-on applications to help eliminate short 
circuit noise. The material comes in two versions: 

• The DMP-1 self-adhesive sheet for applications up to 
150°F (66°C). The material comes as two 9.5-in. (24 cm) 
wide sheets cut in sufficient length to cover the pipe 
circumference plus an additional tenth of a circumference. 
The material can be cut with a utility knife, and comes with 
a paper backing that is removed before installation.

• The DMP-3 is a clay-like compound for all temperature 
applications. If the temperature is over 150°F, the PDJ pipe 
dampening jacket (available from GE Sensing with 
preapplied DMP-3) must be used with the material.

At a minimum, you should consider applying dampening material 
if you have any of the following conditions:

• The distance from the nearest butt weld or pipe flange is 
less than 10 ft (3 m);

• The pipe size is under 4 in. (100 mm) diameter and the gas 
pressure is 200 psig (14 barg) or lower; 

• The pipe is deformed,

• The pipe is old, with a history of scaling or rust,

• The pipe experiences condensation on the outside.

Note: Consult a GE Sensing flowmeter applications engineer or 
sales engineer if you have any questions regarding 
dampening material.
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Installing DMP-1 Dampening Material

1. Be sure the CFG-V clamping fixture is installed on the pipe 
with the transducers as described in the section Installing the 
V Series Clamping Fixture and Transducers on page 3-14. 
With a marker, mark scribe lines on the inside edges of the 
brackets onto the pipe. These lines indicate where to apply the 
material. (One 9.5-in. roll fits between the brackets.)

2. Remove the fixture and transducers.

3. Use a dry towel or rag and thoroughly dry the pipe.

4. Unroll the DMP-1 material and cut off a length equal to the  
circumference. Peel the paper backing off the cut portion. 

IMPORTANT: The DMP-1 material will only adhere to the pipe 
correctly if the pipe is completely dry. To adhere 
properly, the material must also be at a 
temperature above 50°F (10°C).

5. Before more atmospheric condensation can occur on the 
outside of the pipe, roll the DMP-1 dampening material once 
around the pipe, following the scribe marks that represent the 
inside edge of the fixture, as shown in Figure 3-23 below. 

Figure 3-23: DMP-1 Dampening Material 
Wrapped Around Pipe

6. Reinstall the fixture, and make sure the spacing is set 
correctly. Loosely mount the transducers on top of the 
dampening material, using the correct spacing.
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Installing DMP-1 Dampening Material with CFG-V 
Series Fixtures (cont.)

7. With a marker, trace around the transducer footprint, as shown 
in Figure 3-24 below.

Figure 3-24: DMP-1 Material with 
Transducer Footprint Traced

8. Remove the fixture and transducers. Then use a utility knife to 
cut out the area under the transducer footprint, and peel the cut 
material off the pipe, as shown in Figure 3-25 below.

Note: Remove excess dampening material as soon as possible, 
before it adheres to the pipe and becomes difficult to 
remove.

Figure 3-25: DMP-1 Material with 
Transducer Footprint Cut Out

9. To remove any residual adhesive, clean the cut-out area with a 
rag or a piece of sandpaper, or use varnish remover.

10. Reinstall the fixture and transducers on the pipe.
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Installing DMP-1 Dampening Material with CFG-V 
Series Fixtures (cont.)

11. Lay the second strip of dampening material flat. Then cut the 
strip into two pieces, each 4.5-in. (12 cm) wide.

12. Wrap each of these strips around the pipe on the outside edge 
of the clamping fixture, one upstream and one downstream. 
The completed dampening material installation should appear 
similar to Figure 3-26 below.

Figure 3-26: Completed DMP-1 Installation
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Installing DMP-1 Dampening Material with PI Fixture

1. Be sure the PI clamping fixture is installed onto the pipe with 
the transducers as described in the section Installing the PI 
Fixture and Transducers on page 3-18.

2. Approximate the axial distance from one transducer face to 
the other transducer face, as shown in Figure 3-27 below.

Figure 3-27: Distance Between Transducer Faces

3. Lay the first strip of dampening material flat. Cut a strip to a 
width equal to the distance between transducer faces (the 
distance illustrated in Figure 3-27 above).

4. Wrap this strip around the pipe in the space between the 
transducers.

5. Lay the second strip of dampening material flat. Then cut the 
strip into two pieces, each 4.5-in. (12 cm) wide.

6. Wrap each of these strips around the pipe on the outside edge 
of the clamping fixture, one upstream and one downstream. 
The completed installation should appear similar to Figure 
3-28 on the next page.
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Installing DMP-1 Dampening Material with PI Fixture 
(cont.)

Figure 3-28: Completed DMP-1 Installation
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Installing DMP-3 Compound with All Fixtures

1. Be sure the fixture and transducers are installed on the pipe as 
described in the previous sections of this chapter.

2. Remove the fixture and transducers, but be sure to mark the 
approximate area of installation.

3. Remove any loose paint or rust with a file or emery cloth, as 
shown in Figure 3-29a below. If the finish is mirror-smooth, 
roughen the surface.

Figure 3-29: Filing (a) and Degreasing (b) the Pipe Surface

4. While wearing appropriate gloves, degrease the surface as 
shown in Figure 3-29b above.

5. Place a piece of the DMP-3 material on top of the pipe (Figure 
3-30a), and use the palm of the hand to press it onto the pipe 
(see Figure 3-30b below).

Figure 3-30: Applying the DMP-3 Material

(a) (b)

(a) (b)
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Installing DMP-3 Compound with All Fixtures (cont.)

6. Spread the DMP-3 material so that it covers the whole area 
under the fixture to a thickness of about 0.25 in. (6.4 mm), as 
shown in Figure 3-31a below.

Figure 3-31: Spreading the DMP-3 (a) and
Reinstalling the Fixture (b)

7. Position the transducer yokes to the correct spacing and 
reinstall the fixture around, but not on, the DMP-3 material, as 
shown in Figure 3-31b above.

8. Remove the DMP-3 material from the transducer locations 
(Figure 3-32a below).

Figure 3-32: Clearing DMP-3 from the Transducer Location 
(a) and Installing the Transducers (b)

9. Apply the couplant to the transducers, and install the 
transducers onto the pipe.

Note: If the measurement point is near a flange or weld, apply 
DMP-3 between that structure and the fixture as well.

(a) (b)

(a) (b)
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Installing the PDJ Dampening Jacket

If the pipe temperature is over 150°F, you must use the PDJ pipe 
dampening jacket with preapplied DMP-3. As the dampening 
material dries out over several hours after installation, its 
effectiveness increases. The jacket is available in standard pipe 
sizes from 4 to 12 in. (100 to 300 mm). 

1. Remove any insulation from the installation area, as well as 
any loose paint, rust and high spots from the pipe.

2. Remove the backing paper from the inside of the pipe 
dampening jacket (shown in Figure 3-33 below). 

Figure 3-33: The PDJ Pipe Dampening Jacket

3. Install the jacket on the pipe as shown in Figure 3-34 below. 
Tighten the clamping screws so that some fluid drips from the 
bottom of the jacket.

Figure 3-34: Installation of a PDJ Jacket
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Installing the PDJ Dampening Jacket (cont.)

!WARNING!
The pipe and the dripping fluid will cause severe burns 
upon contact with bare skin. Also, be sure not to inhale 

the fumes generated during the DMP-3 curing cycle.

4. Install the fixture over the jacket, adjusting the spacing to 
match the prestamped transducer holes and PT878GC spacing 
calculations.

5. Apply a thin bead of CPL-16 couplant. Spread it in a thin layer 
about 6 mm (0.25 in.) wide on each transducer face. 

6. Install the transducers into the yokes, and tighten the hold-
down screws until the couplant touches the pipe.

7. If you wish, reinstall insulation over the pipe, making sure that 
the yokes and junction boxes protrude through the insulation.

8. Wait 15 min. for the couplant to skin and finger-tighten the 
transducer hold-down screws. Do not use pliers or any other 
tools.

9. Using a wrench, tighten the transducer hold-down screw 
backing nuts to prevent loosening due to vibration and thermal 
expansion.
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Chapter 4

Programming Site Data

On the PT878GC, a Program Menu (part of the Main Menu) 
enables you to enter information that is specific to each site: 

• Transducer types and paths

• Pipe materials and linings

• Fluid types

• Standard volume and mass flow parameters

• Skan/Measure parameters

• Analog input and output parameters

• Digital output parameters

• User functions

• Correction factors

For immediate operation, the PT878GC requires only transducer, 
pipe and fluid data. However, additional information allows you 
to tailor measurements to your application. Once you have 
entered this data, you can save it in files and recall these files for 
later use. The PT878GC can store up to 1 MB of data in the meter 
at any one time. But through the infrared link, users can store an 
unlimited number of sites on a PC, and then upload the sites as 
they are needed.

This chapter covers entering:

• The Program Menu

• Transducer, pipe, and fluid parameters

• Input/output and other setup parameters

• User functions.
Programming Site Data 4-1



April 2009
Entering the Program Menu

To enter the Program Menu, press the [MENU] key at the lower 
right of the PT878GC keypad. The Menu Bar replaces the Status 
Bar at the top of the screen. Press the  [ ] arrow key once to 
scroll from the Site Menu to the Program Menu. At the Program 
Menu, press [ENTER]. The screen appears similar to Figure 4-1 
below. While following the programming instructions, refer to 
Figure A-2 on page A-2 of Appendix A, Menu Maps

Figure 4-1: The Program Menu

To scroll to a particular option, press the [ ]or [ ] arrow keys 
until you reach the option. Then press [ENTER] to open the option 
window.

When entering parameters in an option, press:

• The  [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any 
time and return to Operate Mode without changing the 
parameters.

Note: On certain text box parameters, you can use the numeric 
keys to enter a desired value. You can then use the [ ] or 
[ ] keys to change the value, if necessary.

Velocity, ft/s Signal, dB

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

Pipe

Path
Fluid

Std Vol/Mass Flow

Analog Input
Analog Output
Digital Output
User Functions

Site   Program   Meter  Logging   Service

Transducer

Correction Factors

Skan/Measure

Lining
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Entering Transducer Parameters

To enter the Transducer option, scroll to the Transducer entry on 
the Program Menu and press [ENTER]. The screen appears similar 
to Figure 4-2 below. To step through each parameter (or reach a 
particular parameter), press the [ ] key.  Refer to Figure A-3 on 
page A-3 of Appendix A, Menu Maps
Note: Refer to Chapter 3 for additional information about 

clamp-on gas transducers and fixture configurations.
.

Figure 4-2: The Transducer Option Window

1. The first prompt asks you to select whether you are using a 
wetted or a clamp-on transducer.

a. Use the  [ ] and [ ] keys to scroll between the two types.

b. Press [ENTER] or [SEL] to confirm the choice.

IMPORTANT: While wetted transducers are listed as a choice, 
the PT878GC is designed for use with Shear 
wave clamp-on transducers. Consult GE before 
selecting wetted transducers.

Transducer Pipe Lining Path

Transducer/Pipe

OKCancel

Fluid

Type:         Wetted Clamp-on

Transducer Special

Frequency 2.00 Tw 14MHz

Wedge Ang  50 °

Wedge Tmp 25 °C
Wedge SS 1219.2 m/s

µs
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Entering Transducer Parameters (cont.)

Note: The choices made earlier in the Transducer and Pipe 
options determine the prompts available later. If the 
PT878GC does not scroll to a particular parameter, it is 
not necessary for that transducer or pipe type. 

2. The next prompt asks you to enter the transducer number, or to 
specify that you are using a special application transducer.

a. From the Type prompt, press the [ ] key to reach the 
Transducer prompt, and press [ENTER].

b. A drop-down list of transducer numbers opens, if you have 
selected clamp-on in the previous prompt. Press the [ ] or 
[ ] keys to scroll to the appropriate number, or scroll to 
“Special” for a special application transducer. To speed 
scrolling, you can press the [ ] key to scroll down by a 
page, or the [ ] key to scroll up by a page.

c. Press [ENTER] to confirm your selection.
The program now varies, depending on whether you have 
selected preprogrammed or special transducers.

• If you have selected a transducer from the list of 
preprogrammed shear clamp-on transducers (#301 to 315), the 
PT878GC comes programmed with the needed parameters. 
You only need to enter the wedge temperature. 

a. From the Wedge Angle prompt, press the [ ] key to reach 
the Wedge Temperature prompt, and press [ENTER].

b. Use the numeric keys to enter the wedge temperature (in 
degrees) and press [ENTER].

Note: For highest accuracy, program the wedge temperature to 
the average of the gas and ambient temperatures. For 
example, if the gas temperature is 350°, the wedge 
temperature is (350+70)/2 = 210°F.

Pressing the [ ] key thus returns the meter to the Transducer tab 
at the top. Go to page 4-7 to continue programming.

• However, if you have selected a special application transducer, 
turn to the next page.
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Parameters for Special Transducers

3. The prompt asks for the transducer frequency, to transmit a 
voltage at a rate to which the transducer can respond. 

a. From the Transducer prompt, press the [ ] key to reach 
the Frequency prompt, and press [ENTER].

b. A drop-down list of five frequencies opens, ranging from 
0.25 to 4.00 MHz. Scroll to the frequency of your 
transducers, and press [ENTER].

4. The next prompt asks for Tw, the time delay. This parameter is 
actually the time the transducer signal spends travelling 
through the transducer and cable. The PT878GC calculates the 
flow rate by subtracting the time of the upstream and 
downstream signals, so the time delay must be subtracted out 
for an accurate measurement. GE Sensing supplies the time 
delay on a data sheet inside the transducer case.

a. From the Frequency prompt, press the [ ] key to reach the 
Tw prompt, and press [ENTER].

b. Use the numeric keys to enter the GE Sensing-supplied 
time delay and press [ENTER].

5. When calculating the flow rate, the PT878GC must take into 
account the wedge angle, the angle of the ultrasonic 
transmission. 

a. From the Tw prompt, press the [ ] key to reach the 
Wedge Angle prompt, and press [ENTER].

b. Use the numeric keys to enter the GE Sensing-supplied 
wedge angle (in degrees) and press [ENTER].

6. The PT878GC must also take into account the wedge 
temperature.

a. From the Wedge Angle prompt, press the [ ] key to reach 
the Wedge Temperature prompt, and press [ENTER].

b. Use the numeric keys to enter the wedge temperature (in 
degrees) and press [ENTER].
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Parameters for Special Transducers (cont.)

Note: If the transducer is installed on a pipe that is at a different 
temperature than the ambient temperature, the wedge 
temperature is the average of the pipe temperature and 
the ambient temperature.

7. Finally, the PT878GC requires the wedge sound speed.

a. From the Wedge Temp prompt, press the [ ] key to reach 
the Wedge SS prompt, and press [ENTER].

b. Use the numeric keys to enter the GE Sensing-supplied 
wedge sound speed (in ft/sec or m/sec) and press [ENTER].

Pressing the [ ] key returns the meter to the Transducer tab at 
the top. 

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate Mode, press [F2] (Cancel) or the [ESC] key.
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Entering Pipe Parameters

To enter the Pipe option, scroll to the Pipe entry on the Program 
Menu and press [ENTER]. (From the Transducer window, you can 
scroll back up to the Transducer tab and press the  [ ] arrow key 
to reach the Pipe window and press [ENTER].) The screen appears 
similar to Figure 4-3 below. To step through each parameter, 
press the [ ] key. Refer to Figure A-4 on page A-4 of Appendix 
A, Menu Maps.

Note: Refer to the brochure Sound Speeds and Pipe Size Data 
(914-004) for additional information about pipe sizes and 
sound speeds.

Figure 4-3: The Pipe Option Window

Transducer Lining Path

Transducer/Pipe

5

Schedule

Cancel OK

Pipe

Material Other

SndSpeed 600.3 m/s

OD, mm Wall, mm
2

Nominal      Schedule

Fluid

5
OD x PI, mm

15.708

ANSI
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Entering Pipe Parameters (cont.)

1. The first prompt asks you to select the pipe material.

a. Press [ENTER] to enter the material prompt.

b. A drop-down list of materials opens. Table 4-1 below lists 
the available preprogrammed materials on the list. Press 
the [ ] or [ ] keys to scroll to the appropriate material, 
or scroll to “Other” for a material not on the list. You can 
press the  [ ] key to scroll down by a page, or the [ ] key 
to scroll up by a page.

c. Press [ENTER] to confirm the choice.

Table 4-1:  Preprogrammed Pipe Materials

Pipe Material 
Category Specific Material

Al - Aluminum Rolled
Brass None
Cu - Copper Annealed or Rolled
CuNi - Copper/Nickel 70% Cu 30% Ni or  

90% Cu 10% Ni
Glass Pyrex, Flint, or Crown
Gold Hard-drawn
Inconel None
Iron Armco, Ductile, Cast, Electrolytic
Monel None
Nickel None
Plastic Nylon, Polyethylene, Polypropy-

lene, PVC (CPVC), or Acrylic
Steel Carbon Steel or Stainless Steel
Tin Rolled
Titanium None
Tungsten Annealed, Carbide, Drawn
Zinc Rolled
Other Any material
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Entering Pipe Parameters (cont.)

2. At this point, the program follows one of two paths:

a. If you have selected a preprogrammed material, the 
PT878GC automatically supplies the correct sound speed, 
and  proceeds to step 3. 

b. If you have selected “Other,” the meter prompts you to 
enter the sound speed. Use the numeric keys to type the 
known sound speed in the text box, and press [ENTER] to 
confirm the choice.

3. At this point, two alternatives are available. At the Diameter 
prompt, the meter asks for the pipe outside diameter and 
thickness. But if you have selected certain pipe materials 
(carbon or stainless steel, cast iron, PVC and CPVC),  you 
have the option of entering the pipe dimensions by a 
standardized schedule. Once you enter the nominal pipe size 
and schedule identification, the PT878GC determines the OD 
and wall thickness from an internal table.

If you select a material that uses the Diameter alternative:

a. You must select from two choices, outside diameter or 
circumference.

• The prompt moves to the OD (outside diameter) text box. 
Type the pipe OD (in mm or in.) into the text box, and press 
[ENTER] to confirm the choice, or

• Move the prompt to the OD X PI (circumference) text box. 
Type the circumference (in mm or in.) into the box, and 
press [ENTER] to confirm your choice. 

b. In either case, the next prompt asks for the wall thickness. 
Type the value (in mm or in.) into the box, and press 
[ENTER] to confirm your choice

Note: The measurement units shown depend on the choices you 
have made in the English/Metric window of the Meter  
menu.
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Entering Pipe Parameters (cont.)

If you select a material that has the Schedule option:

a. The prompt asks if you wish to apply DIN (the DIN 
schedule). Press [ENTER] to select (or deselect) the DIN 
box. (If you do not select the DIN option, the prompt 
moves to the OD text box, and you enter the parameters for 
the Diameter alternative as discussed on the previous 
page.)

Note: If you have selected English units in the Meter Menu (as 
discussed on page 7-3), the schedules appear as ANSI.

b. Press the [ ] key twice to move the prompt to the 
Nominal pipe size drop-down menu. Press [ENTER] to open 
the menu. Scroll to the desired pipe size, and press [ENTER] 
to confirm your choice.

c. Press the [ ] key to move the prompt to the Schedule 
drop-down menu. Press [ENTER] to open the menu. Scroll to 
the desired schedule (5S, 10S, 40S or 80S),  and press 
[ENTER] to confirm the choice. 

After entering either diameter or schedule settings, pressing the 
[ ] key returns the meter to the Pipe Material prompt. 

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.

• To return to the Pipe tab and scroll to other windows, press the  
[ ] key.
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Entering Pipe Lining Parameters

To enter the Lining option, scroll to the Lining entry on the 
Program Menu and press [ENTER]. (From the Pipe window, you 
can scroll back up to the Pipe tab and press the  [ ] arrow key to 
reach the Lining window, and press [ENTER].) The screen appears 
similar to Figure 4-4 below. To step through each parameter, 
press the [ ] key. While programming, refer to Figure A-3 on 
page A-3 of Appendix A, Menu Maps.

Note: The Lining option is only available for clamp-on 
transducers.

Figure 4-4: The Pipe Lining Window

1. The PT878GC first prompts you to select the pipe lining 
material.

a. Press [ENTER]  to open the drop-down list of lining 
materials.

b. Scroll to the appropriate material. If you do not see your 
lining material on the list, select “Other.”

c. Press [ENTER] to confirm your choice.

Transducer Pipe Path

Transducer/Pipe

Cancel OK

Lining

Material Tar/Epoxy

Sound Speed 2000

mmThickness

m/s

0

Fluid
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Entering Pipe Lining Parameters (cont.)

Note: If your pipe lining is not on the drop-down list, consult GE 
Sensing for further information.

2. The program follows one of two paths:

a. If you have selected a preprogrammed material, the 
PT878GC automatically supplies the correct sound speed, 
and you proceed to step 3. 

b. If you have selected “Other,” the meter prompts you to 
enter the sound speed. Press [ENTER]. Use the numeric keys 
to type the known sound speed in the text box, and press 
[ENTER] to confirm the choice.

3. The meter now asks for the lining thickness. Press [ENTER]. 
Use the numeric keys to enter the known value in the text box, 
and press [ENTER] to confirm your entry.

Pressing the [ ] key returns the meter to the Lining tab.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key.

• To scroll to other windows, press the [ ] or  [ ] key.
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Entering Fluid Types and Speeds

To access the Fluid option, scroll to the Fluid entry on the 
Program Menu and press [ENTER]. (If you are already in the 
Transducer/Pipe form, press the  [ ] arrow key to reach the Fluid  
window, and press [ENTER].) The screen appears similar to Figure 
4-5 below.  To step through each parameter, press the [ ] key. 
Refer to Figure A-3 on page A-3 of Appendix A, Menu Maps.

Figure 4-5: The Fluid Type Window

1. The first prompt asks for the gas type.

a. Press [ENTER] to open the drop-down menu. The following 
choices are available:

• Other

• Air

• Natural Gas

• Steam

          Fluid

Cancel OK

Transducer/Pipe

Transducer Pipe PathFluid

Fluid Type

Sound Speed

Other

m/s345.75

Lining
Programming Site Data 4-13



April 2009
Entering Fluid Types and Speeds (cont.)

b. Scroll to the appropriate entry. If you do not see your fluid 
on the list, select “Other.”

c. Press [ENTER] to confirm your selection.

If you have selected a preprogrammed gas, the PT878GC supplies 
the sound speed. Pressing the [ ] key returns you to the Fluid 
tab. However, if you have selected “Other,”  the PT878GC 
prompts you to enter the sound speed. 

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the known sound speed.

c. Press [ENTER] to confirm the selection.

Pressing the [ ] key returns you to the Fluid prompt.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Entering the Signal Path Parameters

To enter the Path option, scroll to the Path entry on the Program 
Menu and press [ENTER]. (From the Lining window, you can scroll 
back up to the Lining tab and press the [ ] arrow key to reach the 
Path window, and press [ENTER].) The screen appears similar to 
Figure 4-6 below. To step through each parameter, press the [ ] 
key. Refer to Figure A-3 on page A-3 of Appendix A, Menu 
Maps.

Figure 4-6: The Signal Path Window

Note: The Path Length and Axial Length parameters are not 
available for clamp-on transducers.
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Path Parameters for Clamp-On Transducers

The PT878GC path menu includes two parameters for clamp-on 
transducers:

• Traverses

• Spacing
1. The PT878GC first prompts for traverses, the number of times 

the ultrasonic signal crosses the pipe. 

a. Press [ENTER] to open the drop-down list of traverse 
numbers.

b. Scroll to the appropriate number. 

c. Press [ENTER] to confirm the entry.

2. The next prompt displays the spacing of the transducers, as 
calculated from the information entered.

a. Record this number and use it to space the transducers. 
(Use Chapter 3 to assist in installing transducers on the 
pipe.) Press the [ ] key to scroll to the next parameter.

b. If necessary, you can overwrite the spacing to match the 
actual physical spacing of the transducers. (Do not change 
the spacing by more than ±10% from that calculated by the 
meter.) Press [ENTER]. Use the numeric keys to enter the 
desired value, and press [ENTER] to confirm the entry. If you 
enter an invalid entry, the PT878GC rejects the entry and 
displays an error message.

Note: GE Sensing does not recommend using a spacing other 
than the one calculated by the PT878GC.

After you enter the spacing, pressing the [ ] key returns the 
prompt to the Traverses box, and then to the Path tab at the top of 
the screen. 

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Entering the Standard Volume/
Mass Flow Parameters

The Standard Volume/Mass Flow option enables you to correct 
standard volumetric units for pressure and temperature, as well as 
to disable or enable mass flow. To enter this option, scroll to the 
Std Vol/Mass Flow entry on the Program Menu and press [ENTER]. 
The screen appears similar to Figure 4-7 below. To step through 
each parameter, press the [ ] key. Refer to Figure A-5 on 
page A-5 of Appendix A, Menu Maps.

Figure 4-7: The Standard Volume Option Window

1. The first prompt asks if you want to disable or enable the 
Standard Volume option.

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

Note: If you select “Disabled,” you cannot select any other 
prompts in this window.

Settings Inputs

Std Vol/Mass Flow

OKCancel

                 l

DisabledEnabled

Base Pressure Bars

Atmospheric Pressure Bars

Base Temperature °C

1.0

1.0

15.5

Standard_Volume    

Mass Flow
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April 2009
Entering the Standard Volume Parameters 
(cont.)

2. The next prompt asks for the base pressure.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the known pressure.

c. Press [ENTER] to confirm the entry.

3. The next prompt asks for the atmospheric pressure. 

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the local atmospheric 
pressure.

c. Press [ENTER] to confirm the entry.

4. The final prompt in this window asks for the base temperature 
(in degrees F or C).

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the known temperature.

c. Press [ENTER] to confirm the entry.

Pressing the [ ] key returns the meter to the Standard Volume  
prompt, and then to the Settings tab.  

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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April 2009
Entering Inputs in the Standard Volume Option

To enter input parameters in the Standard Volume/Mass Flow 
option, return to the Settings tab at the top of the Standard 
Volume window. Press the [ ] arrow key and [ENTER] to open the 
Inputs window. The screen appears similar to Figure 4-8 below. 
To step through each parameter, press the [ ] key.

Figure 4-8: The Inputs Tab in the
Standard Volume/Mass Flow Option

1. The first prompt asks if the pressure is fixed or active. 

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

Settings Inputs

Cancel OK

Pressure
Fixed                 Active

Bars Input # 1.01 A

Temperature    

Fixed Active

°C Input # 15.5 B

Pressure

Temp

Std Vol/Mass Flow

Mass Flow
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April 2009
Entering Inputs in the Standard Volume Option (cont.)

2. The next prompt appears if you have selected a fixed pressure. 
The PT878GC asks for the fixed pressure value.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the known pressure.

c. Press [ENTER] to confirm the entry.

3. Whether you have selected a fixed or an active supply, the 
PT878GC asks for the desired input. 

a. From the Pressure text box, press the [ ] arrow key to 
reach the Input # menu.

b. Press [ENTER] to open the drop-down menu.

c. Scroll to Input A or B.

d. Press [ENTER]  to confirm the entry.

4. The next prompt asks if the temperature is fixed or active. 

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

5. The next prompt appears if you have selected a fixed 
temperature. The PT878GC asks for the fixed temperature 
value.

a. Press [ENTER] to open the text box. 

b. Use the numeric keys to enter the known temperature (in 
degrees C or F), and press [ENTER] to confirm the entry.

6. Whether you have selected a fixed or an active temperature, 
the PT878GC asks for the desired input. 

a. Press [ENTER] to open the drop-down menu.

b. Scroll to Input A or B.

c. Press [ENTER] to confirm the entry.
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April 2009
Entering Inputs in the Standard Volume Option (cont.)

Note: If you have switched both active inputs to #A (or to #B), 
the PT878GC automatically switches one input to the 
other letter. This change ensures that only one analog 
input is assigned to one measurement type.

Pressing the [ ] key returns the meter to the Inputs tab.  

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Entering Mass Flow Parameters

To enter mass flow parameters in the Standard Volume/Mass 
Flow option, press the [ ] arrow key until you reach the Mass 
Flow tab, and then press [ENTER] to open the Mass Flow window. 
The screen appears similar to Figure 4-9 below. To step through 
each parameter, press the [ ] key.

Figure 4-9: The Mass Flow Tab in the Standard Volume/Mass 
Flow Option

1. The first prompt asks if you want to disable or enable the 
Mass Flow option.

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

Note: If you select “Disabled,” you cannot select any other 
prompt in this window.

Settings Inputs

Cancel OK

Mass Flow
Enabled                 Disabled

Calculation Method Static Density

Saturated Steam Input    

Static Density Kgs/m31.02305

Std Vol/Mass Flow

Mass Flow

Temperature
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April 2009
Entering Mass Flow Parameters (cont.)

2. If you have enabled Mass Flow, the next prompt asks for the 
calculation method. Three options are available: static density, 
saturated steam, and steam. 

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the appropriate method for your application.

c. Press [ENTER] to confirm the entry.

• If you select Saturated Steam:
The prompt asks for the Saturated Steam input. Press 
[ENTER], scroll to either Temperature or Pressure, and press 
[ENTER].

• If you select Static Density:
The prompt asks for the Static Density value. Press [ENTER] 
to open the text box, enter the appropriate value, and press 
[ENTER] to confirm the entry.

Pressing the [ ] key returns the meter to the Mass Flow prompt, 
and then to the Mass Flow tab.  

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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April 2009
Entering Skan/Measure Parameters

IMPORTANT: Do not change the Skan/Measure parameters 
unless recommended by GE Sensing.

If you select one of the Skan/Measure modes in the Measurement 
mode window in the Signal Setup option (see page 9-24), the 
PT878GC requires you to set up the appropriate parameters. You 
can enter this option in either of two ways:

• From the Program Menu, scroll to the Skan/Measure option 
and press [ENTER], or

• From the Measurement Mode window (page 8-13), select the 
method, press [ENTER], press the [ ] key to reach the Skan/
Measure Setup prompt, and press [ENTER] again.

In either case, the screen appears similar to Figure 4-10 below. To 
step through each parameter, press the [ ] key. Refer to 
Figure A-6 on page A-6 of Appendix A, Menu Maps.

Figure 4-10: The Skan/Measure Setup Option

Integrate

Skan/Measure

Cancel OK
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April 2009
Entering Skan/Measure Parameters (cont.)

1. The first prompt asks for the Percent of Peak, which is used to 
calculate the transit times and Delta-T. The default value is 80, 
and values from 1 to 100 are acceptable. 

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.

2. The next prompt asks for Skan-T Offset, a time measurement 
offset that compensates for any shift resulting from cross-
correlation. The default value is 12.6 µsec, and values from 
-500 to 500 µsec are acceptable. 

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.

3. The next prompt, M>S Switch, causes the meter to switch 
from Skan to Measure Mode when Delta-T is less than the 
M>S Switch value. The default value is 5.0 µsec and values 
from 0 to 250 µsec are acceptable.

Note: Do not change this value without consulting GE Sensing. 
If you wish to use Skan only, set the M/S Switch to a value 
of 0.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.

4. The program now asks if you wish to Limit the Measurement 
Delta. (The default is unchecked or off.)

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value in 
µsec.

c. Press [ENTER] to confirm the entry.
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April 2009
Entering Skan/Measure Parameters (cont.)

Pressing the [ ] key highlights the Advanced prompt. To enter 
advanced parameters for the Skan/Measure modes, press [ENTER]. 
The screen now appears similar to Figure 4-11 below. In each 
case, to enter a value:

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the value.

c. Press [ENTER] to confirm the entry.

Figure 4-11: The Advanced Skan/Measure Window

5. The first prompt, the number of shifts, corresponds to the 
actual number of transmits per cycle (the number of signals 
added together in one direction to produce an averaged signal 
for one interrogation of the fluid). It need only be changed if 
the environment is very noisy or the acoustic signal is weak. 
The default value is 3 and values from 0 to 10 are acceptable.

Skan/Meas

Advanced Signal Setup

Cancel OK

Meas Window

R Window cycles

# of Shifts

cycles

T Window

  3

1

10

 cycles

cycles

10

Noise Window Width

Noise Window Offset

3

0
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April 2009
Entering Skan/Measure Parameters (cont.)

6. The next prompt enables you to reset the size of the transmit 
window. Normally, the PT878GC calculates the size of both 
transmit and receive windows based on pipe size and fluid 
sound speed. However, for special diagnostic purposes, it may 
sometimes be necessary to reset the window size. The default 
value is 1 and values from 0 to 1,000 are acceptable.

7. The next prompt enables you to reset the size of the receive 
window for diagnostic purposes. The default value is 10 and 
values from 0 to 300 are acceptable.

8. The Meas Window prompt allows you to customize the width 
of the measurement window. While this window is normally 
10 cycles wide, the option allows you to customize the width 
from 1 to 60. 

Pressing the [ ] key returns the meter to the # Shifts entry.  

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Entering Skan/Measure Integrate Parameters

To enter parameters for the Skan/Measure Integrate mode in the 
Skan/Measure option, press the [ ] arrow key once to reach the 
Integrate tab. Then press [ENTER] to open the Integrate window, 
which appears similar to Figure 4-12 below.

Figure 4-12: The Integrate Window in the Skan/Measure 
Option

1. The first prompt, A Divisor, is used in the calculation of the 
Measure Mode integrated threshold level and is not normally 
changed. The default value for this parameter is 2.5, and 
values from 0.1 to 10 are acceptable.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.

2. Next, enter the Noise Level  (-Offset % of Peak) from 0 to 
95%, and press [ENT]. (The default value is 20%.)

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.

Integrate

Skan/Measure

Cancel OK

All

A Divisor

Noise Level

Count Correlate

2.5

Measure Only

     5 %
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April 2009
Entering Skan/Integrate Parameters (cont.)

3. If you wish to use Measure Times only (instead of both Skan 
and Measure times), press [ENTER] at the Measure Only 
prompt. (You can also press [ENTER] to deselect the prompt.)

Pressing the [ ] key returns the meter to the A Divisor entry, and 
pressing the [ ] key returns the meter to the Integrate tab. 

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Entering Skan/Measure Count Parameters

To open the Skan/Measure Count window in the Skan/Measure 
option, press the [ ] arrow key twice (from the All tab) to reach 
the Count tab. Press [ENTER], and the screen appears similar to 
Figure 4-13 below.

Figure 4-13: The Count Window in the 
Skan/Measure Option

1. The first prompt asks for the Cycle Number that triggers the 
count from 1 to 100.  (The default number is 1.)

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended number.

c. Press [ENTER] to confirm the entry.

2. The meter now asks for the Cycle Width (# of cycle count 
samples, minimum width of valid cycle).

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.
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Cancel OK

All

Cycle Number

SNR Test

Cycle Width

Noise Level %
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April 2009
Entering Skan/Measure Count Parameters (cont.)

3. The next prompt asks for the percentage of Noise Level.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.

4. If you wish to select (or deselect) Measure Times only 
(instead of both Skan and Measure times), press [ENTER] at the 
Measure Only prompt. 

5. If you wish to select (or deselect) a SNR (signal-to-noise 
ratio) test, press the [ ] key to highlight the SNR Test prompt 
and press [ENTER].

a. If you have selected SNR Test, the next prompt asks for the 
Minimum Noise Level. Press [ENTER], type in the 
recommended value, and press [ENTER] to confirm the 
entry.

b. The final prompt asks for the Low SNR Error Limit. (The 
default is 7.) Press [ENTER], type in the recommended 
value, and press [ENTER] to confirm the entry.

Pressing the [ ] key returns the meter to the Cycle Number 
entry, and pressing the [ ] key returns the meter to the Count 
tab.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Entering Skan/Correlation Parameters

To open the Skan/Correlation window in the Skan/Measure 
option, press the [ ] arrow key three times (from the All tab) to 
reach the Correlate tab, and press [ENTER]. The screen appears 
similar to Figure 4-14 below.

 

Figure 4-14: The Correlate Window in the Skan/Measure 
Option

To identify the peak of the received signal, the PT878GC uses the 
“Threshold” method, in which the peak is identified as the point 
where the signal crosses a threshold that is a percentage of the 
maximum signal detected. 

1. The first prompt, Min Threshold, asks for the minimum 
percentage of peak used to measure transit time. 

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm the entry.
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April 2009
Entering Skan/Correlation Parameters (cont.)

2. Repeat step 1 to enter the maximum percentage of peak. 

3. The next prompt asks for the Percent of Peak, which is used to 
calculate the transit times and Delta-T.  

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

4. To select (or deselect) Measure Times only (instead of both 
Skan and Measure times), press [ENTER] at the Measure Only 
prompt.

Pressing the [ ] key returns the meter to the Min Threshold 
entry, and pressing the [ ] key returns the meter to the Correlate 
tab.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Entering Analog Inputs

The Analog Inputs option enables you to specify parameters for 
general purpose or standard volume inputs. To enter the Analog 
Inputs option, scroll to the Analog Inputs entry on the Program 
Menu and press [ENTER]. If you have not enabled the Standard 
Volume Option (see page 4-18), the screen appears similar to 
Figure 4-15 below. To step through each parameter, press the [ ] 
key. Refer to Figure A-6 on page A-6 of Appendix A, Menu 
Maps.

Entering General-Purpose Analog Inputs

Figure 4-15: The Analog Inputs Option Window

1. The first prompt asks you to select whether the desired 
function is off or general purpose.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired response.

c. Press [ENTER] to confirm your selection.

Note: If you select “Off,” you cannot select any other prompts in 
this window.

          Analog Input

Cancel OK

Function

Units
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Label

Zero 

100

General Purpose

0

Psia

Input A Input B
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April 2009
Entering General-Purpose Analog Inputs (cont.)

2. The next prompt asks you to create a label for the input. The 
label corresponds to the measurement type (i.e., velocity or 
temperature), while the units symbol corresponds to the 
measurement units (i.e., feet/sec or degrees F).

a. Press [ENTER] to open the text creation window, which 
appears similar to Figure 4-16 below.

Figure 4-16: The Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or 
symbol, and press [ENTER] to add the letter to the label.

Note:  Pressing [SEL] causes the screen to alternate between a 
set of upper-case (capital) letters, a set of lower-case 
letters, and a set of symbols. Use all three screens to 
create a desired label.

c. Repeat this procedure for each letter or symbol you wish to 
add to the label. If you wish to delete a letter, press [F1] 
(Delete) to erase each letter or symbol, from right to left on 
the label. (The label window can display up to 14 
characters.)

d. When you have completed the label, press [F3] (OK) to 
confirm the label, or [F2] (Cancel) to leave the window 
without adding the label.

A        B      C      D      E      F      G      H       I        J

K        L      M      N      O      P      Q      R      S       T

U      V       W     X      Y       Z      0       1       2      3

4      5        6      7      8        9      .        ,        “       ‘
=      <       >       

Delete Cancel OK
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April 2009
Entering General-Purpose Analog Inputs (cont.)

3. The next prompt asks for the Units Symbol. 

a. Press [ENTER] to reopen the text creation window. 

b. Repeat the procedure used for the Label (on the previous 
page) to create the Units Symbol.

c. When you have completed the entry, press [F3] (OK) to 
confirm the symbol, or [F2] (Cancel) to leave the window 
without adding the symbol. If you confirm the symbol, the 
Units symbol will appear to the right of the zero and span 
text boxes.

4. The next prompt asks for the zero input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

5. The final prompt asks for the span input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER]  to confirm the entry.

You have completed entering data for general-purpose inputs. 
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Entering Analog Inputs in Standard Volume 
or Mass Flow Option

If you have enabled the Standard Volume or Mass Flow options, 
the screen displays different options, as shown in Figure 4-17 
below.

Figure 4-17: The Analog Inputs Option Window, with the 
Standard Volume Option Activated

1. The screen displays the function (pressure or temperature), 
label (pressure or temperature) and units selected in the Inputs 
form of the Standard Volume option (see page 4-20). You 
cannot change these parameters in this form. Press the [ ] 
key to step through these parameters.

2. The first prompt asks for the zero input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

3. The final prompt asks for the span input value.

a. Press [ENTER] to enter the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER]  to confirm the entry.
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Entering Analog Inputs in the Standard Volume or 
Mass Flow Option (cont.)

You have completed entering parameters in the Analog Inputs 
option.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). The PT878GC returns to Operate Mode.

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key. 
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Entering the Analog Output

The Analog Output option enables you to enter information to set 
up output parameters. To enter the option, scroll to the Analog 
Output entry on the Program Menu and press [ENTER]. The screen 
appears similar to Figure 4-18 below. To step through each 
parameter, press the [ ] key. Refer to Figure A-6 on page A-6 of 
Appendix A, Menu Maps.

Figure 4-18: The Analog Output Window

1. The first prompt enables you to select a range to send a current 
signal to a recording device. 

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired output from three choices: Off, 
0-20 mA, and 4-20 mA.

c. Press [ENTER] to confirm your selection.

Note: If you select “Off,” you cannot access any other 
parameters in this option.
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Entering the Analog Output (cont.)

2. The next prompt asks you to select the analog output type 
from a number of choices, as shown in Figure 4-19 below.

Figure 4-19: Data Source Selection Window

a. Press [ENTER] to open the window.

b. Scroll to the desired output type.

c. Press [SEL] to confirm your selection.

d. The prompt then moves to a list of unit types. (The 
available units depend on the selection made at the Data 
Source prompt.) Scroll to the desired output unit.

e. Press [F3] (OK) to confirm your selection.

         Select Measurement

Cancel OK

Diagnostics

         Aux Input A

Volume

No Unit

Velocity

UserFunction

m/s

Pressure
Temperature

Aux Input B
Skan/Measure
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April 2009
Entering the Analog Output (cont.)

3. The next prompt asks you to enter the zero (base) value for the 
analog output. This value represents the 0/4 mA output (in 
flow units).

a. Press [ENTER] to open the text box.
b. Use the numeric keys to enter the desired value.
c. Press [ENTER] to confirm your selection.

4. The next prompt asks you to enter the span (full scale) value 
for the analog output. This value represents the 20 mA output 
(in flow units).

a. Press [ENTER] to open the text box.
b. Use the numeric keys to enter the desired value.
c. Press [ENTER] to confirm your selection.

5. The last prompt, On Error, asks you to select how the 
PT878GC will handle the analog outputs in the event of a fault 
condition. The meter offers three alternatives:

• Hold Last Value (hold the last good reading)

• Force Low (force the reading to 0 or 4 mA)

• Force High (force the reading to 20 mA).

a. Press [ENTER] to open the drop-down menu.
b. Scroll to the desired selection.
c. Press [ENTER] to confirm your selection.

You have completed entering data in the Analog Output option.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key.
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Entering the Digital Output

While resembling the Analog Output option, the Digital Output 
option enables you to set up parameters necessary for a digital 
output. To enter the option, scroll to the Digital Output entry on 
the Program Menu and press [ENTER]. The screen appears similar 
to Figure 4-20 below. To step through each parameter, press the 
[ ] key. Refer to Figure A-7 on page A-7 of Appendix A, Menu 
Maps.

Figure 4-20: The Digital Output Window

1. The first prompt enables you to select the output function 
from five choices:

• Off

• Pulse Totalizer

• Frequency

• Test Points

• Gate Input
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Entering the Digital Output (cont.)

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired function.

c. Press [ENTER] to confirm your selection.

Note: If you select Off, you will not be able to access any other 
parameters in this option. If you select Test Points or Gate 
Input, the program goes at once to Step 4. 

2. The next prompt asks you to select the data source for the 
digital output from a number of choices. If you select Pulse 
Totalizer, the meter offers four sources:

• Forward Totalizer

• Reverse Totalizer

• Standard Forward Totalizer

• Standard Reverse Totalizer

If you select Frequency, the sources also include:

• Pressure

• Diagnostics

• Velocity

• Temperature

• Volume

• User Function

• Skan/Measure

• Mass Flow

a. Press [ENTER] to open the data source selection window, 
shown in Figure 4-19 on page 4-40.

b. Scroll to the desired source.

c. Press [SEL] to confirm your selection.
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Entering the Digital Output (cont.)
d. The prompt then moves to a list of unit types. (The 

available units depend on the selection made at the Data 
Source prompt.) Scroll to the desired output unit.

e. Press [F3] (OK) to confirm your selection.

3. The last set of parameters that appears depends on the 
selection you made at the Function prompt.

If you selected Pulse Totalizer:

The prompt asks for the units/pulse, the pulse width (in 
microseconds), and the polarity. (Figure 4-20 on page 4-42 
illustrates a Digital Output window configured for the Pulse 
Totalizer function.) For the Units/Pulse and Pulse Width 
parameters:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your selection.

For Polarity:

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired polarity, either Low/High or 
High/Low.

c. Press [ENTER] to confirm your selection.

If you selected Frequency:

The prompt asks for the minimum and maximum range of 
measurements, frequencies and the duty cycle percentage. For 
each parameter:

a. Press [ENTER]  to open the text box.

b. Use the numeric keys to enter the desired value. (Once you 
have entered a number, you can use the [ ] or [ ] key to 
step through to the desired value.)

c. Press [ENTER] to confirm your selection.

d. For the minimum and maximum values, press the [ ] key 
to move to the box to the right, and repeat the procedure.
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Entering the Digital Output (cont.)

If you entered Test Points:
The prompt asks for the signal type from two choices: transmit or 
receive.

a. Press [ENTER] to open the drop-down menu.
b. Scroll to the required signal.
c. Press [ENTER] to confirm your selection.

If you entered Gate Input:
1. The first prompt asks for the gate active.

a. Press [ENTER] to open the drop-down menu.
b. Scroll to the gate, either Contact Open or Contact Closed.
c. Press [ENTER] to confirm your selection.

2. The remaining prompt asks for the mode, automatic or 
manual.
a. Press [ENTER] to open the drop-down menu.
b. Scroll to the required mode.
c. Press [ENTER] to confirm your selection.

Stopwatch Totalizer

Through the Gate Input option, you can implement the  
Stopwatch Totalizer function to measure totals manually. To set 
up the Totalizer function:
1. At the Gate Active prompt, select Contact Closed.
2. At the Mode prompt, select Manual, and press [ENTER].
The stopwatch icon (see page 2-11) appears in the system tray. To 
start or stop the function, press the minus (-) key on the keypad.
You have completed entering parameters in the Digital Output 
option.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key.
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Entering User Functions

User functions enable you to perform mathematical equations on 
each measurement. You can also use any parameter in the meter 
to calculate a different parameter. To enter the User Functions 
option, scroll to the User Functions entry on the Program Menu 
and press [ENTER]. The screen appears similar to Figure 4-21 
below.  To step through each parameter, press the [ ] key. Refer 
to Figure A-7 on page A-7 of Appendix A, Menu Maps.

Figure 4-21: The User Functions Window

1. The first prompt asks you to select the function number, 
1 through 8.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired function number (User F1, User F2, 
etc.).

c. Press [ENTER] to confirm the entry.

Set User Function

Function User F1

Label

Units Sym

Dec. 0

Delete Check Done
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Entering User Functions (cont.)
2. The next prompt asks you to create a label for the function. 

The label corresponds to the measurement type (i.e., velocity 
or temperature), while the units symbol corresponds to the 
measurement units (i.e., feet/sec or degrees F).

a. Press [ENTER] to open the text creation window, which 
appears similar to Figure 4-22 below.

Figure 4-22: The Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or 
symbol, and press [ENTER] to add the letter to the label.

Note:  Pressing [SEL] causes the screen to alternate between a 
set of upper-case (capital) letters, a set of lower-case 
letters, and a set of symbols. Use all three screens to 
create a desired label.

c. Repeat this procedure for each letter or symbol you wish to 
add to the label. If you wish to delete a letter, press [F1] 
(Delete) to erase each letter or symbol, from right to left on 
the label. Up to 17 characters can appear in the label 
window.

d. When you have completed the label, press [F3] (OK) to 
confirm the label, or [F2] (Cancel) to leave the window 
without adding the label.
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K        L      M      N      O      P      Q      R      S       T

U      V       W     X      Y       Z      0       1       2      3
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=      <       >       
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Entering User Functions (cont.)

3. The next prompt asks for the Units Symbol. 

a. Press [ENTER] to reopen the text creation window. 

b. Repeat the procedure used for the Label (on the previous 
page) to create the Units Symbol.

c. When you have completed the entry, press [F3] (OK) to 
confirm the symbol, or [F2] (Cancel) to leave the window 
without adding the symbol.

4. The next prompt asks you to select the number of decimal 
places.

a. Press [ENTER] to open the drop-down menu.

b. Scroll to the desired number of decimal places, ranging 
from 0 to 4.

c. Press [ENTER] to confirm the entry.

5. The final prompt asks for the function itself.

a. Press [ENTER] to open the function creation window, which 
appears similar to Figure 4-23 on the next page.

b. Use the four arrow keys to scroll to the desired function or 
table, and press [ENTER] to confirm each entry. Use the 
numeric keys to enter numeric values. Press [F1] (Delete) to 
remove any mistaken or unwanted symbols or numbers.

Note: Pressing [SEL] causes the screen to alternate between a set 
of symbols and functions and a list of user functions. Use 
both screens to create the desired function.
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Entering User Functions (cont.)

Figure 4-23: The Function Creation Window

c. To enter a particular measured parameter into the equation, 
click on the MODE symbol in the middle of the third row. 
The Select Measurement window (shown in Figure 4-19 
on page 4-40) opens. Select the desired data source and 
unit as discussed on page 4-40, and press [F3] (OK) to 
confirm the entry.

d. When you have completed entering the function, press [F3] 
(OK) to confirm the entry and return to the User Function 
window.

6. GE Sensing recommends pressing [F2] (Check) to test the 
validity of the function. The PT878GC displays either “OK” 
or a message such as “Syntax Error.”

• Press [F1] to delete the entire function and start again, or

• Press [F2] to cancel the function and return to Operate 
Mode.

• Press [F3] (Done) to confirm the function and return to 
Operate Mode.

Delete Cancel OK

+ * / ( )

^ E abs exp inv ln

log sqrt MODE
sin cos tan asin acos
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Entering Correction Factors

The final option in the Program Menu, Correction Factors, allows 
you to enter and modify three correction factors: Reynolds 
Correction, Kinematic Viscosity and Calibration Factor. To enter 
the Correction Factors option, scroll to the Correction Factors 
entry on the Program Menu and press [ENTER]. The screen appears 
similar to Figure 4-24 below.  To step through each parameter, 
press the [ ] key. Refer to Figure A-7 on page A-7 of Appendix 
A, Menu Maps.

Figure 4-24: Reynolds Correction Window

Entering Reynolds Correction

1. The first prompt asks if you want to enable the Reynolds 
Correction factor, a number based on the Kinematic Viscosity 
and flow rate of the gas. 

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

Reynolds Correction Inputs

Correction Factors

Cancel OK

Calibration Factor

Re Correction On Off

K/V x 10-6 m2/s

Data Source

K/V Factors   Single Table

Edit Table

10
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Entering Reynolds Correction  (cont.)

b. Press [ENTER] to confirm your selection.

Note: If you disable Reynolds Correction, you will not be able to 
enter any other values in this window.

2. If you enable Reynolds Correction, you will also need to enter 
the Kinematic Viscosity of the gas (available in the brochure 
Sound Speeds and Pipe Size Data, 914-004). The next prompt 
asks if you wish to enter the Kinematic Viscosity as a single 
number, or as a table of values.

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

3. The following steps depend on whether you select a single 
value or a table for Kinematic Viscosity. 

If you entered Single:

The prompt asks for a kinematic viscosity value.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the known value (from 
Sound Speeds and Pipe Size Data).

c. Press [ENTER] to confirm your selection.

You have completed entering data for a single Kinematic 
Viscosity factor.

If you entered Table:

The menu asks, first for the data source, and then for the entry of 
values into the Reynolds Correction table. This procedure allows 
the PT878GC to estimate Kinematic Viscosity from other 
measurements, such as signal strength.

a. Press [ENTER] to open the Data Source window. The Select 
Measurement window (Figure 4-19 on page 4-40) appears.
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Entering Reynolds Correction (cont.)

b. Enter the desired measurement and units as described on 
page 4-40.

c. Press [F3] (OK) to confirm your selection.

4. The prompt then asks if you wish to edit the Reynolds 
Correction table.

a. Press [ENTER] to open the table, which appears similar to 
Figure 4-25 below.

Figure 4-25: Window for Reynolds Correction Table

b. Use the numeric keys to enter the first value for the data 
source, and press [ENTER] to confirm the entry.

c. Press the [ ] key to move to the Reynolds value column. 
Use the numeric keys to enter the corresponding value, and 
press [ENTER] to confirm the entry.

d. Repeat steps b and c for the remainder of the table.

Inputs

Edit Reynolds Table

Cancel OK
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5
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Entering Reynolds Correction (cont.)

e. When you have completed entering values, press [F3] (OK) 
to confirm the table and return to the Correction Factors 
window.

You have completed entering data for a Reynolds Correction 
table.

• To confirm the entries, press [F3] (OK). The meter returns to 
Operate Mode.

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key. 

Entering a Calibration Factor

The Calibration Factor is used as a reference for the flowmeter 
electronics to ensure accurate readings. To enter a Calibration 
Factor, return to the Reynolds Correction tab at the top of the 
Correction Factors option. Press the [ ] arrow key to reach the 
Calibration Factor window. The window appears similar to 
Figure 4-26 below. To step through each parameter, press the [ ] 
key.

Figure 4-26: The Calibration Factor Window

Reynolds Correction Inputs

Correction Factors

Cancel OK

Calibration Factor

Edit Table

Calibration Factor On Off

Meter K-Factor

Data Source

K Factor   Single Table

1.0000
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Entering a Calibration Factor (cont.)

1. The first prompt asks if you wish to enable the calibration 
factor. 

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

2. The next prompt asks if you want a single K factor or a table 
of K factors.

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER]  to confirm your selection.

3. The following steps depend on whether you select a single 
value or a table. 

If you entered Single:

The prompt asks for a value.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the recommended value. 
Generally, if you have enabled the Reynolds Correction 
factor, the correction factor should be set to 1.00. 
Otherwise, the typical factor is between 0.5 and 2.00.

c. Press [ENTER] to confirm your selection.

You have completed entering data for a single Calibration Factor.

If you entered Table:

The menu asks, first for the data source, and then for the entry of 
values into the Correction Factor table.

a. Press [ENTER] to open the Data Source window. The Select 
Measurement window (Figure 4-19 on page 4-40) appears.
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Entering a Calibration Factor (cont.)

b. Enter the desired measurement and units as described on 
page 4-40.

c. Press [F3] (OK) to confirm your selection.

4. The prompt then asks if you wish to edit the K factor table.

a. Press [ENTER] to open the table, which appears similar to 
Figure 4-27 below.

Figure 4-27: The KFactor Table

b. Use the numeric keys to enter the first value for the data 
source, and press [ENTER] to confirm the entry.

c. Press the [ ] key to move to the KFactor column. Use the 
numeric keys to enter the corresponding value, and press 
[ENTER] to confirm the entry.

d. Repeat steps b and c for the remainder of the table.

e. When you have completed entering values, press [F3] (OK) 
to confirm the table and return to the Correction Factors 
window.

Inputs
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Cancel OK
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Entering a Calibration Factor (cont.)

You have completed entering data for correction factors.

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.

In either case, the meter returns to Operate Mode.
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Chapter 5

Creating and Managing Sites

The PT878GC can store site data in files for current and future 
access. (To learn how to program setup data, refer to Chapter 4, 
Programming Site Data.) After you answer the necessary 
questions, simply save the information to a site file. The Site 
Manager option then enables you to recall, rename, print, transfer 
or delete site files as needed. 

To open the Site Menu, press the [MENU] key at the lower right of 
the PT878GC keypad. The Menu Bar replaces the Status Bar at 
the top of the screen. Then press [ENTER]. The screen now appears 
similar to Figure 5-1 below.  While following the programming 
instructions, refer to Figure A-2 on page A-2 of Appendix A, 
Menu Maps.

Figure 5-1: The Site Menu in the Main Menu
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Velocity, ft/s

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s
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1 View
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Drive Manager
FKeys                     4
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Site     Program  
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The Site Manager

From the Site Menu, press [ENTER] to open the Site Manager. The 
screen appears similar to Figure 5-2 below.

Figure 5-2: The Site Manager Window

Note: Each PT878GC comes preprogrammed with a basic site, 
Default, which serves as a basis for saving data and 
creating other sites.

The right section of the screen supplies information for the site 
highlighted in the list on the left: the date, time, and file size, as 
well as the amount of free memory remaining. You can use the 
[ ] and [ ] arrow keys to scroll to a particular site and display 
information pertaining to that site.

To open the File submenu within the Site Manager, press [MENU] 
and then [ENTER]. The screen now appears similar to Figure 5-3 
on page 5-3.

Site Manager

Info: DEFAULT:SIT

03/04/04  14:51:10
5111 bytes
118272 bytes free

   Refresh
  

DEFAULT
New Site

File Site   Sort

**CURRENT SITE**

Exit
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The Site Manager (cont.)

Figure 5-3: The Site Manager Menu

• To create a new site, go to page 5-4.

• To open an existing site (thus replacing the current site), go to 
page 5-6.

• To save a current site, go to page 5-7.

• To refresh site information, go to page 5-9.

• To rename a site, go to page 5-9.

• To delete a site, go to page 5-10.
You can access four additional functions from the Site submenu 
(shown in Figure 5-11 on page 5-11).

• To add a site message, go to page 5-11.

• To print out a site, go to page 5-13.

• To transfer a site to a PC, go to page 5-13.

• To transfer a site from a PC to the PT878GC, go to page 5-14.

Site Manager
File

Info: DEFAULT:SIT

09/04/04  14:51:10
5111 bytes
118272 bytes free

  Refresh Exit
  

DEFAULT
New Site

New
Open
Save
Save As

Rename
Delete

Site   Sort

Refresh
Creating and Managing Sites 5-3



April 2009
Creating a New Site

To create a new site in the Site Manager, press [MENU] in the Site 
Manager. Be sure the option New is highlighted, and then press 
[ENTER]. The screen appears similar to Figure 5-4 below.

Figure 5-4: Name Entry Window for a New Site

1. Use the four arrow keys to scroll to the desired letter or 
number, and press [ENTER]. 

2. Repeat this procedure until you have created the desired site 
name of up to eight characters. (Press [F1], Delete, to remove 
any unwanted letters or numbers.) 

3. When you have finished, press [F3], OK, to confirm the entry. 

A second screen appears (as shown in Figure 5-5 on the next 
page) asking if you want to use the currently highlighted site as a 
template for the new site, using its current display windows, 
measurements and programmed data. (To modify the display and 
measurements, refer to Chapter 6, Displaying and Configuring 
Data. To alter programming data, see Chapter 4, Programming 
Site Data.)

• Press [F2] (No) if you do not want to use it, or

• Press [F3] (Yes) if you want to use it as a template.
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Y        Z         0        1         2         3         4          5
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New Site

Delete Cancel OK

   
5-4 Creating and Managing Sites



April 2009
Creating a New Site (cont.)

Figure 5-5: Template Confirmation Window

The meter returns to Operate Mode, with the new site name 
displayed in the upper left corner of the screen.
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Opening an Existing Site

If you want to return to a second site that you have previously 
saved, first highlight the replacement site in the left window of 
the Site Manager. Then press [MENU] to open the File Menu. 
Scroll to the Open option, and press [ENTER]. The screen appears 
similar to Figure 5-6 below.

Figure 5-6: The Open Site Confirmation Window

• Press [F2] (No) to cancel opening the site and return to the 
current site, or

• Press [F3] (Yes) to open the site. 

If you have changed the first site (that is, the one you are now 
closing by opening the second site), the PT878GC asks if you 
want to save the changes to the first site.

• Press [F2] (No) to cancel the changes, or

• Press [F3] (Yes) to confirm and save the changes.
The PT878GC returns to Operate Mode, with the selected site 
displayed in the upper left corner of the screen.

1 View

Programming

Site Manager

  No Yes

Info:DEFAULT

        
GLOBAL

File

DEFAULT

Open Confirmation

ResReOpen File DEFAULT 
Are You Sure?
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Saving a Site

You can save the current site in one of two ways:

• From the Site Menu, you can scroll down to the Save Now 
option and press [ENTER], or

• From within the Site Manager, press [MENU], scroll to the Save 
option, and press [ENTER].

In either case, the screen appears similar to Figure 5-7 below.

Figure 5-7: The Save Current Site Window

• Press [F2] (No) to cancel saving the site, or

• Press [F3] (Yes) to save the site.

The PT878GC remains in the current window (Operate Mode or 
Site Manager), with the current site saved.

         

   No Yes

Save the current site
(DEFAULT.SIT)?

         Save Site
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Saving a Site with a Different Name

If you want to save the current site with a different name, open 
the Site Manager, press [MENU] to open the File Menu, scroll to 
the Save As option, and press [ENTER]. The screen appears similar 
to Figure 5-8 below.

Figure 5-8: The Save As (Another Name) Window

1. Use the four arrow keys to scroll to the desired letter or 
number, and press [ENTER]. 

2. Repeat this procedure until you have created the desired site 
name with up to eight characters. (Press [F1], Delete, to 
remove any unwanted letters or numbers.)

3. When you have finished, 

• Press [F2] (Cancel) to erase the entry, or

• Press [F3], OK, to confirm the entry. 
The Save Site window then appears. 

• Press [F2] (No) to cancel saving the site, or

• Press [F3] (Yes) to save the site.
The PT878GC remains in Site Manager, with the current site 
saved under both the old and new names.
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Refreshing a Site

You can refresh a site (updating the display with the most current 
information) in one of two ways:

• Press [F2], Refresh, to refresh the highlighted file.

• From the File Menu, scroll to the Refresh option and press 
[ENTER].

The updated information on the highlighted file appears in the 
window on the right.

Renaming a Site

If you want to rename a site, first be sure the site has been 
highlighted in the left window of the Site Manager. Then press 
[MENU] to enter the File Menu, scroll to the Rename option, and 
press [ENTER]. The screen appears similar to Figure 5-9 below.

Figure 5-9: The Rename Site Window

Use the four arrow keys to scroll to the desired letter or number, 
and press [ENTER]. Repeat this procedure until you have created 
the desired site name. (Press [F1], Delete, to remove any 
unwanted letters or numbers.) When you have finished, 

• Press [F2] (Cancel) to erase the entry, or

• Press [F3], OK, to confirm the entry.
The PT878GC remains in Site Manager, with the site listed under 
the new name (but not the old name).
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Deleting a Site

To delete a site in the Site Manager, first be sure you have 
highlighted that site in the left window of the Site Manager. Then 
press [MENU], scroll to the Delete option, and press [ENTER]. The 
screen appears similar to Figure 5-10 below.

Figure 5-10: The Delete Confirmation Window

• Press [F2], No, to cancel the deletion and return to the Site 
Manager, or

• Press [F3], Yes, to delete the site.

The Site Manager appears, with the highlighted site now deleted.
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Programming
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Creating a Site Message

The Site Message option allows you to add an explanatory 
message (with up to 30 characters or spaces) for any given site. 
To create a site message:

1. Press [MENU] to enter the File Menu. Then press the [ ] arrow 
key once to scroll from the File Menu to the Site Menu. Press 
[ENTER]. The screen appears similar to Figure 5-11 below. 

Figure 5-11: The Site Menu in the Site Manager

2. Press [ENTER] to select “Message,” which opens the text 
creation window, shown in Figure 5-12 on the next page.
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Creating a Site Message (cont.)

Figure 5-12: The Text Creation Window

3. Use the four arrow keys to scroll to the desired letter or 
symbol, and press [ENTER] to add the letter to the message.

Note:  Pressing [SEL] causes the screen to alternate between a 
set of upper-case (capital) letters, a set of lower-case 
letters, and a set of symbols. Use all three screens to 
create a desired message.

4. Repeat this procedure for each letter or symbol you wish to 
add to the message. If you wish to delete a letter, press [F1] 
(Delete) to erase each letter or symbol, from right to left on the 
label.

5. When you have completed the message, press [F3] (OK) to 
confirm the message, or [F2] (Cancel) to leave the window 
without adding the message.
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Printing a File

To print a file from the Site Manager, press [MENU] to enter the 
File Menu, press the [ ] arrow key once, scroll to the Print 
option, and press [ENTER]. The PT878GC shows a message 
indicating that its infrared scanner is looking for a receiving 
device. (If the scanner finds no device, a window appears 
indicating that the meter can find no device. If it finds more than 
one compatible infrared device within range, it asks you to select 
the desired device.) If successful, the PT878GC returns to 
Operate Mode, while the thermal printer prints out the current 
site.

Transferring a Site File to a PC

To upload a site file to a PC, you must have an infrared sensor 
connected to the PC (or incorporated into the PC) that can receive 
data from the PT878GC IR beam.

1. Check that the Communications option (see page 7-15) has 
been set to the IrDA protocol.

Note: For Windows NT 4.0, check that the QuickBeam software 
(available through the path C:\Program Files\QuickBeam 
Suite) is running, and that the IR beam on the PT878GC 
has clear access to the IR sensor connected to the PC 
port.  

2. Highlight the desired site in the left window of the Site 
Manager.

3. Press [MENU] to open the File Menu, press the [ ] arrow key 
once, scroll to the Transfer option, and press [ENTER]. 

The screen shows a message indicating that the PT878GC is 
searching for an infrared device. (If the scanner finds no device, a 
window appears with this message, and asks if you want to try 
again.) If it finds a device, it sends another message indicating 
that it is uploading the site. (The meter also displays a message if 
the upload fails.) When the upload is complete, the meter returns 
to the Site Manager. The PC holds the transferred file in the 
QuickBeam (or IR) Inbox folder, as shown in Figure 5-13 on 
page 5-14. You can open the file on the PC using any text editor.
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Transferring a Site to a PC (cont.)

Figure 5-13: The IR_Inbox Folder with 
Transferred Site File

Transferring a File as Text

If you want to review site programming data as text, the 
PT878GC can transfer a site file to a PC in a Unicode text format 
that can be opened by text editors such as Notepad or Word. 
Again, you must have an infrared sensor connected to the PC (or 
incorporated into the PC) that can receive data from the 
PT878GC IR beam.

1. Check that the Communications option (see 
page 7-15) has been set to the IrDA protocol.

Note: For Windows NT 4.0, check that the QuickBeam software 
(available through the path C:\Program Files\QuickBeam 
Suite) is running, and that the IR beam on the PT878GC 
has clear access to the IR sensor connected to the PC 
port.  

2. Highlight the desired site in the left window of the Site 
Manager.

3. Press [MENU] to open the File Menu, press the  [ ] arrow key 
once, scroll to the Transfer as Text option, and press [ENTER].

The PT878GC transfers the file as discussed on the previous 
page; however, the file has a .txt extension, and it cannot be sent 
back to the PT878GC in this format.
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Transferring a File from a PC to the PT878GC

Once you have stored site or meter files to a PC, you can then 
transfer them back to the PT878GC over the IR interface. The 
PT878GC only accepts files with a .sit (site) or .met (meter) 
extension. If you rename another type of file with one of these 
extensions and transfer it, it will be transferred, but will not 
function if you open it. Also, if you are transferring a file and the 
meter already has a file with the identical name, the meter will 
overwrite its current file with the transferred file. If the 
transferred file has a name longer than eight characters, the meter 
will shorten the name to eight characters, and replace any spaces 
in the name with underbars.

To download a site or meter file from a PC to a PT878GC:

1. Check that the Communications option (see page 7-15) has 
been set to the IrDA protocol.

Note:  For Windows NT 4.0, check that the QuickBeam software 
(available through the path C:\Program Files\QuickBeam 
Suite) is running, and that the IR beam on the PT878GC 
has clear access to the IR sensor connected to the PC 
port. 

2. You can send the file in one of two ways:

• Click on the desired file, and drag it onto the rocket button 
in the QuickBeam window, as shown in Figure 5-14 below.

Figure 5-14: The QuickBeam Window

• Open the Send menu in the QuickBeam window, enter the 
Files or Files on Clipboard option, scroll to the desired file, 
and click Send.
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Transferring a File from a PC to the PT878GC (cont.)

QuickBeam opens a window indicating that it is downloading the 
file. If you close and reopen the Site Manager, the file appears as 
one of the listed sites.

Note: While sending or receiving files, the PT878GC continues 
to perform measurements, but at a slower rate than 
normal.
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Listing Files by Name

If you want to list your files alphabetically by site name within 
the Site Manager, press [MENU] to open the File Menu. Then press 
the [ ] arrow key twice to scroll from the File Menu to the Sort 
Menu, shown in Figure 5-15 below. Press [ENTER]. The Site 
Manager screen refreshes, with the sites listed in alphabetical 
order.

Figure 5-15: The Sort Submenu

Listing Files in Chronological Order

If you prefer to list your files chronologically by time of creation 
within the Site Manager, press [MENU] to open the File Menu. 
Then press the [ ] arrow key twice to scroll from the File Menu 
to the Sort Menu, and scroll to the By Date option. Press [ENTER]. 
The Site Manager screen refreshes, with the sites listed in 
chronological order, from the most recent to the earliest.

Site Manager
File

Info: DEFAULT:SIT

03/04/04  14:51:10
5111 bytes
118272 bytes free

   Refresh Exit
  

New SiteBy Date

Site Sort
By NameDEFAULTb
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Chapter 6

Displaying and Configuring Data

The PT878GC allows you to view from one to four different 
measurement parameters simultaneously. The screen can show 
these parameters not only in numeric format, but as line or bar 
graphs as well. 

You can configure any given measurement for your particular 
requirements. To configure an individual measurement, press 
[SEL] from the Operate Mode window shown in Figure 2-5 on 
page 2-9. A cursor appears next to the parameter closest to the 
upper left corner. Continuing to press [SEL] enables the cursor to 
scroll through the other displayed measurements. Once you have 
reached a particular window, pressing the [ENTER] button opens 
the menu for that window, as shown in Figure 6-1 below. To learn 
how to use the display window menu, go to pages 6-2 to 6-6.

] 

Figure 6-1: Display Screen After Pressing [SEL]

2004/11/30    09:53 AM

4Velocity, ft/s

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

ABC.SIT

Signal, dB
Format View Measurement
Displaying and Configuring Data 6-1



April 2009
The Format Option

The first option on the menu, Format, allows you to specify the 
type of notation and the number of decimal places for the 
measurement in that window. Press [ENTER] and the submenu 
shows two options, Decimal Place and Notation. Press the [ ] or 
[ ] arrow keys to select either entry, and press [ENTER]. The 
screen appears similar to Figure 6-2 below. To scroll to a 
particular parameter or menu entry, press the [ ] or [ ] key.

Note: If the window displays a line or bar graph, the Limits 
option (see page 6-5) appears instead of Format in the 
menu.

Figure 6-2: The Number Format Window

1. The first entry, Format, asks you to select the numeric format 
from three choices: fixed decimal, default and scientific. 
Default provides the default resolution, while Fixed Decimal 
allows users to override the standard resolution. Scientific 
format displays the value in mantissa and exponent format.

a. Press [ENTER] to open the drop-down list of format choices.

b. Scroll to the appropriate selection.

c. Press [ENTER] to confirm your choice.

Programming

Number Format

Cancel OK

Format Fixed Decimal

  Decimal Places 2
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The Format Option (cont.)

2. The second step asks you to choose the number of decimal 
places to be displayed. Available choices range from 0 to 4 
places.

a. Press [ENTER] to open the drop-down list.

b. Scroll to the appropriate number. 

c. Press [ENTER] to confirm your choice.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key.
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The View Option

The second option, View, allows you to select the presentation of 
a parameter in one of three formats: numeric, line graph or bar 
graph. 

1. From the Display Menu, press the [ ] key once to reach the 
View option, and then press [ENTER].

2. A drop-down menu shows the three formats. Scroll to the 
appropriate selection.

3. Press [ENTER] to confirm your selection.

The screen immediately displays any changes. For example, if 
you have changed the first parameter to a line graph, the screen 
appears similar to Figure 6-3 below.

Figure 6-3: Screen After Format Change
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The Limits Option

Once you have configured a parameter as a line or bar graph, you 
might need to change its presentation or values. The Limits 
option (replacing the Format option for line and bar graphs) 
enables you to program the minimum or maximum values 
displayed, the time interval and the display of the average value. 

To enter the Limits option:

1. Press [SEL] from the Operate Mode window until you have 
reached the desired measurement. 

2. Press [ENTER] to open the Display Menu.

3. Be sure the Limits option is highlighted, and press [ENTER].  

The screen appears similar to Figure 6-4 below.

Figure 6-4: The Line (or Bar) Graph Parameters Window
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The Limits Option (cont.)

4. The first prompt asks for the minimum value shown in the 
graph.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the value.

5. Repeat the procedure in step 5 to enter the maximum value.

A line graph involves two more prompts.

6. The next prompt asks for the display interval.

a. Press [ENTER] to open the text box. Use the numeric keys to 
enter the desired number. Press [ENTER] to confirm the 
value.

b. The second box asks for the interval in terms of seconds, 
minutes, hours, or days. Press [ENTER] to open the drop-
down menu, and then press the [ ] or [ ] keys to move 
to the desired parameter. Press [ENTER] to confirm the entry.

7. The final three prompts ask for details of the graph 
configuration: if you want to use lines, plot the average value, 
or show the minimum and maximum values. Press the [ ]  
key to step through each value, and press [ENTER] to add a 
given detail as part of the graph.

8. When you have configured the graph, press [F3], OK, to 
confirm the graph settings.

The screen returns to Operate Mode, and displays any changes.
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The Measurement Option

On occasion, you might need to change the actual parameter 
measured in a given window.The Measurement option enables 
you to reconfigure the window with one of five categories of data 
source (velocity, volume, forward or reverse totalizer, or 
diagnostics) and appropriate English or metric measurement 
units.

To enter the Measurement option:

1. Press [SEL] from the Operate Mode window until you have 
reached the desired measurement. 

2. Press [ENTER] to open the Display Menu.
3. Be sure the Measurement option is highlighted, and press 

[ENTER]. 
The screen appears similar to Figure 6-5 on page 6-8. The left 
column displays the measurement data sources, while the right 
column displays English and metric measurement units (or, with 
the Diagnostics source shown, a list of diagnostics parameters).

4. Use the [ ] and [ ] arrow keys to reach the desired data 
source, and press [SEL]. 

5. Then use the [ ] or [ ] arrow keys to select the desired 
measurement unit (or diagnostic parameter).To speed 
scrolling, you can press the  [ ] key to scroll down by a page, 
or the [ ] key to scroll up by a page. Press [F3], OK, to 
confirm the entry.

6. The screen returns to Operate Mode, and displays any 
changes.
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The Measurement Option (cont.)

Figure 6-5: The Measurement Menu Window
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Customizing the Display Screen

You might wish to display one or two parameters, or customize 
the soft keys to quickly access particular menus. The Site Menu 
enables you to make more comprehensive changes in your 
display screen.

To enter the Site Menu, press the [MENU] key at the lower right of 
the PT878GC keypad. The Menu Bar replaces the Status Bar at 
the top of the screen. The Site Menu will be highlighted in the 
upper left corner. Press [ENTER] or the [ ] arrow key. The screen 
now appears similar to Figure 6-6 below. While following the 
programming instructions, refer to Figure A-2 on page A-2 of 
Appendix A, Menu Maps.

Figure 6-6: The Site Menu

• To specify the number of parameters displayed, go to page
 6-10.

• To customize or clear softkeys (FKeys), go to page 6-11.
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Specifying the Number of Displayed Parameters

As mentioned earlier, the PT878GC can display one to four 
different measurement parameters simultaneously. However, 
sometimes you might wish to display only one or two parameters. 
To change the number of open display windows:

1. Press [MENU].

2. From the Site Menu (shown in Figure 6-6 on page 6-8), use 
the [ ]or [ ] arrow keys to move to the desired number of 
views (1 View, 2 Views, etc.) Press [ENTER].

The screen displays the designated number of windows. For 
example, Figure 6-7 below shows the screen displayed in Figure 
6-3 on page 6-4, reconfigured for a single view. 

Figure 6-7: Display Screen Configured for Single View

Note: The PT878GC opens display windows from the top; that 
is, if you press “1 View,” one parameter appears. If you 
press “2 Views,” two parameters appear, one on the top 
and one on the bottom. The view for “3 Views” adds a 
window in the lower right, and that for “4 Views” sends 
the second parameter to the upper right corner, with the 
third parameter in the lower left and the fourth parameter 
in the lower right.
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Customizing Softkeys

When the screen is in Operate mode, you might wish to access a 
particular submenu frequently without the trouble of scrolling 
through menus. Customizing the softkeys (the function keys —
[F1], [F2] and [F3]) allows you to access up to three submenus by 
pressing the associated softkey. You can customize a softkey 
from the Site Menu or from within a particular menu.

• To customize a softkey from the Site Menu:

1. Press [MENU].

2. From the Site Menu (shown in Figure 6-6 on page 6-9), use 
the [ ] or [ ] arrow keys to move to the FKeys entry on the 
menu. Press [ENTER]. The screen now appears similar to Figure 
6-8 below.

Figure 6-8: The FKeys Menu

3. Use the [ ] or [ ] arrow keys to move to the desired FKey 
(1, 2 or 3) entry on the menu. Press [ENTER]. The Configure 
FKey window opens, as shown in Figure 6-9 on the next page.
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Customizing Softkeys (cont.)

Figure 6-9: The Configure FKey Window

4. Press [ENTER] to open the menu drop-down list. Then use the 
[ ] or [ ] arrow keys to scroll to the desired submenu (for 
example, Contrast).

5. Press [ENTER] to confirm the entry, and press [F3]  (OK) to 
confirm the entry and close the window. (Press [F2] (Cancel) 
to close the window without changing the key.)

The screen now appears similar to Figure 6-10 on the next page, 
with the [F1] window displaying “Contrast.” Pressing [F1] opens 
the Contrast window.

• To customize a softkey from a particular menu:

1. Open the desired menu on the Menu Bar (see Chapters 4, 5, 7 
8, and 9 for details on particular menus) and scroll to the 
desired option.

2. Press the desired softkey. A window appears with the 
question, “Assign current menu command to FKeyX?”

3. Press [F3]  (Yes) to confirm the assignment and close the 
window. (Press [F2] (No) to close the window without 
changing the key.)

Configure FKey

Cancel OK

Select a menu item

(CLEAR)

Site Manager
Save Now
1 View
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Customizing Softkeys (cont.)

Figure 6-10: The Display Screen with Modified Softkey

• To clear a softkey:

1. Press [MENU].

2. From the Site Menu (shown in Figure 6-6 on page 6-8), use 
the [ ] or [ ] arrow keys to move to the FKeys entry on the 
menu. Press [ENTER]. The screen now appears similar to Figure 
6-8 on page 6-11.

3. Use the [ ] or [ ] arrow keys to move to the desired Clear 
FKey (1, 2 or 3) entry on the menu. Press [ENTER].

The softkey window clears. You can also clear the softkey 
through the Configure FKey window, by selecting (Clear) as an 
entry, pressing [ENTER] and then [F3], OK.

Note: Since the customized softkeys are saved globally, they will 
remain, even if you change site files.
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Managing Files — The Drive Manager

On occasion, you might want to review, print or transfer some or 
all of the files in the PT878GC. The Drive Manager allows you to 
view all the files stored in the meter. To open the Drive Manager:

1. Press [MENU].

2. From the Site Menu (shown in Figure 6-6 on page 6-8), use 
the [ ] or [ ] arrow keys to move to the Drive Manager 
entry on the menu. Press [ENTER]. The screen now appears 
similar to Figure 6-11 below. 

Figure 6-11: The Drive Manager Window

The window on the left lists all the meter, site and log files in the 
PT878GC, while the window on the right displays information on 
the file highlighted in the left window. 
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Managing Files — The Drive Manager (cont.)

Figure 6-12: The File Manager Menu

To transfer, refresh or delete a file, first be sure the file is 
highlighted in the window on the left. Then press [MENU] and 
scroll to the appropriate option, as shown in Figure 6-12 above. 
Press [ENTER]. The PT878GC then performs the desired action 
with the file.

• To refresh a file, go to the next page.

• To transfer a file to or from a PC, go to the next page.

• To delete a file, go to page 6-19.
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Refreshing a File

You can refresh a file (updating the display with the most current 
information) in one of two ways:

• Press [F2], Refresh, to refresh the highlighted file.

• From the File Menu, scroll to the Refresh option and press 
[ENTER].

The updated information on the highlighted file appears in the 
window on the right.

Transferring a File to a PC

To upload a log, meter, screen capture (bitmap) or site file to a 
PC:

1. Check that the Communications option (see page 7-15) has 
been set to the IrDA protocol.

Note: For Windows NT 4.0, check that the QuickBeam software 
(available through the path C:\Program Files\QuickBeam 
Suite) is running, and that the IR beam on the PT878GC-
GC has clear access to the IR sensor connected to the PC 
port.  

2. Highlight the desired site in the left window of the Drive 
Manager.

3. Press [MENU], scroll to the Transfer option, and press [ENTER]. 

The screen shows a message indicating that the PT878GC is 
searching for an infrared device. (If the scanner finds no device, a 
window appears with this message, and asks if you want to try 
again.) If it finds a device, it sends another message indicating 
that it is uploading the site. (The meter also displays a message if 
the upload fails.) When the upload is complete, the meter returns 
to the Drive Manager. The PC holds the transferred file in the 
QuickBeam (IR) Inbox folder, as shown in Figure 6-13 on the 
next page. You can open the file on the PC using any text editor.
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Transferring a File to a PC (cont.)

Figure 6-13: The IR_Inbox Folder with 
Transferred File

Transferring a File from a PC to the PT878GC

Once you have stored site or meter files to a PC, you can then 
transfer them back to the PT878GC over the IR interface. The 
PT878GC only accepts files with a .sit (site) or .met (meter) 
extension. If you try renaming another type of file with a .sit or 
.met extension and transfer it, it will be transferred, but it will not 
function if you open it. Also, if you are transferring a file and the 
meter already has a file with the identical name, the meter will 
overwrite its current file with the transferred file. If the 
transferred file has a name longer than eight characters, the meter 
will shorten the name to eight characters, and replace any spaces 
in the name with underbars.

Note: It is not possible to download log files back to the 
PT878GC.

To download a site or meter file from a PC to a PT878GC:

1. Check that the Communications option (see page 7-15) has 
been set to the IrDA protocol.
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Transferring a File from a PC to the PT878GC (cont.)

Note: For Windows NT 4.0, check that the QuickBeam software 
(available through the path C:\Program Files\QuickBeam 
Suite) is running, and that the IR beam on the PT878GC 
has clear access to the IR sensor connected to the PC 
port.  

2. You can send the file in one of two ways:

• Click on the desired file, and drag it onto the rocket button 
in the QuickBeam window, as shown in Figure 6-14 below.

Figure 6-14: The QuickBeam Window

• Open the Send menu in the QuickBeam window, enter the 
Files or Files on Clipboard option, scroll to the desired file, 
and click Send.

QuickBeam opens a window indicating that it is downloading the 
file. When the download is complete, the meter returns to the 
Drive Manager. If you close and reopen the Drive Manager, the 
file appears as one of the listed sites.

Note: While sending or receiving files, the PT878GC continues 
to perform measurements, but at a slower rate than 
normal.
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Deleting a File

To delete a file in the File Manager, first be sure you have 
highlighted that site in the left window of the File Manager. Then 
press [MENU], scroll to the Delete option, and press [ENTER]. The 
screen appears similar to Figure 6-15 below.

Figure 6-15: The Delete Confirmation Window

• Press [F2], No, to cancel the deletion and return to the File 
Manager, or

• Press [F3], Yes, to delete the site.

The File Manager appears, with the highlighted site now deleted.

1 View

Programming

File Manager

  No Yes

Info:DEFAULT

        
GLOBAL

File

DEFAULT

Delete Confirmation

ResReDelete The Site ‘A.SIT’ 
Are You Sure?
Displaying and Configuring Data 6-19



April 2009
Listing Files by Name

If you want to list your files alphabetically by site name within 
the File Manager, press [MENU] to open the File Menu. Then press 
the [ ] arrow key to scroll from the File Menu to the Sort Menu, 
shown in Figure 6-16 below. Press [ENTER]. The File Manager 
screen refreshes, with the sites listed in alphabetical order.

Figure 6-16: The Sort Submenu

Listing Files in Chronological Order

If you prefer to list your files chronologically by time of creation 
within the File Manager, press [MENU] to open the File Menu. 
Then press the  [ ] arrow key to scroll from the File Menu to the 
Sort Menu, and scroll to the By Date option. Press [ENTER]. The 
Site Manager screen refreshes, with the sites listed in 
chronological order, from the most recent to the earliest.

SYS.LOG

File  Manager
File

Info: DEFAULT:SIT

09/04/02  14:51:10
5111 bytes
118272 bytes free

   Refresh Exit
  

New Site

Sort

DEFAULT.
GLOBAL.
TABLE.MET
FUNCTIO
AAA.LOG
BBB.LOG
CCC.LOG
Q.LOG

bBy Name
By Date
6-20 Displaying and Configuring Data



April 2009
Accessing Meter Data —The About Option

The About option displays useful information concerning the 
model number and software version of your PT878GC. While the 
window normally appears briefly at startup, users might want to 
access the information for a longer period. To open the About 
window, scroll to the About option on the Site Menu and press 
[ENTER]. The screen appears similar to Figure 6-17 below. 

Figure 6-17: The About Window

To find out details about your specific software version, press 
Next ([F2]). To return to Operate Mode, press [ESC] or Exit ([F3]).
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Chapter 7

Programming Meter Settings

Along with display formats and site data, PT878GC users can 
program global settings for the meter that suit their individual 
preferences. The global settings include:

• English or Metric measurement units

• Battery power

• Date and time parameters and appearance

• Screen contrast

• Backlight timeout

• Language settings

• Infrared communications settings

• Resetting forward and reverse totals

• User tables

• Printing and capturing screens
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Entering the Meter Menu

To enter the Meter Menu, press the [MENU] key at the lower right 
of the PT878GC keypad. The Main Menu replaces the Status Bar 
at the top of the screen. Press the [ ] arrow key twice to scroll 
from the Site Menu to the Meter Menu. At the Meter Menu, press 
[ENTER]. The screen appears similar to Figure 7-1 below. While 
programming, refer to Figure A-8 on page A-8 of Appendix A, 
Menu Maps.

Figure 7-1: The Meter Menu

To scroll to a particular option, press the [ ] or [ ] arrow keys 
until you reach the option. Then press [ENTER] to open the option 
window.

When entering parameters in an option, press:

• The  [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any 
time and return to Operate Mode without changing the 
parameters.
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Selecting Measurement Units

The first option, Units, enables you to select either English or 
Metric units as global measurement units for the PT878GC. The 
selected units then become the default settings for every 
measurement that has the option for metric/English units. In 
addition, you can select the type of pressure units displayed. To 
select the units, scroll to the Units entry on the Meter menu and 
press [ENTER]. The Meter Settings window opens, as shown in 
Figure 7-2 below.

Figure 7-2: The Meter Settings Window

1. At the Units prompt, use the [ ] and [ ] keys to scroll 
between English and Metric units.

2. Press [ENTER] to confirm the choice.

3. To enter the Pressure Units prompt, press the [ ] key and 
then the  [ ] keys to reach the prompt.
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Selecting Measurement Units (cont.)

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] and [ ] arrow keys to scroll to the desired 
choice:

• PSIA

• KPA

• Bars

• MMGH
c. Press [ENTER] to confirm the entry.

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). 

• To leave the window without confirming the entries, press [F2] 
(Cancel) or the [ESC] key.

In either case, the meter returns to Operate Mode.
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The Battery Charger
The Battery option allows you to monitor the current run time and 
status of the internal rechargeable batteries, as well as to 
condition NiCad batteries to maintain the maximum life possible. 
Conditioning NiCad batteries (a process that can take up to 12 
hours for a fully charged pack) discharges the pack completely 
and then performs a fast charge. 
Note: When conditioning the batteries, be sure you have 

plugged the AC adapter into the PT878GC and pressed 
the power key. NiMH batteries normally do not require 
conditioning.

To open the option window:
1. From the Meter menu, scroll to the Battery entry and press 

[ENTER]. The Battery Charger window opens, as shown in 
Figure 7-3 below. 

2. If you wish to open the Part Number window, press [ENTER]. 
You can choose from a 1.8 Ahr NiCd battery (part number 
200-058) or a 3.0 Ahr NiMH battery (part number 200-081). 
Scroll to the battery type you have installed and press [ENTER].

Note: If you do not set the correct battery type in the Part 
Number window, the battery continues to function, but the 
battery status icons (see page 2-5) will not be accurate.

Figure 7-3: The Battery Charger Window

Battery Charger

Cancel OK

Status: Full Charge

Battery Voltage: 5.78 Volts
Battery Type:  NiCd

Condition Battery

Run Time Remaining:  

Backup Battery: OK
       Part Number: 1.8Ahr NiCd (200-058)
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The Battery Charger (cont.)

3. To condition the batteries, press the [ENTER] key. The 
“Condition Battery” window should now read “Stop.” The 
status line should change to “Discharging.” (Updating the 
status could take up to 30 seconds.)

Note: It is advisable to condition NiCad batteries when their run 
time is reduced to 50% of their previous run time.

4. To stop the discharge cycle, press the [ENTER] key and the 
“Condition Battery” window reappears. The status now 
changes to “On Charger.”

5. Press [F3], OK, to return to Operate Mode.
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Entering Date and Time 

In Operate mode, the Status Bar displays the current date and 
time above the measurements in the upper right corner of the 
screen. The Date/Time option allows you to set the date or time, 
which are required for correct data logging operation.

To set the time:

1. From the Meter menu, scroll to the Date/Time entry and press 
[ENTER]. The Meter Settings window reopens, as shown in 
Figure 7-2 on page 7-3. 

2. From the Units option, press the [ ] key once to reach the 
date text box. This box displays the current meter date. 

3. Press [ENTER] to enter the text window. The meter highlights 
the first number. Use the [ ] and [ ] keys to scroll to any 
number you wish to change.

4. Two alternatives are available to change a highlighted 
number:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit 
increments, to the desired number. (For example, if the text 
box highlights 09, pressing the [ ] key twice changes the 
number to 07.) You can scroll from 01 to 12 for the month 
and from 01 to 31 for the day (depending on the number 
you have selected for the month).

In either case, press [ENTER] to confirm the entry.
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Entering Date and Time (cont.)

To set the date:

1. From the date text box, press the [ ] key once to scroll to the 
time text box. This box displays the current meter time. 

2. Press [ENTER] to enter the text box. The meter highlights the 
first number. Use the [ ] and [ ] keys to scroll to any 
number you wish to change.

3. Two alternatives are available to change a highlighted 
number:

• Use the numeric keys to enter the desired number.

• Use the [ ] or [ ] arrow keys to scroll, in 1-digit 
increments, to the desired number. (For example, if the text 
box highlights 09, pressing the  [ ] key twice changes the 
number to 07.) You can scroll from 01 to 12 for the hour 
and from 01 to 59 for the minute and second inputs.

4. In either case, press [ENTER] to confirm the entry.

Pressing the [ ] or [ ] arrow keys causes the meter to scroll 
within the Meter Settings options.

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Changing Date and Time Appearance (Locale)

In addition to setting the correct date and time, you can also 
change its presentation to suit local preferences. You can select a 
time display of AM/PM or 24-hour time

To alter the time and date display:

1. From the Meter menu, scroll to the Locale entry and press 
[ENTER]. The Display Options window opens on the Format 
tab, as shown in Figure 7-4 below. To step through each 
parameter, press the [ ] key.

 

Figure 7-4: Format Tab in the Display Options Window

Display

   Display Options

Locale

Date Format

Separators:

Time Format

Time

Date/Time, Decimal Formats:

MM/DD/YYYY

/

12 Hour

:

MM/DD/YYYY  HH:MM:SS PM,  123.45

Cancel OK

DecimalDate .
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Changing Date and Time Appearance (cont.)

2. The first series of prompts asks you to select separator 
symbols for the date, time and decimal. You can choose from 
a dash, comma and slash (/) for the date; from a period and 
colon for the time: and from a period or comma for the 
decimal place. For each symbol type:

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired 
format.

c. Press [ENTER] to confirm your entry.

3. The next prompt asks you to select the date format.

a. Press [ENTER] to open the drop-down menu. Three options 
are available:

•YYYY/MM/DD (year/month/day)

•MM/DD/YYYY (month/day/year)

•DD/MM/YYYY (day/month/year)

b. Use the [ ] or [ ] arrow keys to scroll to the desired 
format.

c. Press [ENTER] to confirm your entry.

4. The PT878GC now asks you to select whether you want the 
time presented in a 12-hour format (for example, 11:53:23 
PM) or in a 24-hour format (23:53:23).

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the 12-hour or 
24-hour entry.

c. Press [ENTER] to confirm your entry.
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Changing Date and Time Appearance (cont.)

A line at the bottom, the Date/Time, Decimal Formats, displays 
how the format and separator selections will appear on the screen.

Pressing the [ ] arrow key returns the PT878GC to the Locale 
tab.

• To confirm the entries and return to Operate Mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Adjusting the Contrast

For more comfortable viewing in a particular environment, the 
PT878GC enables you to adjust the screen contrast. To adjust the 
screen contrast:

1. From the Meter menu, scroll to the Contrast entry and press 
[ENTER]. The Display Options window opens on the Display 
tab, as shown in Figure 7-5 below. (From the Format tab, press 
the [ ] key to move to the Display tab.) To step through each 
parameter, press the [ ] key.

Figure 7-5: Display Tab in the Display Options Window

2. Scroll to the Darker or Lighter box as desired.

3. Press the [ENTER] button repeatedly until the screen has the 
desired contrast. 

Note: If you find the screen has become too light or too dark, 
scroll to the other box and press [ENTER] until you have 
adjusted the screen to your satisfaction.

Display

   Display Options

Cancel OK

Locale

Darker

Lighter

Backlight Off Min3

English
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Adjusting the Contrast (cont.)

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Setting Backlight Timeout

By using the Backlight Timeout option, you can set a specified 
time that the PT878GC backlight will remain on before turning 
itself off. Automatic turnoff enables the PT878GC to conserve 
battery power. 

To set the backlight timeout:

1. From the Meter menu, scroll to the Backlight entry and press 
[ENTER]. The Display Options window opens on the Display 
tab, as shown in Figure 7-5 on page 7-12.

2. Press the [ ] key three times to reach the Backlight Off text 
box. 

3. Then press [ENTER] to enter the box.

4. Use the numeric keys to enter the number of minutes that the 
backlight remains on (from 0 to 60).

5. Press [ENTER] to confirm the entry.

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.

Note: You can turn the backlight on or off at any time by 
pressing the power switch for 1 second.
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Changing Communications Parameters

On occasion, you might need to change the parameters by which 
the PT878GC communicates with a PC over the wireless infrared 
interface. To check or change these parameters:

1. From the Meter menu, scroll to the Communications entry and 
press [ENTER]. The Communications window appears similar 
to Figure 7-6 below.

Figure 7-6: The Communications Window

2. The first prompt asks for the node identification number, 
which can be any number from 1 to 240.  

IMPORTANT: Do NOT change the node ID unless instructed by 
GE Sensing.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the node ID.

c. Press [ENTER] to confirm the entry.

Communications

Node ID 2

Comm Interface  IrDA   IR 232

Baud Rate   9600 bps

Parity None
Stop Bits   

Data Bits

1 2

7 8

Cancel OK
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Changing Communications Settings (cont.)

3. The next prompt asks you to select the communications 
interface from two options: IrDA (Infrared Data Association) 
and the IR232 virtual interface. You must use IrDA when 
using an IR printer or transfer application such as QuickBeam. 
Use the  [ ] and [ ] keys to scroll to the desired selection, 
and press [ENTER].

Note: For more information on loading software updates via the 
infrared interface, see Chapter 9, Servicing the PT878GC,  
page 9-43. 

If you have selected IrDA, you have completed entering data in 
this window. However, if you have selected IR232, the PT878GC 
asks for four more parameters.

IMPORTANT: Using IR232 requires the following parameters:

•Baud Rate -- 9600
•Parity -- None
•Stop Bits -- 1
•Data Bits -- 8 

4. The program now asks for the baud rate. The default rate is 
9,600 bps. 

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired rate, 
from 300 to 115.2K bps.

c. Press [ENTER] to confirm the entry.

5. The next prompt asks for the parity from five options: None, 
Mark, Space, Even or Odd. The default parity is None.

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the desired 
parity.

c. Press [ENTER] to confirm the entry.
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Changing Communications Settings (cont.)

6. The next prompt asks you to select either one or two stop 
bits.The default number is one. Use the  [ ] and [ ] keys to 
scroll to the desired number, and press [ENTER].

7. The final prompt asks you to select either seven or eight data 
bits. The default number is 8. Use the  [ ] and [ ] keys to 
scroll to the desired number, and press [ENTER].

• To confirm the entries and return to Operate mode, press [F3] 
(OK). 

• To leave the window without confirming the entries and return 
to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Resetting Forward and Reverse Totals

On occasion, it might be necessary to clear and reset the forward 
and reverse totals computed by the Forward and Reverse 
Totalizers. To reset the totals:

1. From the Meter menu, scroll to the Totals entry and press 
[ENTER]. The window now appears similar to Figure 7-7 
below.

Figure 7-7: The Resetting Totals Menu

2. Use the [ ] or [ ] arrow keys to choose the total to be reset.

3. Press [ENTER] to reset the total(s).

The meter resets the selected total(s) to 0.0.

Velocity, ft/s Signal, dB

0.00
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Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

Site   Program   Meter  Logging   Service

Units
Date/Time
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Contrast
Backlight

Units

Language
Communication

Battery

User Tables
Totals                 

Reset Both
ReReset Fwd Total
Reset Rev Total

Snapshot
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Setting Up User Tables

When you program user functions (see page 4-46), you can also 
support them with up to six user tables of non-linear or empirical 
data. To program one or more user tables:

1. From the Meter menu, scroll to the User Tables entry and 
press [ENTER]. The window now appears similar to Figure 
7-8 below.

Figure 7-8: The User Tables Window

2. The first prompt asks you to select the table to be 
programmed.

a. Press [ENTER] to open the drop-down menu.

b. Use the [ ] or [ ] arrow keys to scroll to the table you 
wish to program.

c. Press [ENTER] to confirm the entry.

Programming

   User Function Tables

Cancel OK

Edit Tables

Table

Table ID

Table 1

UserTable1

# Data Points

Max Points
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Setting up User Tables (cont.)

3. The next step is to create a Table ID.

a. Press [ENTER] to open the window. The screen now appears 
similar to Figure 7-9 below.

Figure 7-9: The Text Creation Window

b. Use the four arrow keys to scroll to the desired letter or 
symbol, and press [ENTER] to add the letter to the label.

Note:  Pressing [SEL] causes the screen to alternate between a 
set of upper-case (capital) letters and a set of symbols. 
Use both screens to create the desired label.

c. Repeat this procedure for each letter or symbol you wish to 
add to the label. (The Table ID window can display up to 
15 characters.) If you wish to delete a letter, press [F1] 
(Delete) to erase each letter or symbol, from right to left on 
the label.

d. When you have completed the label, press [F3] (OK) to 
confirm the label, or [F2] (Cancel) to leave the window 
without adding the label.

Delete Cancel OK

UserTable1

A       B      C     D       E      F        G     H      I        J

K      L       M     N       O     P        Q      R     S      T

U     V      W      X      Y      Z        0       1       2      3       

4     5       6      7       8       9       .        ,        “        ‘

=      <        > 
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Setting up User Tables (cont.)

4. The final prompt asks you to enter or change data in the user 
table.

a. Press [ENTER] to open the window. The screen appears 
similar to Figure 7-10 below.

Figure 7-10: The Edit User Table Window

b. Use the four arrow keys to move to the desired entry in the 
table. 

c. Press [ENTER]. Then use the numeric keys to enter the 
desired data, which appears in the right corner of the 
window above the table.

d. Press [ENTER] to confirm the data, which then appears in 
the appropriate slot in the table.

Programming

  Edit User Table 1

Cancell OK

UserTable1 Y

1

2

3

4

5
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Setting up User Tables (cont.)

e. Repeat steps b, c and d on page 7-21 until you have 
completed entering data for the table.

f. When you have finished, press [F3] (OK) to confirm the 
entries or [F2] (Cancel) to leave the window without 
confirming the table.

The program returns to the Edit Tables window. 

• To confirm the entries and return to Operate mode, press 
[F3] (OK). 

• To leave the window without confirming the entries and 
return to Operate mode, press [F2] (Cancel) or the [ESC] key.
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Taking a Bitmap Capture of a Current Screen

The Snapshot option enables you to take a “screen capture” of the 
current screen in bitmap format (.bmp) for display or storage in a 
Windows-based PC. To take a “snapshot” of the screen:

1. From the Meter menu, scroll to the Snapshot entry and press 
[ENTER]. 

2. A drop-down menu appears, asking if you want to send the 
capture to a printer or to a file, or to turn the option off. If you 
select “To File,” an icon of a camera (see page 2-10) appears 
at the far right of the status tray, indicating that you have 
activated the Snapshot option. If you select “To Printer,” an 
icon of a printer appears. 

3. To capture a screen, press the “.” (decimal) button in the lower 
left corner of the keypad twice. The meter beeps, indicating 
that it has made a screen capture.

The “To Printer” option enables you to send a picture of the 
current screen to an infrared printer. After capturing a screen, the 
PT878GC shows a message indicating that its infrared scanner is 
looking for a receiving device. (If the scanner finds no device, a 
window appears stating that the meter can find no device. If it 
finds more than one compatible infrared device within range, it 
asks you to select the desired device.) If successful, the PT878GC 
returns to Operate Mode, while the printer prints out the current 
screen.

To locate the screen capture with the “To File” option, open the 
Drive Manager (see page 6-14). The captured file is listed as 
“Screen 0X.bmp”. To transfer the file to a PC, follow the 
instructions in “Transferring a File to a PC” on page 6-16.
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Chapter 8

Logging Data

A powerful and flexible feature of the PT878GC is data logging. 
The meter enables you to choose up to 12 parameters to log. You 
can also select the start time and date, end time and date, and time 
interval. Logs can run one at a time or simultaneously. Error and 
circular logs are also available. The logged data is internally 
stored in battery-backed-up memory.  A fixed amount of memory 
is assigned to data logging. The frequency of the time interval, 
the length of the log run, and the number of logs affect the 
amount of memory required for a particular log. For example, a 
log that records every 5 seconds will use up more memory than a 
log that records every 5 minutes for a given amount of time. Once 
you make your data logging selections, the PT878GC enables you 
to view the amount of memory left. You may also stop logging or 
view logged data while or after data is logged.

This section describes:

• How to enter the Logging Menu.

• How to set up a new log.

• How to view the data logger memory.

• How to start, stop or pause logging
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Entering the Logging Menu

To enter the Logging Menu, press the [MENU] key at the lower 
right of the PT878GC keypad. The Main Menu replaces the 
Status Bar at the top of the screen. Press the [ ] arrow key three 
times to scroll from the Site Menu to the Logging Menu. At the 
Logging Menu, press [ENTER]. The screen appears similar to 
Figure 8-1 below. Refer to Figure A-9 on page A-9 of Appendix 
A, Menu Maps. 

Figure 8-1: The Logging Menu

To scroll to a particular option, press the [ ] or [ ] arrow keys 
until you reach the option. Then press [ENTER] to open the option 
window.

When entering parameters in an option, press:

• The  [ ] key to step through the available parameters 

• The [ ] key to scroll back to a previously entered parameter

• The [F2] key (Cancel) or the [ESC] key to exit an option at any 
time and return to Operate Mode without changing the 
parameters.
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The Log Manager

The Log Manager offers users a way to check the status and 
memory size of all the logs currently pending, running or 
finished.  To select Log Manager, scroll to the Manager entry on 
the Logging Menu and press [ENTER]. The screen appears similar 
to Figure 8-2 below. The right section of the screen supplies 
information for the log highlighted in the list on the left. You can 
use the [ ] and [ ] arrow keys to scroll to a particular log and 
display information pertaining to that log.

Figure 8-2: The Log Manager Window

To access the menu for the Log Manager, press the [MENU] key. 
The cursor highlights the File Menu in the upper left corner. Use 
the [ ] and [ ] keys to scroll to the desired menu, and press 
[ENTER] to open the menu.

Log Manager

Info: AAA.LOG

03/01/04  13:23:21
1216 bytes
109568 bytes free

 Refresh Exit

AAA
BBB
CCC

State: Finished

File    Log     View    Sort   

S:03/01/04  13:13:41
E:03/01/04  13:23:41
Interval: 10 Seconds
Records:51
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The File Menu

The File Menu allows you, not only to create new logs, but also to 
copy, rename or delete logs, as well as to print them or transfer 
them to a PC. To open the File menu from the Log Manager, press 
the [MENU] key and then [ENTER]. The screen appears similar to 
Figure 8-3 below.

Figure 8-3: File Menu in the Log Manager

Log Manager

Info: AAA.LOG

03/01/04  13:23:21
1216 bytes
109568 bytes free

   ExitRefresh

AAA
BBB
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State: Finished
S:03/01/04  13:13:41
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Interval: 10 Seconds
Records:51

Clone Selected Log
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Delete
Delete All Logs?

Print
Print All
Transfer

File    Log     View    Sort 
New

Refresh
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Setting up a New Log

The New Log option enables you to create and set up parameters 
for a new log. You can access this option in two ways:

• by scrolling to the New Log option in the Logging Menu (as 
shown in Figure 8-1 on page 8-2) and pressing [ENTER], or

• by scrolling to the New option in the File menu of the Log 
Manager (as shown in Figure 8-3 on page 8-4) and pressing 
[ENTER].

In either case, the Create New Log screen appears similar to 
Figure 8-4 below. Use the four arrow keys to scroll to the desired 
letter or number, and press [ENTER]. Repeat this procedure until 
you have created the desired log name with up to eight characters. 
(Press [F1], Delete, to remove any unwanted letters or numbers.) 
When you have finished, press [F3], OK, to confirm the entry.

Figure 8-4: The New Log Window

The PT878GC now asks for log formatting and measurements. 
The screen appears similar to Figure 8-5 on the next page.

6         7          8         9          

Delete Cancel OK
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Setting up a New Log (cont.)

Figure 8-5: The General Log Format Window

To step through each parameter, press the [ ] key.

1. The first prompt asks you to choose between a linear or 
circular format for the log. (A linear log stops when it reaches 
a specified end time or the PT878GC runs out of memory, 
while a circular log runs continuously until manually 
stopped.)

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

2. The next prompt asks you to choose whether the log is to be a 
standard log, recording specified data, or an error log (one 
which records error conditions). 

a. Use the  [ ] and [ ] keys to scroll to the appropriate 
radio button.

b. Press [ENTER] to confirm your selection.

General Measurements

Cancel Activate

Log Name 10SEC.LOG

End Date/Time

Standard Error
Linear Circular

Type
Format

Logging Interval 

 Start Date/Time 01:38:08

2004/11/01

10

09:38:08

secs

2004/11/01
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Setting up a New Log (cont.)

3. The next prompt asks for the starting date and time.

a. Press [ENTER] to enter the text box. The meter highlights 
the first number. Use the [ ] and [ ] keys to scroll to any 
number you wish to change, or the  [ ] key to scroll to the 
time box.

b. Two alternatives are available to change a highlighted 
number:

•Use the numeric keys to enter the desired number.

•Use the [ ] or [ ] arrow keys to scroll, in 1-digit 
increments, to the desired number. (For example, if the text 
box displays 09, pressing the  [ ] key twice changes the 
number to 07.) You can scroll from 01 to 12 for the month 
and from 01 to 31 for the day (depending on the number 
you have selected for the month).

c. In either case, press [ENTER] to confirm the entry.

4. Follow the same procedure to enter the end date and time.

5. The final prompt in this window asks for the logging interval.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired interval in 
seconds. 

c. Press [ENTER] to confirm the entry.

6. You have completed entering parameters in this window. To 
select the measurements, 

a. Press the [ ] key to return to the Format prompt.

b. Then press the [ ] key to return to the General tab.

c. Finally, press the [ ] key to move to the Measurements 
tab, and press [ENTER]. The Measurements window appears 
similar to Figure 8-6 on the next page.
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Setting up a New Log (cont.)

Figure 8-6: The Log Measurements Window

To step through each entry, press the [ ] key.

1. Press [ENTER] to open the first entry. The Select Measurement 
window opens, as shown in Figure 8-7 on the next page.

General             NsMeasurements

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

NO UNIT

Cancel Activate
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Setting up a New Log (cont.)

Figure 8-7: The Select Measurement Window

2. Scroll to the desired output type.

3. Press [SEL] to confirm your selection.

4. The prompt then moves to a list of unit types. (The available 
units depend on the selection made at the Data Source 
prompt.) Scroll to the desired output unit.

5. Press [F3] (OK) to confirm your selection.

6. You can repeat this procedure for up to 12 different 
parameters. 

7. When you have finished, press [F2] (Cancel) to cancel the 
entries, or [F3] (Activate) to confirm the entries and start the 
log.

If you started the log from the New Log option, the PT878GC 
returns to Operate Mode; if you started it from within the Log 
Manager, the meter returns to the Log Manager.

         Select Measurement

Cancel OK

Diagnostics

        Rev Totalizer

Volume

No Unit

Velocity

Fwd Totalizer

m/sPressure

Temperature

StdFwdTotalizer
StdRevTotalizer
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Copying (Cloning) a Selected Log

In the Clone Selected Log option, you can copy the parameters of 
a particular log, modify the parameters, and start the copy. To 
copy a log:

1.  First, select the log you wish to copy in the Log Manager 
(shown in Figure 8-3 on page 8-4).

2. Then open the File menu, scroll to the Clone Selected Log 
option, and press [ENTER].

3. The Create New Log window (shown in Figure 8-4 on page 
8-6) opens. Follow the procedure discussed on page 8-5 to 
create a log name, and press [F3] (OK) to confirm the name.

4. The General Log Format window (shown in Figure 8-5 on 
page 8-7) opens. Follow the procedure discussed on pages 8-7 
and 8-8 to change any settings. 

Note: Unless otherwise specified, the cloned log always begins 
at the current date and time, and ends after the period of 
time used by the original log.

5. If you wish, scroll to the Measurements window (shown in 
Figure 8-6 on page 8-8) and follow the procedure discussed on 
pages 8-8 and 8-9 to modify any parameters. 

6. When you have completed modifying the log parameters, 
press [F2] (Cancel) to cancel the log or [F3] (Activate) to 
confirm and start the new log.

The PT878GC returns to the Log Manager, which now displays 
the status of the cloned log.

Note: Some changes in the site file could prevent log cloning.
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Renaming a Log

To rename a log:

1. First, select the log you wish to rename in the Log Manager 
(shown in Figure 8-3 on page 8-4).

2. Then open the File menu, scroll to the Rename option, and 
press [ENTER].

3. The Rename Log window opens. (Except for the heading, the 
window is identical to the Create New Log window shown in 
Figure 8-4 on page 8-5.) Follow the procedure discussed on 
page 8-5 to create a log name, and press [F3] (OK) to confirm 
the name.

The PT878GC returns to the Log Manager, which highlights the 
renamed log.

Deleting a Log

To delete a log:

1.  First, select the log you wish to delete in the Log Manager 
(shown in Figure 8-3 on page 8-4).

2. Then open the File menu, scroll to the Delete option, and press 
[ENTER].

3. A delete confirmation window opens, as shown in Figure 8-8 
on the next page. Press [F2] (No) to stop the deletion, or [F3] 
(Yes) to delete the log.

The Log Manager reappears, with the specified log deleted.
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Deleting a Log (cont.)

Figure 8-8: The Delete Confirmation Window

Deleting All Logs

To clear the Log Manager and memory of all logs, open the File 
menu, scroll to the Delete All Logs option, and press [ENTER]. A 
window opens, asking, “Delete All Logs?” Press [F2] (No) to stop 
the deletion, or [F3] (Yes) to delete the logs.

IMPORTANT: This step cannot be undone!

A blank Log Manager appears. All logs have been deleted.

Refreshing a Log

You can refresh a log (updating the display with the most current 
information) in one of two ways:

• Press [F2], Refresh, to refresh the highlighted log.

• From the File Menu, scroll to the Refresh option and press 
[ENTER].

The updated information on the highlighted log appears in the 
window on the right.

1 View

Programming

Log Manager

  No Yes

Info:DEFAULT

        
GLOBAL

File

DEFAULT

Delete 

ResReDelete Log ‘555.LOG?’ 
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Printing a Log

To print a file from the Log Manager:

1. Highlight the desired log in the window on the left of the Log 
Manager. 

2. Press [MENU], scroll to the Print option, and press [ENTER].
The PT878GC shows a message indicating that its infrared sensor 
is looking for a printer. (If the sensor finds no printer, a window 
appears with this message. If it finds two printers within its range, 
it asks you to select the desired device.) If successful, the 
PT878GC returns to the Log Manager, while the printer prints out 
the log.

Transferring a Log to a PC

To upload a log to a PC:
1. Check that the Communications option (see page 7-15) has 

been set to the IrDA protocol.
Note: For Windows NT4.0, check that the QuickBeam software 

(available through the path C:\Program Files\QuickBeam 
Suite) is running, and that the IR beam on the PT878GC 
has access to the IR sensor connected to the PC port. 

2. Highlight the desired log in the left window of the Log 
Manager.

3. Press [MENU], scroll to the Transfer option, and press [ENTER]. 
The screen shows a message indicating that the PT878GC is 
searching for an infrared device. (If the sensor finds no device, a 
window appears with this message, and asks if you want to try 
again.) If it finds a device, it sends another message indicating 
that it is uploading the log. (The meter also displays a message if 
the upload fails.) When the upload is complete, the meter returns 
to the Log Manager. The PC holds the transferred log in a 
C\Ir_Inbox folder (C:\Ir_Inbox for Windows NT, C:\My 
Received Files for Windows 98, or Desktop for Windows 2000). 
You can open the file on the PC using the PanaLog Viewer 
(available at www.gesensing.com) and export it in Microsoft 
Excel format.
Note: You cannot download log files back to the PT878GC.
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The Log Menu

The Log Menu allows you to pause, restart or end any or all logs 
that are currently pending or running. (However, you cannot 
restart any finished logs, even if they were finished before the 
programmed end time.) To open the Log Menu in the Log 
Manager, press [MENU]. Scroll to the Log option, and press 
[ENTER]. The window appears similar to Figure 8-9 below.

Figure 8-9: The Log Menu in the Log Manager

Log Manager

Info: AAA.LOG

03/01/04  13:23:21
1216 bytes
109568 bytes free

  Refresh Exit

AAA
BBB
CCC

State: Finished
S:03/01/04  13:13:41
E:03/01/04  13:23:41
Interval: 10 Seconds
Records:51

Pause
End

Start All Logs
Pause All Logs

End All Logs

View All Sites

Start
File    Log     View    Sort
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Stopping (Pausing) a Log

To stop a log that is currently pending or running, 

1.  First, select the log you wish to pause in the Log Manager 
(shown in Figure 8-2 on page 8-4).

2. Then open the Log menu, scroll to the Pause option, and press 
[ENTER].

The PT878GC returns to the Log Manager, which displays the 
highlighted log with “Paused” in the State line.

Restarting a Log

To restart a paused log:

1.  First, select the log you wish to restart in the Log Manager 
(shown in Figure 8-2 on page 8-4).

2. Then open the Log menu, scroll to the Start option, and press 
[ENTER].

The PT878GC returns to the Log Manager, which displays the 
highlighted log with a status of “Pending” or “Running.”

Ending a Log

To end a log:

1.  First, select the log you wish to end in the Log Manager 
(shown in Figure 8-2 on page 8-4).

2. Then open the Log menu, scroll to the End option, and press 
[ENTER].

The PT878GC returns to the Log Manager, which displays the 
highlighted log with a status of  “Finished.” The space not used 
by the finished log is freed for reuse.

Note: You cannot restart a finished log. You must create a new 
log with the same parameters.
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Pausing All Logs

To pause all logs that are currently pending or running, open the 
Log menu, scroll to the Pause All Logs option, and press [ENTER]. 
The PT878GC returns to the Log Manager, which displays all 
logs programmed to run now or in the future with a status of 
“Paused.”

Restarting All Logs

To restart all paused logs, open the Log menu, scroll to the Start 
All Logs option, and press [ENTER]. The PT878GC returns to the 
Log Manager, which displays the logs with a status of “Pending” 
or “Running.”

Ending All Logs

To end all currently pending or running logs, open the Log menu, 
scroll to the End All Logs option, and press [ENTER].The 
PT878GC returns to the Log Manager, which displays the 
running logs with a status of  “Finished.”

View All Sites

To check on all logs, open the Log menu, scroll to the View All 
Sites option, and press [ENTER]. Logs are associated with the site 
in use at the time the log is created. Thus, when another site is in 
use, the PT878GC automatically starts different logs. By default, 
the Log Manager only displays the logs created with the current 
site. View All Sites allows the Manager to list logs for all sites.
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The View Menu

Through the View menu, you can view the data of individual logs 
in graphical or spreadsheet formats. To open the View menu from 
the Log Manager, press [MENU]. Scroll to the View menu, and 
press [ENTER]. The screen appears similar to Figure 8-10 below.

Figure 8-10: The View Menu

Log Manager

Info: AAA.LOG

03/01/04  13:23:21
1216 bytes
109568 bytes free

   Refresh Exit

AAA
BBB
CCC

State: Finished
S:03/01/04  13:13:41
E:03/01/04  13:23:41
Interval: 10 Seconds
Records:51

Graph
Spreadsheet

Details
File    Log     View     Sort 
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Displaying Log Details

To view details of a given log, be sure the log is highlighted in the 
left window of the Log Manager. Then scroll to the View menu 
and press [ENTER]. Scroll to the Details option and press [ENTER]. 
The screen now appears similar to Figure 8-11 below.

Figure 8-11: The Log Details Display Window, 
with List of Measurements in the Log

Press [F3] (OK) to return to the Log Manager.

Log Info
State: Finished
S:03/01/04  13:13:41
E:03/01/04  13:23:41
Interval:10 Seconds
Records:51
Precision: 8 Error:No (Basic)

Velocity: Meters/sec

Exit
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Displaying Log Data in Graphical Form

To view a log in graphical form, be sure the log is highlighted in 
the left window of the Log Manager. 

1. Scroll to the View menu and press [ENTER].

2. Scroll to the Graph option and press [ENTER]. 

3. The “Select Measurement” window appears, with the logged 
measurements. Be sure you have highlighted the desired 
measurement, and press [F3] (View).

The screen now appears similar to Figure 8-12 below.

Figure 8-12: The Log Graph Display Window

Note: If a log contains more than one measurement, you must 
select which measurement to plot from the list displayed.

• If you wish to alter the graph scale, press [F1] (Scale). The 
window appears similar to Figure 8-13 on the next page. 

• If you wish to alter the time scale, press [F2] (Time). The 
window appears similar to Figure 8-14 on page 8-21. 

• To leave the window, press [F3] (Exit).

AAA.LOG (P#Up)

297

Time                        Exit

2004/03/01 2004/03/01  
13:23:41 PM 13:53:41 PM

289

Scale
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Displaying Log Data in Graphical Form (cont.)

Figure 8-13: The Y-Axis Window

The Y-Axis window allows you to specify whether the Y axis on 
the graph extends to the maximum value (Max), over the entire 
range (Range) or between certain specified values (Set).

1. Use the [ ] and [ ] keys to scroll to the desired limit type. 
Press [ENTER] to confirm the entry.

If you select Max or Range for limits, you have finished entering 
data in this form. But if you select Set, the PT878GC asks for 
minimum and maximum limits.

2. Press the  [ ] key to reach the Minimum text box.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm the entry.

3. Repeat step 2 to enter the Maximum value.

4. When you have finished, press [F2] (Cancel) to cancel the 
entries, or [F3] (OK) to confirm the entries and change the 
graph.

AAA.LOG (Dew Point, °C) 
-52.0

2004/03/01 2004/03/01  
13:23:41 PM 13:53:41 PM

Y-Axis

Limits

Max Range Set

Minimum

Maximum

Cancel OK

0.1234

0.5678
8-20 Logging Data



April 2009
Displaying Log Data in Graphical Form (cont.)

If you wish to alter the time scale, press [F2] (Time). The Enter 
Time window appears similar to Figure 8-14 below.

Figure 8-14: The Enter Time Window

1. Use the arrow keys to scroll to the desired text box. Press 
[ENTER] to open the box.

2. Two alternatives are available to change a highlighted date or 
time:

•Use the numeric keys to enter the desired number.

•Use the [ ] or [ ] arrow keys to scroll, in 1-digit 
increments, to the desired number. (For example, if the 
text box displays 09, pressing the  [ ] key twice 
changes the number to 07.) You can scroll from 01 to 12 
for the month, from 01 to 31 for the day (depending on 
the number you have selected for the month), and from 
0 to 59 for minutes and seconds.

In either case, press [ENTER] to confirm the entry.

3. Repeat step 2 for any other entries you wish to change.

4. When you have finished, press [F3] (OK) to confirm the 
entries and close the window.

AAA.LOG (P#Up) 
-52.0 Enter Time

Start Date

End Date

Start Time

End Time
2004/03/01

2004/03/01 13:53:41 PM

13:23:41 PM
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Displaying Log Data in Spreadsheet Form

To view a log in spreadsheet form, be sure the log is highlighted 
in the left window of the Log Manager. Then scroll to the View 
menu and press [ENTER]. Scroll to the Spreadsheet option and 
press [ENTER]. The screen now appears similar to Figure 8-15 
below.

Figure 8-15: The Log Spreadsheet Window

Use the  [ ] and [ ] keys to scroll to other columns, or the  [ ] 
or [ ] keys to scroll backward or forward in time.

• To alter the times displayed, press [F1] (Time). The Enter Time 
window (shown on the previous page) opens. Follow the 
instructions on the previous page to change the date or time.

• To refresh the display, press [F2] (Refresh). The display shows 
the most current data.

• Press [F3] (Exit) to return to the Log Manager.

Refresh Exit

AAA.LOG

Time
03/20/2004
14:24:46
14:24:56
14:25:06
14:25:17

14:25:27
14:25:37

14:25:47

Diagnostics
    P# Up

290
291
293

295
294

293

Time
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The Sort Menu

The Sort Menu within the Log Manager allows you to arrange 
your log list either alphabetically (By Name) or chronologically 
(By Date).

Figure 8-16: Sort Menu in the Log Manager

Listing Logs by Name

If you want to list your logs alphabetically by log name within the 
Log Manager, press [MENU] to open the File Menu. Then scroll 
from the File Menu to the Sort Menu, shown in Figure 8-16 
above. Press [ENTER]. The Log Manager screen refreshes, with the 
sites listed in alphabetical order.

Listing Logs in Chronological Order

If you prefer to list your logs chronologically by time of creation 
within the Log Manager, press [MENU] to open the File Menu. 
Then scroll from the File Menu to the Sort Menu, and scroll to the 
By Date option. Press [ENTER]. The Log Manager screen 
refreshes, with the sites listed in chronological order, from the 
most recent to the earliest.

Log Manager

Info: AAA.LOG

03/01/04  13:23:21
1216 bytes
109568 bytes free

   Refresh Exit

AAA
BBB
CCC

State: Finished
S:03/01/04  13:13:41
E:03/01/04  13:23:41
Interval: 10 Seconds
Records:51

File    Log     View   Sort

By Date
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Chapter 9

Servicing the PT878GC

For user convenience, the PT878GC offers a Service Menu. This 
menu enables users to perform a variety of functions that they 
might occasionally require: 

• print out reports

• calibrate the PT878GC

• run diagnostics

• set up signal parameters and peak detection

• define error limits

• test the meter screen and keys

• determine setup errors with impulse response

• check test points

• return to factory default parameters

• load updated versions of the meter program into the 
PT878GC.
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Entering the Service Menu

To enter the Service Menu, press the [MENU] key at the lower 
right of the PT878GC keypad. The Main Menu replaces the 
Status Bar at the top of the screen. Press the [ ] arrow key four 
times to scroll from the Site Menu to the Service Menu. At the 
Service Menu, press [ENTER]. The screen appears similar to Figure 
9-1 below. When programming, refer to Figure A-10 on page A-
10 of Appendix A, Menu Maps.

Figure 9-1: The Service Menu

To scroll to a particular option, press the [ ] or [ ] arrow keys 
until you reach the option. Then press [ENTER] to open the option 
window.

When entering parameters in an option, press:

• The  [ ] key to step through the available parameters. 

• The [ ] key to scroll back to a previously entered parameter.

• The [F2] key (Cancel) or the [ESC] key to exit an option at any 
time and return to Operate Mode without changing the 
parameters.

Velocity, ft/s Signal, dB

0.00
32

Delta-T, ns

0.10 0.0

Volume, l/s

E0: No Errors

Site   Program   Meter  Logging   Service

Units

Reports

Test

Calibrate
Diagnostics

Error Limits
Test                         
Factory Defaults
Flash Update

Signal Setup

T-Gauge Display
T-Gauge Setup
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Printing Reports

When used with an IR-compatible printer, the PT878GC can print 
out a variety of data (current site, logs, drive contents, and user 
functions, tables, and settings) in the Reports option. To enter the 
Reports option, scroll to the Reports entry on the Service Menu 
and press [ENTER]. The screen appears similar to Figure 9-2 
below. 

Figure 9-2: The Reports Window

Press [ENTER] to open the drop-down list of available reports, as 
shown in Figure 9-2 above. Press the [ ]or [ ] arrow keys to 
scroll to the desired reports, and press [ENTER]. Then press [F2] 
(Print) to print out the desired reports, or press [F3] (Exit) to leave 
the option and return to Operate Mode. Figure 9-3 on the next 
page shows a typical printout of a drive report.

         Reports

 Print Exit

Current Site

Reports

Global Settings

Menu Commands
All Reports

All User Settings

Drive Contents

User Functions
User Tables
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Printing Reports (cont.)

Figure 9-3: Printout of a Typical Drive Report
9-4 Servicing the PT878GC



April 2009
Setting up the Thickness Gauge

For greatest accuracy in flow applications, the PT878GC can 
measure pipe wall thickness using an optional thickness gauge 
transducer, instead of relying on the nominal pipe wall thickness. 
In Thickness Gauge mode, the PT878GC does not measure flow, 
but it can determine the thickness of most standard metal and 
plastic pipe materials over a range from 0.05 to 3 in. (1.3 to 76.2 
mm). Figure 9-4 below illustrates use of the optional thickness 
gauge.

Figure 9-4: PT878GC Thickness Gauge in Operation

The PT878GC offers two basic thickness gauge functions: using 
the gauge to measure thickness after entering the pipe material, 
and calibrating the gauge. For the highest possible accuracy, you 
can also calibrate the velocity of sound in the pipe material.

Using the thickness gauge involves three steps:

1. Entering the material and sound speed (in the Material 
window on page 9-7),

2. Measuring the pipe wall thickness (in the Display window on 
page 9-9), and

3. If the measurement seems unreasonable, examining the 
acoustic signal to diagnose the problem (in the Graph window 
on page 9-10).
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Setting up the Thickness Gauge (cont.)

Calibrating the thickness gauge involves up to two additional 
steps:

4. Calibrating the thickness gauge itself (in the Zero window on 
page 9-12), and

5. Calibrating the velocity of sound in the pipe material (in the 
Velocity window on page 9-14), if possible and if the pipe 
material is not the material entered in the Zero window. This 
step requires a trustworthy reference, either a section of pipe 
(such as a flange or open pipe section) that can be measured 
with calipers or another measurement device, or a thickness 
calibration block of the same material.
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Measuring Pipe Wall Thickness

Entering the Material and Sound Speed

IMPORTANT: GE Sensing recommends calibrating the 
thickness gauge periodically (as discussed on 
page 9-12) before measuring thickness.

To enter the Thickness Gauge Display option, scroll to the 
T-Gauge Display entry on the Service Menu and press [ENTER]. 
The screen appears similar to Figure 9-5 below. 

Figure 9-5: The Material Window 

1. From the Thickness Gauge Display option, press the [ ] 
arrow key four times to enter the Material window.

2. The first prompt asks you to select the material for the pipe 
wall you wish to measure from a drop-down list.

a. Press [ENTER] to open the list.

b. Use the  [ ] or [ ] arrow keys to scroll to the desired 
material.

c. Press [ENTER] to confirm your selection.

Thickness Gauge Measure

Cancel OK

MaterialDisplay Graph Velocity Zero

Sound Speed m/sec0

Material Other
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Entering the Material and Sound Speed (cont.)

If you have selected a preprogrammed material, you have 
completed entering data in this window. Pressing the [ ] key 
returns the program to the Material tab. But if you selected 
“Other,” you can also enter a specific sound speed.

3. To enter the sound speed:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the known sound speed in 
the pipe material (from the brochure Sound Speeds and 
Pipe Size Data, 914-004).

c. Press [ENTER] to confirm your entry.

To leave the Material window:

• Press the [ ] or [ ] arrow key to move to another tab to 
take readings or perform a velocity calibration.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the sound speed value.

• Press [F3] (OK) to confirm the new value. The PT878GC 
returns to Operate Mode.
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Measuring Thickness in Numeric Format

To measure the actual thickness of a pipe, apply couplant to the 
calibrated thickness gauge transducer and hold the transducer 
steady against the pipe. Then press the [ ] or [ ] arrow key 
until you reach the Display tab and press [ENTER]. The T-Gauge 
Display option shows the thickness measurement in numeric 
format (displayed in Figure 9-6 below).

Note: Refer to Appendix C, Ultrasonic Thickness Gauge Theory 
of Operation, page C-3, to learn how to position and align 
the transducer.

Figure 9-6: The Thickness Gauge Display Window

Be sure the “Noise” or “Los” (loss of signal) boxes do not appear. 
Press [F2] (Cancel) or [F3] (OK) to return to Operate Mode, or 
press the  [ ] arrow key to move to another window in the 
option.

Display

Thickness Gauge Measure

Cancel OK

VelocityGraph Zero

Thickness, mm

42.71

Material
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Displaying the Receive Signal in Graphical Format

Used chiefly for diagnostic purposes, the Graph option helps to 
determine why the thickness gauge is not working if you suspect 
a problem. The graph shows an image of the acoustic signal. If 
the display does not show a signal image similar to Figure 9-7 
below, you may have a problem with the transducer, couplant, or 
the programmed values. Also, some materials (such as Teflon® or 
fiberglass) do not support acoustic signals.

To open the Graph window and display the receive signal 
graphically, press the [ ] or [ ] arrow key until you reach the 
Graph tab and press [ENTER]. The screen appears similar to Figure 
9-7 below.

Figure 9-7: The Thickness Gauge Graph Window

Press [F2] (Cancel) or [F3] (OK) to return to Operate Mode, or 
press the  [ ] arrow key to move to another window in the 
option. However, if you wish to adjust the graph, press the [ ] 
key. The screen now appears similar to Figure 9-8 on the next 
page.

Display

Thickness Gauge Measure

Cancel OK

VelocityGraph Zero

Signal

Material
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Displaying the Receive Signal in Graphical Format 
(cont.)

Figure 9-8: The Graph Window in Zoom Format

• Press [F1] (In) to zoom in to magnify screen details.

• Press [F2] (Out) to zoom out fully.

• Press [F3] to toggle between the left and right cursors.

• Press  [ ] and [ ] to move the selected cursor left and 
right.

• Press [ ] to select the graph.

• Press [ ] to return to tab navigation.

• Press [ESC] to return to Operate Mode without saving the 
calibration changes.

Display

Thickness Gauge Measure

Out Display

VelocityGraph Zero

Signal

In

Material
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Calibrating the Thickness Gauge Transducer

To zero the transducer offsets, go to the Zero tab. Press the [ ] or 
[ ] arrow key until you reach the Zero tab and press [ENTER]. The 
screen appears similar to Figure 9-9 below.

Figure 9-9: The Zero Window 

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks you to choose between single and dual-
point calibration. Use the [ ] and  [ ] arrow keys to move to 
the appropriate radio button and press [ENTER]. 

Note: GE Sensing recommends dual calibration. Dual-point 
calibration is more reliable, but it requires two known 
thicknesses of the calibration material.Use single-point 
calibration only if you know the sound speed in the 
calibration block material to a high degree of accuracy. 
See Appendix C for more information.

3. The next prompt asks you to enter the length of Block 1. (If 
you are using a GE Sensing-supplied test block, the length is 
printed on the block.) Press [ENTER] to open the text box.

Display

Thickness Gauge Measure

Cancel OK

Graph Velocity Zero Material

Block 1 Length

Calculated Current
Transducer Delay, 

0          0

Single Dual Calibration

0 mm Calibrate

µs
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Calibrating the Thickness Gauge Transducer (cont.)

a. Press [ENTER] to open the text box.
b. Use the numeric keys to enter the length.
c. Press [ENTER] to confirm the entry.

4. Press [ENTER] (Calibrate button) to prepare for calibration. 
Then apply couplant B to the block surface, and hold the 
transducer against the block. 

5. When you have the transducer firmly pressed against the 
block, press [ENTER] (Ready button) again to perform the 
calibration.

6. Hold the transducer steady until the Set button appears. Press 
[ENTER] to store the calibration. 

IMPORTANT: Be sure to hold the transducer steady until the 
GE Sensing wait cursor disappears.

7. If you have chosen dual calibration, repeat Steps 3 through 6 
above for Block 2.

8. The PT878GC asks for confirmation of the calculated and 
current values. 

• Press the [ ] arrow key to move to the Retry box and press 
[ENTER] to recalculate the value, or

• Press [ENTER] on “Set” to commit the calculated value.
Once you have completed calibration, the transducer should 
remain calibrated until the meter memory is cleared or a dramatic 
shift in ambient conditions occurs.

To leave the Zero window:

• Press the [ ] or [ ] arrow key to move to another tab to 
take readings or perform a velocity calibration.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the sound speed value.

• Press [F3] (OK) to confirm the new value. The PT878GC 
returns to Operate Mode.
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Calculating Velocity (Pipe Material Sound Speed)

The nominal sound speed for your pipe material will give 
thickness measurements of reasonable accuracy. However, for 
greater accuracy, calibrate pipe material sound velocity.

IMPORTANT: This step is necessary only if the actual pipe 
material sound speed differs from the sound 
speed of the material used in the calibration 
block. It is possible only if you have a sample of 
pipe material with the thickness known to a high 
level of precision. 

To open the Velocity window, press the [ ] or [ ] arrow key 
until you reach the Velocity tab and press [ENTER]. The screen 
appears similar to Figure 9-10 below.

Figure 9-10: The Sound Speed Window

1. Scroll to the Velocity tab as shown in Figure 9-10 above. Press 
[ENTER].

Display

Thickness Gauge Measure

Cancel OK

VelocityGraph Zero Material

Block Length 0

Calculated Current

Determine the Sound Speed
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Calculating Velocity (Pipe Material Sound Speed) (cont.)

2. To enter the block length (here, the thickness of the sample as 
measured with a caliper or calibrated sample), press the [ ] 
arrow key and then press [ENTER] to open the Block Length 
text box. Use the numeric keys to enter the measured block 
length. Press [ENTER] to confirm the entry.

3. Prepare the sample for calibration by applying couplant B to 
its surface, and press [ENTER]. The screen now appears similar 
to Figure 9-11 below.

4. Hold the transducer steady against the sample, and wait for the 
Set button to appear.

5. To calibrate the gauge, press the [ ] arrow key to move to the 
Set button.

6. Press [ENTER] (Set button) to start the calibration sequence. 

Figure 9-11: The Velocity Window, 
Displaying the Calculated and Current Values

Display

Thickness Gauge Measure

Cancel OK

VelocityGraph Zero Material

Block Length

Calculated Current

1

Press Set to Commit Value
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Calculating Velocity (Pipe Material Sound Speed) (cont.)

7. The “Calculated” box shows the thickness value measured. 
The PT878GC asks for confirmation of the calculated and 
current values. Press [ENTER] to commit (accept) the calculated 
value (in which case it becomes the current value), and to 
recalculate the value (which becomes the new “Calculated” 
value).

Note: If you commit the calculated value, the settings in the 
Material window also change from the previous material 
to “Other” with the new sound speed.

To leave the Velocity window:

• Press the [ ] or  [ ] arrow key to move to another tab.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the sound speed value.

• Press [F3] (OK) to confirm the new value and return to 
Operate Mode.
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Programming the Thickness Gauge

While the T-Gauge Display option allows you to program the 
appropriate material and sound speed, the Thickness Gauge Setup 
option enables you to view or change five parameters:

• Low Signal Threshold

• Transducer Delay

• Signal Inversion

• Noise Threshold

• Detection Threshold

IMPORTANT: The thickness gauge programming settings are 
entered at the factory. You should not change 
them unless instructed by GE Sensing.

The Programming window appears similar to Figure 9-12 below.

Figure 9-12: The Thickness Gauge Programming Window

Thickness Gauge Setup

Cancel OK

Low Signal Thresh 0 %

Transducer Delay 0

Signal Inversion

Noise Threshold

On Off

0

Detection Threshold

%

0 %

µs

Programming
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Programming the Thickness Gauge (cont.)

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks for the low signal threshold. If the signal 
strength falls below this value, a “Low Signal” message 
appears on the screen. To change this value:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the provided value.

c. Press [ENTER] to confirm your entry.

3. The next value, transducer delay, represents the time the 
ultrasonic signal takes to travel from the meter to the pipe 
material surface. To change this value:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

4. The signal inversion prompt enables you to invert the 
thickness transducer signal. Signal inversion may be 
necessary if your thickness readings show unusual jitter, or for 
certain unusual combinations of pipe and fluid or pipe and 
lining. Consult the factory before measuring the thickness of 
lined pipes.

Note: When measuring the thickness of certain pipe materials, 
you might need to drain the pipe before measuring the 
pipe wall, because certain pipe/liquid combinations 
muffle the ultrasonic echo.

Signal inversion should be on, unless you have received other 
instructions. To change its status, use the [ ] and [ ] arrow keys 
to move to the appropriate radio button and press [ENTER].

5. To enter the noise threshold:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm your entry.
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April 2009
Programming the Thickness Gauge (cont.)

6. The final value, the detection threshold, represents the percent 
of peak the PT878GC uses to make measurements. It will 
consider anything above the entered percentage as part of the 
signal. To change this value:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm your entry.

You have finished entering values for the Programming window. 
To leave this window:

• Press the [ ] arrow key to move to the Materials tab.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the changes. The PT878GC returns to Operate 
Mode.

• Press [F3] (OK) to confirm the new data and return to Operate 
Mode. The PT878GC returns to Operate Mode.
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Displaying Diagnostic Parameters

The Diagnostics option enables you to view current diagnostic 
parameters without having to open a display window in Operate 
Mode. To enter the option, scroll to the Diagnostics entry on the 
Service Menu and press [ENTER]. The screen appears similar to 
Figure 9-13 below.

Figure 9-13: The Diagnostics Window

Press [F2] (Cancel) or [F3] (OK) to close the window and return to 
Operate Mode.

Note: For an explanation of diagnostic parameters, refer to 
Chapter 10, Diagnostics and Troubleshooting.
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Calibrating the Analog Output and Inputs

The Calibration option allows you to calibrate the analog output 
and inputs. To enter the option, scroll to the Calibrate entry on the 
Service Menu and press [ENTER]. The screen appears similar to 
Figure 9-14 below. 

Figure 9-14: The Outputs Window 
in the Calibration Option

Calibrating the Analog Output

The calibration procedure consists of calibrating the analog 
output zero point (0 or 4 mA) and then calibrating the full scale 
span point (20 mA). You enter, first the setpoint, and then the 
actual value measured with a digital ammeter or voltmeter. The 
analog outputs have a resolution of ±5.0 µA. Press the [ ] arrow 
key to enter the Analog Output window.

 Analog Output

Calibrate/Test I/O

Analog Input

         Setpoint

Cancel  OK

mA
4

Calibrate

          Actual 4

4 mA 20 mA

Actual 20 mA

Reset

20
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Calibrating the Analog Output (cont.)

1. Connect a digital multimeter or ammeter to the analog output.

2. The next prompt asks for the setpoint (4 or 20 mA). Use the 
[ ] and  [ ]  arrow keys to move to the appropriate radio 
button and press [ENTER].

3. The next prompt asks you to enter the actual value shown on 
the multimeter or ammeter.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the measured value.

c. Press [ENTER] to confirm your entry.

4. Repeat steps 2 and 3 for the other setpoint.

5. Press the [ ]  arrow key to move to the Calibrate box, and 
then press [ENTER] to calibrate the output.

If you are unsatisfied with the calibration, you can reset the inputs 
to factory defaults. Press the [ ] arrow key to move to the Reset 
box, and then press [ENTER] to undo the calibration.

You have completed calibrating the outputs. To leave the Output 
window,

• Press the [ ] key to return to the Output tab, and the  [ ]  
arrow key to move to the Input tab.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the changes. 

• Press [F3] (OK) to confirm the new data. The PT878GC returns 
to Operate Mode.
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Calibrating Inputs

To open the Inputs window, press the [ ] arrow key and press 
[ENTER]. The screen appears similar to Figure 9-15 below.

Note: Calibrating the analog inputs requires use of a current 
source.

 

Figure 9-15: The Inputs Window in the Calibrate Option

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks you to select the input.

a. Press [ENTER] to open the drop-down list.
b. Use the  [ ]or [ ] arrow keys to scroll to the desired 

output (A or B).
c. Press [ENTER] to confirm your selection.

3. The next prompt asks for the value to which you want to set 
the low input (0 or 4 mA).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry. 

Analog Output

Calibrate/Test I/O

Analog Input

Input# A

Low 

Cancel  OK

  4 mA

mA20

Calibrate

High

Read

Read

Reset
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Calibrating Inputs (cont.)

4. Connect the current source to the input and set it to deliver the 
value entered in the previous step.

5. Press the [ ] arrow key to move to the Read box, and then 
press [ENTER] to read the low input.

6. The next prompt asks for the value to which you want to set 
the high input (20 mA).

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm your entry. 

7. Connect the current source to the input and set it to deliver the 
value entered in the previous step.

8. Press the [ ] arrow key to move to the Read box, and then 
press [ENTER] to read the high input.

9. Press the [ ] key to move to the Calibrate box, and press 
[ENTER] to calibrate the inputs.

10.At this point, you have two options:

a. If you are unsatisfied with the calibration, you can reset the 
inputs to factory defaults. Press the [ ] arrow key to move 
to the Reset box, and then press [ENTER] to undo the 
calibration.

b. If you are satisfied with the calibration, press the [ ] key 
to return to the Input# prompt, and repeat steps 2 through 8 
for the other input.

You have completed calibrating the inputs. To leave the Inputs 
window,

• Press the [ ] key to return to the Inputs tab, and the [ ]  
arrow key to move to the Outputs tab.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the changes.

• Press [F3] (OK) to confirm the new data. The PT878GC 
returns to Operate Mode.
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Setting up Signal Parameters

The Signal Setup option enables you to set parameters that affect 
the transducer signal:

• Delta-T Offset

• Transmit Sample Size

• Zero Cutoff

• Velocity Averaging 

• Errors Allowed

• Peak Detection Method

• Peak Thresholds

• Pulse and Code
To enter the option, scroll to the Signal Setup entry on the Service 
Menu and press [ENTER]. The screen appears similar to Figure 
9-16 below.

Figure 9-16: The Signal Parameter Window 

Meas ModeSignal Param

Signal Setup

Cancel OK

Delta-T Offset

Errors Allowed
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8
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Setting up Signal Parameters (cont.)

1. Press the [ ] arrow key to enter the window.

2. The first prompt asks for the Delta-T offset. Delta-T is the 
difference between the upstream and downstream transit times 
of the transducers. The Delta-T offset should normally be set 
to zero.

Note: Consult GE Sensing before performing this step.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the recommended value.

c. Press [ENTER] to confirm your entry. 

3. The next prompt, the transmitter sample size, is the number of 
pulses each transmitter (upstream and downstream) emits. It is 
set to 8 by default.

Note: Consult GE Sensing before performing this step.

a. Press [ENTER] to open the drop-down list.

b. Use the  [ ] or [ ] arrow keys to scroll to the 
recommended number.

c. Press [ENTER] to confirm your selection.

4. The next prompt asks for the zero cutoff. Near “zero” flow, the 
PT878GC may have fluctuating readings due to small offsets 
(caused by factors such as thermal drift in the fluid). The zero 
cutoff causes velocity measurements less than the cutoff to be 
reported as zero. To set the cutoff:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.
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Setting up Signal Parameters (cont.)

5. The next prompt asks for velocity averaging, the number of 
velocity measurements to average together to smooth out 
noise in the system. 

a. Press [ENTER] to open the drop-down list.

b. Use the  [ ] or [ ] arrow keys to scroll to the desired 
number.

c. Press [ENTER] to confirm your selection.

6. The final prompt, errors allowed, specifies the number of 
errors the meter can record before displaying an error 
message.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

You have finished entering data in the Signal Parameter window. 
To leave this window,

• Press the [ ] key to return to the Signal Parameter tab, and 
the [ ] arrow key to move to the Measurement Mode tab.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the changes.

• Press [F3] (OK) to confirm the new data and return to Operate 
Mode.
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Setting up the Measurement Mode

The PT878GC can take measurements in four different ways:

Skan is a low resolution technique for locating the acoustic signal 
and for high velocity measurements. It is more robust in a noisy 
environment than the Measure technique. 

Measure is a more precise technique best used for low velocity 
measurements. You can choose from Skan/Measure Count (the 
default technique) or Skan/Measure Integrate (the traditional 
Skan/Measure mode). A variation, the Skan/Correlation mode, is 
used primarily for liquid flow measurement.

Note: Do not change the measurement mode or values unless 
recommended by GE Sensing. 

From the Signal Parameter tab, press the [ ] arrow key to move 
to the Meas Mode tab. The window appears similar to Figure 
9-17 below.

Figure 9-17: The Measurement Mode  Window 
in the Signal Setup Option
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Cancel OK
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Setting up Measurement Mode (cont.)

The first prompt asks for the measurement mode detection 
method. Use the [ ] and  [ ] arrow keys to move to the 
appropriate radio button and press [ENTER].

You must now enter the setup data covered on page 4-23, if you 
have not already done so. Pressing the  [ ] key takes you to 
“Skan/Measure Setup.” Press [ENTER] to open the Skan/Measure 
option and enter the parameters discussed on page 4-23.

You have completed entering data for the Measurement Mode. To 
leave this window,

• Press the [ ] key to return to the Measurement Mode tab, 
and the [ ]  arrow key to move to the Signal Parameter tab 
or the [ ] arrow key to move to the Pulse/Code tab.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the changes.

• Press [F3] (OK) to confirm the new data and return to 
Operate Mode.
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Setting Up Pulse/Code Parameters

When you select the Skan detection method, you must also 
choose what type of signal to send to the transducers: either a 
coded signal at 1, 2, 4, 11 or Twin bits, or a specific number of 
pulses to be sent. From the Meas Mode tab, press the [ ] arrow 
key to move to the Pulse/Code tab. The window appears similar 
to Figure 9-18 below.

Figure 9-18: The Pulse/Code Window 
in the Signal Setup Option

1. The first prompt asks for the number of bits in the coded 
signal.

a. Press [ENTER] or [SEL] to open the drop-down list.

b. Use the  [ ] or [ ] arrow keys to scroll to the 
recommended number.

c. Press [ENTER] to confirm your selection.
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Setting Up Pulse/Code Parameters (cont.)

2. The next prompt asks if you want to send a specific number of 
pulses. Press [ENTER] to select or deselect the pulse option.

Note: If you do not select this option, pressing the [ ] key 
returns the meter to the Transmit Code prompt.

3. The next prompt asks how many pulses (from 0 to 16) you 
wish to send.

a. Press [ENTER] to open the drop-down list.

b. Use the  [ ] or [ ] arrow keys to scroll to the 
recommended number.

c. Press [ENTER] to confirm your selection.

4. The final prompt, signal inversion, enables you to invert the  
transducer signal. Signal inversion may be necessary if your  
readings show unusual jitter, or for certain unusual 
combinations of pipe and fluid or pipe and lining. Signal 
inversion should be off, unless you have received other 
instructions. To change its status, use the [ ] and [ ] arrow 
keys to move to the appropriate radio button and press 
[ENTER].

You have completed entering data in the Signal Setup option.

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the changes.

• Press [F3] (OK) to confirm the new data and return to 
Operate Mode.
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Setting Error Limits

The Error Limits option enables you to set limits for an incoming 
signal. When the signal falls outside the programmed limits, an 
error indication appears. To enter this option, scroll to the Error 
Limits entry on the Service Menu and press [ENTER]. The screen 
appears similar to Figure 9-19 below.

Figure 9-19: The Signal Error Limits Option

1. The first prompt asks for the minimum and maximum limits 
for the transducer signal received by the PT878GC. The 
default values are 10 for the minimum and 72 for the 
maximum. The E1: LOW SIGNAL error message appears if 
the signal strength falls below the limit programmed here.

    To enter the minimum signal:

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired value.

c. Press [ENTER] to confirm your entry.

Programming

Signal Error Limits

Cancel OK
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Setting Error Limits (cont.)

d. Press the [ ] arrow key to move to the maximum signal 
box, and repeat steps a, b and c.

e. Press the [ ] arrow key to return to the minimum signal 
box, and the  [ ] key to move to the next limit.

2. The next prompt calls for the low and high velocity limits. The 
E3: VELOCITY RANGE error message appears if the 
velocity falls outside these limits. Repeat the steps in Step 1 
on the previous page to enter the desired limits.

3. The third prompt calls for the low and high limits for the 
amplitude discriminator. The discriminator measures the size 
of the transducer signal sent from the PT878GC. If the signal 
falls outside these limits, the E5: AMPLITUDE error message 
appears. Repeat the steps in Step 1 on the previous page to 
enter the desired limits. 

4. The fourth prompt asks for the acceptable limits for the sound 
speed, based on conditions in your particular system. The E2: 
SOUND SPEED error message appears if the fluid sound 
speed exceeds that entered in the Pipe option of the Program 
menu by more than this percentage. The default value is 20% 
of the nominal soundspeed.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired percentage.

c. Press [ENTER] to confirm your entry.

5. The final prompt asks for the acceleration limit for detecting 
cycle skipping. The E6: CYCLE SKIP/ACCELERATION 
message appears if the velocity changes by more than this 
limit from one reading to the next.

a. Press [ENTER] to open the text box.

b. Use the numeric keys to enter the desired speed.

c. Press [ENTER] to confirm your entry.
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Setting Error Limits (cont.)

Note: For the velocity and acceleration boxes, the F1 softkey 
toggles between English and metric measurements. Thus, 
the key will always display the opposite measurement 
from that which is currently active. Press [F1] to display 
the measurement in the alternate format.

You have completed entering signal error limits. 

• Press [F2] (Cancel) to return to Operate Mode without 
confirming the error limits, or

• Press [F3] (OK) to confirm the new limits and return to Operate 
Mode.
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The Test Option

Within the Service Menu, the Test option includes seven tests to 
ensure that the PT878GC is performing properly: Test Screen, 
Test Keys, Watchdog Test, Impulse Response, Wave Snapshot, 
Simulate and Battery Test.To enter this option, scroll to the Test 
entry on the Service Menu and press [ENTER]. The screen appears 
similar to Figure 9-20 below.

Figure 9-20: The Test Option in the Service Menu

Scroll to the desired entry in the option menu and press [ENTER].
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Testing the Screen

To test the proper functioning of the PT878GC screen, scroll to 
the Test Screen option in the Test Menu and press [ENTER]. The 
screen then shows the message, “Press Any Key To Continue.” 
Once you press a key, a screen with a checkerboard pattern 
appears, as shown in Figure 9-21 below.

Figure 9-21: A Functioning Test Screen

Pressing a key two more times should result in two more 
checkerboard patterns, followed by a series of dark and light 
screens. Pressing the key through this sequence should return the 
PT878GC to Operate Mode. If the test does not proceed 
according to this sequence, please consult GE Sensing.
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Testing the Keys

The Test Keys option checks the functioning of the various keys 
on the keypad. To start the test, scroll to the Test Keys option on 
the Test Menu and press [ENTER]. The screen appears similar to 
Figure 9-22 below. Press any key on the keypad, and a window 
representing that key should darken.

Figure 9-22: The Test Keys Window

Pressing the [F3] key returns the meter to the Operate Mode. If 
any key does not appear on the screen or does not darken when 
pressed, contact GE Sensing.

Note: The power key does not appear in this test.
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Testing the Watchdog Timer Circuit

The PT878GC includes a watchdog timer circuit. If a software 
error causes the meter to stop responding, this circuit 
automatically resets the meter. A properly functioning PT878GC 
restarts if you run the Watchdog Test.

To start the Watchdog Test, scroll to the Watchdog Test option in 
the Test Menu and press [ENTER]. The screen appears similar to 
Figure 9-23 below.

Figure 9-23: The Watchdog Test Screen

Press [F2] (No) to cancel the test and return to the Menu screen, or 
press [F3] (Yes) to start the test. The PT878GC should go blank 
for a few seconds, and then restart. If it does not follow this 
sequence, consult GE Sensing.
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** WARNING **
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Setting Impulse Response

The Impulse Response option enables you to force the meter to 
transmit in one direction only, without changing the AGC setting. 
You can then diagnose problems with transducer, pipe, or fluid 
configurations. To enter the option, scroll down to the Impulse 
Response entry in the Service Menu and press [ENTER]. The 
screen appears similar to Figure 9-24 below.

Figure 9-24: The Impulse Response Option

1. The first prompt asks in which direction you wish the meter to 
transmit, upstream or downstream.

a. Press [ENTER] to open the drop-down list.

b. Use the  [ ] or [ ] arrow keys to scroll to the desired 
direction.

c. Press [ENTER] to confirm your selection.

Transmit    Stop Exit

Impulse Response

 

 
 

. 

Direction Upstream

Percent Gain             20 %

Stopped.
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Setting Impulse Response (cont.)

2. The second prompt asks for the percent of gain.

a. Press [ENTER] to open the text box.
b. Use the numeric keys to enter the desired percentage.
c. Press [ENTER] to confirm your entry.

You have completed entering data for the Impulse Response 
option.

• Press [F1] to start transmitting in the chosen direction.

• Press [F2] to stop transmitting.

• Press [F3] to leave the option and return to Operate Mode.

Taking Wave Samples for Diagnosis

The Wave Snapshot option allows you to capture receive signals 
to a file that you can send to a PC for diagnostic purposes. To use 
this option, scroll down to the Wave Snapshot entry in the Service 
Menu and press [ENTER]. The PT878GC then captures three pairs 
of upstream and downstream raw signals to a file named 
Wave01.met. (If you repeat the captures, the successive files will 
be named Wave02.met, Wave03.met, etc.) You can then transfer 
the files over the IR port to a PC for analysis by a service 
engineer. 

Note: Refer to page 6-16 for information on transferring a file 
to a PC.

Applying a Stored Signal for Diagnosis

The Simulate option places the PT878GC in a mode in which it 
uses a stored signal (instead of the live signal from the 
transducers) to make flow calculations for diagnostic purposes. 
On the PC, you must rename a Wavexx.met file as Wave.met and 
send it back to the PT878GC over the IR link. Then, on the 
PT878GC, scroll down to the Simulate entry in the Service Menu 
and press [ENTER]. The PT878GC then applies the simulated 
signal.

Note: Refer to page 6-17 for information on transferring a file 
from a PC to the PT878GC.
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Testing the Battery

The Battery Test option provides additional battery information 
for service troubleshooting. To enter the option, scroll down to 
the Battery Test entry in the Service Menu and press [ENTER]. The 
screen appears similar to Figure 9-25 below.

Figure 9-25: The Battery Test Option

The screen displays the current status (Fast Charge, On Charge, 
Discharging, or On Battery), the time remaining for the PT878GC 
to run on the battery, the time for the Fast Charge, and the current 
condition of the backup battery.

1. If you wish to open the Part Number window, press [ENTER]. 
You can choose from a 1.8 Ahr NiCd battery (part number 
200-058) or a 3.0 Ahr NiMH battery (part number 200-081). 
Scroll to the battery type you have installed and press [ENTER].

2. To condition the batteries, press the [ENTER] key. The 
“Condition Battery” window should now read “Stop.” The 
status line should change to “Discharging.” (Updating the 
status could take up to 30 seconds.)

3. To stop the discharge cycle, press the [ENTER] key and the 
“Condition Battery” window reappears. The status now 
changes to “On Charger.”

4. Press [F3], OK, to return to Operate Mode.

Service Battery Form

Cancel OK

Status: Fast Charge

Batt Voltage     5.78 Volts
Fast Charge     3 Min

Condition Battery

Run Time          250 Minutes 

Backup Battery: OK  Batt temp 27.7 °C

       Part Number: 1.8Ahr NiCd (200-058)
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Resetting to Factory Default Parameters

For various reasons, you might wish to return the PT878GC to its 
original settings. The Factory Defaults option enables you to 
return the meter to its preprogrammed default settings. To enter 
the option, scroll down to the Factory Defaults entry in the 
Service Menu and press [ENTER]. The screen will appear similar to 
Figure 9-26 below.

IMPORTANT: All sites and logs will be lost if you use the 
Factory Defaults option. Be sure to transfer or 
print all sites and logs before resetting!

Figure 9-26: The Factory Defaults Option

1.  You have two options:

• Press [F2] (Cancel) to return to Operate Mode without 
changing the current settings.

• Press [F3] (OK) to confirm that you wish to restore the 
factory default settings.

2. The program asks for confirmation: “Are you SURE?” Repeat 
the procedure shown in step 1 above.

The PT878GC replaces the default site file and the global meter 
settings with the factory default settings.

Factory Defaults

Cancel OK

*** WARNING ***
You will LOSE all changes by
pressing OK.

Choose CANCEL to exit or OK to
proceed.
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Updating PT878GC Software

By using a Windows-based PC with an infrared adapter, 
PT878GC users can update the meter’s operating software 
without the need to change the hardware. This software can 
include the bootloader, FPGA software (timing software for 
transit-time), instrument software, the meter string file and the 
Help string file. The updating procedure involves three steps:

1. Setting up the PT878GC in Flash Update mode.

2. Selecting the loading interface.

3. Loading the new software from the PC into the PT878GC.

Caution!
To guard against mishap, you should print out, download 
or otherwise record all logs, settings and other data you 

wish to save. 

IMPORTANT: When uploading new software, the PT878GC 
uses a “bootloader” program. Be sure that the 
software you are installing is compatible with the 
installed bootloader version, shown in the 
“About” option discussed on page 6-21. If you 
need to replace both programs, install the new 
bootloader first, before any other software.

With the current bootloader software, two interfaces are available 
for sending software to the PT878GC:

• IrOBEX, a recently introduced Microsoft infrared standard 
which allows more straightforward use and faster file transfers, 
while tolerating IR interruptions better.

• IrCOMM, an infrared standard supported by certain Microsoft 
operating systems.

GE Sensing recommends updating software via the IrOBEX 
standard; however, the IrCOMM standard is available for users 
who have problems with IrOBEX. This section covers procedures 
for both standards.
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Updating Software Via IrOBEX

To begin updating software via IrOBEX, scroll down to the Flash 
Update entry in the Service Menu and press [ENTER]. The screen  
appears similar to Figure 9-27 below.

Figure 9-27: The Flash Update Window

• Press [F2] (Cancel) to return to Operate Mode without 
erasing the program.

• Press [F3] (OK) to confirm that you wish to erase the 
program.

4. The meter asks for confirmation. Repeat the options shown in 
Step 1 above. After the PT878GC reboots, the screen appears 
similar to Figure 9-28 below.

Figure 9-28: Flash Reloading Window

 Update Flash

OK

--WARNING--
This will erase the
instrumentation coding.

Choose ‘Cancel’ to exit or ‘OK’
to continue.

Cancel

GE Sensing PCI Loader v3.0  2/26/04
[HW Rev3+]

Reload Flash via Infrared (Yes/No)?

Backup Battery: OK
Firmware CRC: Valid

IrOBEX          No           IrCOMM
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Updating Software Via IrOBEX (cont.)

5. The meter now asks if you wish to reload the flash memory 
via the infrared communications port. 

• Press [F1] (Yes) to begin reloading via OBEX, or

• Press [F2] (No) to stop the reloading procedure.
Be sure the infrared sensor on the meter has a clear path to the 
infrared adapter on the PC. Now return to the PC.

6.  You now have two options:

• In Windows Explorer, browse to the file you wish to send. 
Select and right-click on it. Select Send To  Infrared 
Recipient or Nearby Computer (or QuickBeam if 
QuickBeam has been installed).

• Open the Infrared Transfer Application (My 
Computer\Infrared Recipient), click on Send Files, and 
select the files you wish to send.

In either case, a window displays the status of the file upload.
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Updating Software Via IrCOMM

Note: While Windows 95/98/98SE and NT (with QuickBeam) 
support IrCOMM, Windows 2000 and XP do not. Refer to 
Appendix B.

Before you install new coding, you must be sure that the PC has 
the correct protocols to transmit the software to the meter.

Setting up the PC

Note: The use of Hyperterminal is shown here as an example. If 
you are using a different communications software, see its 
manual for detailed instructions.

1. From the Start Menu, click Programs/Accessories/
Hyperterminal to open the Hyperterminal window.

2. If the call is not connected, click on Connect from the Call 
menu in Hyperterminal.

3. From the File menu, click Properties. Be sure the New 
Connection Properties window is set to your virtual infrared 
port.

Note: You can determine which virtual port your infrared is 
using by opening Infrared Monitor in the Control Panel 
and clicking on the Options tab. It displays the message, 
“Providing Application Support on:” and then lists the 
virtual infrared port, as shown in Figure 9-29 on the next 
page.
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Setting up the PC (cont.)

Figure 9-29: Port Settings for COMM 4

Installing New Software

To begin the loading procedure, scroll down to the Flash Update 
entry in the Service Menu and press [ENTER]. The screen  appears 
similar to Figure 9-30 below.

Figure 9-30: The Flash Update Option

 Update Flash

OK

--WARNING--
This will erase the
instrumentation coding.

Choose ‘Cancel’ to exit or ‘OK’
to continue.

Cancel
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Installing New Software (cont.)

1. As shown in Figure 9-30 on the previous page, the Flash 
Update option erases all instrument coding. 

• Press [F2] (Cancel) to return to Operate Mode without 
erasing the program.

• Press [F3] (OK) to confirm that you wish to erase the 
program.

2. The meter asks for confirmation. Repeat the options shown in 
Step 1 above. The screen on both the PC and the PT878GC 
now appears similar to Figure 9-31 below.

Figure 9-31: Flash Reloading Window

3. The meter now asks if you wish to reload the flash memory 
via the infrared communications port. 

• Press [F3] (Yes) (or C on the PC keyboard) to begin 
reloading via IrCOMM, or

• Press [F2] (No) (or ESC on the keyboard) to stop the 
reloading procedure.

4. Be sure the infrared sensor on the meter has a clear path to the 
infrared adapter on the PC, and return to the PC 
Hyperterminal program.

GE Sensing PCI Loader v3.0  2/26/04
[HW Rev3+]

Reload Flash via Infrared (Yes/No)?

Backup Battery: OK
Firmware CRC: Valid

IrOBEX          No           IrCOMM
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Installing New Software (cont.)

1. In the Hyperterminal window, pull down the Transfer menu 
and click Send File. A window opens similar to Figure 9-32 
below.

Figure 9-32: The Send File Window in the Transfer Menu

2. Click on the replacement software (designated by a .cod 
extension) from the folder where it has been stored.

3. From the Protocol drop-down menu, select Xmodem.
4. Click Send. For a successful transfer, the PC window appears 

similar to Figure 9-33 below, while the PT878GC screen 
displays the program ID, size, load address and a count of 
blocks being loaded.

Figure 9-33: The File Transmission Window
Servicing the PT878GC 9-49



April 2009
Chapter 10

Diagnostics and Troubleshooting

The TransPort PT878GC is a reliable instrument that is easy to 
maintain. It will provide accurate flow measurement readings as 
long as it is operated as described in this manual. If problems do 
arise with the electronics, transducers or the flowcell, the 
TransPort displays an error message specifying the possible 
problem. The TransPort also has a set of diagnostic parameters to 
help you find and remedy the problem.

In general, troubleshooting may be necessary if the TransPort 
displays an error message, the flow readings are erratic, or you 
have other reasons to doubt the accuracy of readings (for 
example, readings do not agree with other flow measuring 
devices connected to the same process).

This section describes error messages, diagnostic parameters, and 
shows you how to isolate problems to one of the following areas:

• Electronics, including programmed values

• Flowcell, which includes the pipe and fluid

• Transducers and cables.
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Error Code Messages

Error Code messages appear on the screen while you are 
displaying measurements. When logs appear in graph form, 
errors are indicated by a vertical gray bar at the point of error. 
When they appear in a spreadsheet format, errors are indicated by 
their number in the last row, called “Error.”The Error Code 
messages are only general descriptions of the possible problems. 
Use Table 10-1 on page 10-3 to isolate and remedy the problem. 
If you are unable to remedy the problem, contact GE Sensing.

Note: We suggest that, in order to isolate the indicated problem 
more easily, you obtain a test flowcell. Contact GE  
Sensing for details.
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Table 10-1:  Error Messages

Error 
Message Problem

Possible 
Cause Action

E0  No error. Displays briefly 
after the dis-
play of another 
error message

None required. Mea-
surement is valid.

E1 Low Signal - 
Poor ultra-
sonic signal 
strength.

Broken cable. 
Flowcell prob-
lem. Trans-
ducer problem. 
Electronic fail-
ure.

Check transducer 
cable. See Flowcell 
Problems on page 10-
9 and Transducer 
Problems on page 10-
11. Check program-
ming and transducer 
spacing. Contact the 
factory if problem 
persists.

E2 Sound Speed 
Error (Sound 
speed is pro-
grammed 
using the Pro-
gram Menu 
Pipe option. 
as described 
in Chapter 4.)

Poor flow con-
ditions. 
Incorrect pro-
gramming. Bad 
transducer spac-
ing. Measure-
ment is very 
different from 
the pro-
grammed 
sound speed. 

Check sound speed 
against nominal sound 
speed. See Flowcell 
Problems on page 10-
9 and Transducer 
Problems on page 10-
11. Check program-
ming and transducer 
spacing.
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E3 Velocity 
Range - 
Velocity 
exceeds pro-
grammed 
limits. 
(Velocity 
limit is pro-
grammed 
using the Ser-
vice Menu 
Error Limits 
option as 
described in 
Chapter 9.) 

Programming 
error, poor flow 
conditions, or 
bad transducer 
spacing.

Make sure the maxi-
mum velocity range  
is within the range 
listed in Table 3-1 on 
page 3-4 for the pipe 
size and pressure. 
Check programming 
and transducer spac-
ing. If programmed 
value is outside of 
limit, change the lim-
its as described in 
Chapter 9 on page 9-
32. See Flowcell 
Problems on page 10-
9 and Transducer 
Problems on page 10-
11.

E4 Signal
Quality

If too high - 
electronic fail-
ure. If too low - 
flowcell, elec-
trical problem.

Check for source of 
electrical interfer-
ence. Check electron-
ics with a test 
flowcell.Check to see 
if the velocity is above 
the maximum value. 
Check to see if the 
pressure is above the 
minimum required 
pressure for the pipe 
OD/WT.  If unit still 
fails to operate, con-
tact the factory.

E5 Amplitude 
Error

Excessive parti-
cles or liquid 
present in fluid. 
A lot of second 
phase present

See Flowcell Prob-
lems on page 10-9.

Table 10-1:  Error Messages (cont.)

Error 
Message Problem

Possible 
Cause Action
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E6 Cycle skip, 
Acceleration

Poor flow con-
ditions or bad 
transducer spac-
ing.

Check transducer 
spacing as pro-
grammed and as set 
on pipe.See Flowcell 
Problems on page 10-
9 and Transducer 
Problems on page 10-
11.

E7 Analog Out 
Error

Under current 
output.

Check that output load 
is within specification 
<550 ohm.

E16 High Signal Entry of 
improper value 
in Transducer 
or Pipe sub-
menus.

Check values in 
Transducer and Pipe 
submenus. Remove 
preamp.

E17 Equation 
Limit

(Steam equa-
tions only)
Process temper-
ature and/or 
pressure are 
outside valid 
limits of Steam 
Equations for 
mass flow.

Adjust the pressure 
reading to within the 
range of 139.9685 kPa 
to 2242.9435 kPa, or 
the temperature read-
ing to within the range 
of 373.1500K to 
810.9278K.

E18 Supersatu-
rated

(Steam equa-
tions only)
Process temper-
ature is below 
the saturation 
temperature of 
steam for the 
process pres-
sure.

Raise the system tem-
perature or lower the 
system pressure until 
all the water vapor-
izes.

Table 10-1:  Error Messages (cont.)

Error 
Message Problem

Possible 
Cause Action
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Displaying Diagnostic Parameters

As part of its measurement menu, the PT878GC offers a list of 
diagnostic parameters to aid in troubleshooting in the event of 
flowcell, transducer, or electrical problems. You can select any 
diagnostic parameter for display as a measurement as discussed 
in Chapter 6 on pages 6-7 and 6-8. Table 10-2 below shows all the 
available diagnostic parameters and ranges.

Table 10-2:   Diagnostic Parameters
Diagnostic
Parameter  Displays Good Bad

ΔT Displays Delta T, or the differ-
ence between the upstream 
and downstream transit times.

N/A Continuous 
large fluctu-
ations of 1 
micro sec-
ond or 
more.

Amplitude Up Displays the value for the 
amplitude discriminator of the 
upstream transducer.

20-28 <20 or > 28.

Amplitude 
Down

Displays the value for the 
amplitude discriminator of the 
downstream transducer.

20-28 
fluctua-
tions

< 20 or > 28 
fluctuations

T Up Displays the upstream 
transit time of the 
ultrasonic signal in micro 
seconds.

N/A N/A

T Down Displays the downstream tran-
sit time of the ultrasonic signal 
in micro seconds.

N/A N/A

Gain/Up Displays upstream gain in dB. N/A N/A

Gain/Dn Displays downstream gain in 
dB.

N/A N/A

CNTup Displays the AGC DAC count 
for upstream gain setting.

N.A. N.A.

CNTdn Displays the AGC DAC count 
for downstream gain setting.

N.A. N.A.
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Soundspeed
(m/s or f/s)

Displays the measured sound 
speed of the fluid.

Check the sound speed 
of fluid in Sound Speeds 
and Pipe Size Data.

P#up Displays signal peaks for the 
upstream transducer.

100-
900

<100, >900

P#dn Displays signal peaks for the 
downstream transducer.

100-
900

 <100, >900

Reynolds # Displays the Reynolds Num-
ber.

N/A N/A

K(RE) Displays the K Factor, based 
on the Reynolds Number.

N/A N/A

Raw Up Displays raw upstream signal. N/A N/A

Demod Up Displays demodulated 
upstream signal.

N/A N/A

Skan Corr Up Displays skan correlation 
upstream signal.

N/A N/A

Raw Down Displays raw downstream 
signal.

N/A N/A

Demod Down Displays demodulated 
downstream signal.

N/A N/A

Skan Corr 
Down

Displays skan correlation 
downstream signal.

N/A N/A

Xmit Corr Up Displays raw upstream signal 
correlated with transmit
signal.

N/A N/A

Xmit Corr Dn Displays raw downstream sig-
nal correlated with transmit 
signal.

N/A N/A

Cross Corr Displays transmit upstream 
signal correlated with transmit 
downstream signal.

N/A N/A

Signal up Displays the signal strength 
for the upstream transducer.

50-80 <50

Signal dn Displays the signal strength 
for the downstream 
transducer.

50-80 <50

Qup Displays the signal quality for 
the upstream transducer. 

±300 or 
higher

 between 
±100

Table 10-2:   Diagnostic Parameters (cont.)
Diagnostic
Parameter  Displays Good Bad
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Qdown Displays the signal quality for 
the downstream transducer.

±300 or 
higher

between 
±100

Norm Factor Displays the normalization 
factor.

 0.85 -   
1.0

<0.85

Threshold Up Displays the Percent of Peak 
for the upstream transducer. 
Set to -40 by default. 

N/A N/A

Threshold Dn Displays the Percent of Peak 
for the downstream trans-
ducer.  Set to -40 by default. 

N/A N/A

SNRup Displays the signal/noise ratio 
for the upstream transducer.

N/A N/A

SNRdn Displays the signal/noise ratio 
for the downstream trans-
ducer.

N/A N/A

Voltage Displays remaining battery 
voltage.

5.75-
7.5

<5.25

Time 
Remaining

Displays estimated battery 
time remaining.

N/A N/A

Table 10-2:   Diagnostic Parameters (cont.)
Diagnostic
Parameter  Displays Good Bad
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Flowcell Problems

Flowcell problems fall into two categories: gas problems and pipe 
problems. Read the following sections carefully to determine if 
such problems exist.

Gas Problems

Most gas-related problems can be solved by proper design of the 
flowmeter installation and the proper choice of transducer 
frequency. Contact GE Sensing if you cannot solve a gas-related 
problem.

If the physical installation of the system meets the recommended 
specifications, it is possible that the gas itself may be preventing 
accurate flow rate measurements. The gas being measured must 
meet the following requirements:

1. THE GAS MUST BE HOMOGENOUS, SINGLE-PHASE 
AND RELATIVELY CLEAN. Although a low level of 
entrained particles may have little effect on the operation of 
the TransPort, excessive amounts of solid or liquid particles 
will absorb or disperse the ultrasound signals. This 
interference with the ultrasound transmissions through the gas 
will cause inaccurate flow rate measurements. In addition, 
temperature gradients in the gas flow may result in erratic or 
inaccurate flow rate readings.

2. THE GAS MUST NOT EXCESSIVELY ATTENUATE 
ULTRASOUND SIGNALS. Some gases (i.e., high-purity 
carbon dioxide, hydrogen, helium, etc.) readily absorb 
ultrasound energy. In these cases an “E1” will appear on the 
screen to indicate that the ultrasonic signal is insufficient for 
reliable measurements.
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Fluid Problems (cont.)

3. THE GAS SOUND SPEED MUST NOT VARY 
EXCESSIVELY. The TransPort will tolerate relatively large,  
changes in gas sound speed due to changes in gas composition 
and temperature. However, such changes must occur slowly. 
Rapid fluctuations in the gas sound speed, to a value that is 
considerably different from that programmed into the 
PT878GC, will result in erratic or inaccurate flow rate 
readings. Refer to Chapter 4, Programming Site Data,  pages 
4-13 and 4-14.

Pipe Problems

Improper pipe conditions and/or flowcell installation can cause 
problems with measurement of the gas flow. Contact GE Sensing 
if you cannot solve pipe-related problems. By far, the most 
common pipe problems are the following

1. THE COLLECTION OF MATERIAL AT THE 
TRANSDUCER LOCATION(S). Accumulated debris at the 
transducer location(s) will interfere with transmission of the 
ultrasound signals. As a result, accurate flow rate 
measurements are not possible. Realignment of the flowcell or 
transducers often cures such problems. Refer to Chapter 3 for 
proper transducer installation.

2. INACCURATE PIPE MEASUREMENTS. The accuracy of 
the flow rate measurements is no better than the accuracy of 
the programmed pipe dimensions. For a flowcell supplied by 
GE Sensing, the correct data will be included in the 
documentation. For other flowcells, measure the pipe wall 
thickness and diameter with the same accuracy desired in the 
flow rate readings. Also, check the pipe for dents, eccentricity, 
weld deformity, straightness and other factors that may cause 
inaccurate readings. Refer to Chapter 4, Programming Site 
Data, pages 4-7 to 4-10, for instructions on programming the 
pipe data. 
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Transducer Problems
Ultrasonic transducers are rugged, reliable devices. However, 
they are subject to physical damage from mishandling and 
chemical attack. The most common transducer problems are 
listed below.
1. LEAKS: Leaks may occur around the transducer and/or the 

flowcell fittings. Repair such leaks immediately. If the leaking 
gas is corrosive, carefully check the transducer and cables for 
damage, after the leak has been repaired.

2. CORROSION DAMAGE: If the transducer material was not 
properly chosen for the intended application, the transducers 
may suffer corrosion damage. The damage usually occurs 
either at the electrical connector or on the transducer surface. 
If corrosion is suspected, remove the transducer from the 
flowcell and carefully inspect the electrical connector and the 
transducer surface for roughness and/or pitting. Any 
transducer damaged in this manner must be replaced. Contact 
GE Sensing for information on transducers in materials 
suitable for the application.

3. INTERNAL DAMAGE: An ultrasonic transducer consists of 
a ceramic crystal bonded to the transducer case. The bond 
between the crystal and the case, or the crystal itself, may be 
damaged by extreme mechanical shock and/or temperature 
extremes. Also, the internal wiring can be corroded or shorted 
if contaminants enter the transducer housing.

4. PHYSICAL DAMAGE: Transducers may be physically 
damaged by dropping them onto a hard surface or striking 
them against another object. The transducer connector is the 
most fragile part and is the one most subject to damage. Minor 
damage may be repaired by carefully bending the connector 
back into shape. If the connector cannot be repaired, the 
transducers must be replaced.

Note: Transducers must be replaced in pairs. Refer to Chapter 
4, Programming Site Data, to program the replacement 
transducer data into the meter.

Contact GE Sensing if you cannot solve a transducer-related 
problem.
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Chapter 11

Specifications

This section contains specifications for the following:

• Operations and Performance

• Electronics

• Clamp-on Transducers

• Thickness Gauge Option

• Additional Options
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Operation and Performance
Fluid Types

Acoustically conductive gases with minimum density 
requirements. See Table 3-1 on page 3-5, Table 3-2 on page 3-7 
and Table 3-3 on page 3-9.

Pipe Sizes

0.75 to 12 in. (20 to 300 mm) with PT878GC-01 electronics

4 to 24 in. (100 to 610 mm) with PT878GC-02 electronics

Pipe Wall Thickness

See Table 3-1 on page 3-5, Table 3-2 on page 3-7 and Table 3-3 
on page 3-9.

Pipe Materials

All unlined metals and plastics; no lined pipes.

Clamp-On Flow Accuracy (Velocity)

For pipes 6 in. (150 mm) and smaller: ±2% to 5% of reading 
typical

For pipes over 6 in. (150 mm): ±1% to 2% of reading typical

Note: Accuracy depends on pipe size and whether measurement 
is one-path or two-path. Accuracy to ±0.5% of reading 
may  be  achievable  with  process  calibration.                                                                                    

Repeatability

±0.2 to 0.5% of reading

Range (Bidirectional)

See Table 3-1 on page 3-5, Table 3-2 on page 3-7 and Table 3-3 
on page 3-9.

Rangeability (Overall)

150:1
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Operation and Performance (cont.)

Note: Specifications assume a fully developed flow profile 
(typically 20 diameters upstream/10 diameters 
downstream straight run) and flow velocity greater than 
5 ft/s (1.5 m/s). Pipes 2 in. (50 mm) or less require a 
minimum of 10 ft (3 m) of continuous straight run without 
flanges, welds or coupling joints.

Pressure Requirements, Air, Nitrogen, Oxygen, Argon

See Table 3-1 on page 3-5.

Pressure Requirements, Natural Gas

See Table 3-2 on page 3-7.

Pressure Requirements, Steam

See Table 3-3 on page 3-9.

Pressure Requirements, Other Gases

Dependent upon gas composition, and pipe size and material. 
Consult GE Sensing.

Measurement Parameters

Standard and actual volumetric flow, flow velocity and mass 
flow. 
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Electronics
Flow Measurement

Patented Correlation Transit-Time mode

Enclosures

Submersible IP67

Dimensions

Weight: 3 lb (1.36 kg)
Size: (h x w x d) 9.4 x 5.5 x 1.5 in. (238 x 138 x 38 mm)

Display

240- x 200-pixel backlit LCD graphic display

Keypad

25-key rubberized tactile membrane keypad

Internal Battery

Rechargeable battery: 8 hours of continuous operation

Battery Charger Input

100 to 250 VAC, 50/60 Hz, 0.38 A

Memory

FLASH memory; field upgradable

Operating Temperature

–20° to 55°C (–4° to 131°F) 

Storage Temperature

 –40° to 70°C (–40° to 158°F)

Note: To ensure maximum battery life, storage temperature 
exceeding 35°C (95°F) is not recommended for more than 
one month.
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Standard Inputs/Outputs

• One 0/4- to 20-mA current output

• One user-selectable pulse (solid state, 5-V maximum) or 
frequency (5-V square wave; 100 to 10,000 Hz)                            

• Two 4- to 20-mA analog inputs with switchable power supply 
for loop-powered temperature or pressure transmitters 

Digital Interfaces

Infrared communication port for printer or PC interface

Site Parameter Programming

• Menu driven operator interface using keypad and "soft"         
functions keys

• On-line help functions including pipe tables

• Storage for saving site parameters

Data Logging

• Memory capacity to log over 100,000 flow data points

• Keypad programmable for log units, update times, start and 
stop time

Display Functions

• Graphic display shows flow in numerical or graphic format

• Displays logged data

• Extensive diagnostic parameters

European Compliance

Battery-powered system complies with EMC Directive 89/336/
EEC, and transducers comply with PED 97/23/EC for DN<25.
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Clamp-On Ultrasonic Flow Transducers

Temperature Range(s)

Standard: –40° to 130°C (–40° to 266°F)
Optional (overall range): –40° to 230°C (–40° to 446°F)

Transducer Materials

Stainless steel and plastic

Fixture Materials

Anodized aluminum blocks with stainless steel rod, chain or strap

Mountings

Portable gas-transducer clamping fixtures in polycarbonate 
carrying cases:

• PCFG-1 for pipes smaller than 12 in. (300 mm) in diameter

• PCFG-2 for pipes larger than 12 in. (300 mm) in diameter

• PCFG-3 for pipes between 3/4 in.(20 mm) and 24 in. (610 
mm) in diameter

Mounting Couplant

CPL-16

Area Classifications

• Standard: General purpose

• Optional: Weatherproof Type 4, IP65

• Optional: Explosionproof Class I, Div 1, Groups C,D

• Optional: Flameproof e II 2 G EEx md IIC T6–T3
(certification pending)

Note: PT878GC electronics are designed for general purpose 
areas.
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Transducer Cables

• Standard: One pair of LEMO® coaxial transducer connectors 
with 25-ft (8-m) cables

• Optional: 500-ft (152-m) extension cables available for most 
transducers
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Thickness Gauge Option

Transducer

GE Sensing dual element transducer

Pipe Thickness Range

0.05 to 3 in. (1.3 to 76.2 mm)

Pipe Materials

Most standard metal and plastic pipe materials

Accuracy

±1% typical or ±0.002 in. (±0.05 mm)

Thermal Exposure

Continuous operation to 37°C (100°F); Intermittent operation to 
260°C (500°F) for 10 sec followed by 2 min air cooling

Additional Options

PC Communication

The PT878GC communicates with a PC through the infrared 
interface and Windows® operating systems. Consult the manual 
for details on sites, logs and other operations with a PC.

RS232-to-Infrared

IR adapter plugs into any available serial port to give desktop PCs 
infrared capability.

Printer

• Infrared, portable, thermal printer with rechargeable battery 
and 120- to 240-VAC power supply/recharger

• 13 oz (370 g); 6.3 x 6.5 x 2.3 in. (160 x 164.2 x 59 mm); 
print width 4 in. (104 mm).
11-8 Specifications
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Menu Maps
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Figure A-4:  The Program Menu: Pipe Option
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Figure A-5:  The Program Menu: Standard Volume Option
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Figure A-11:  The Communications Option
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Appendix B
Establishing IR Communications 
with the PT878GC

As discussed in Chapter 2, the PT878GC includes an infrared 
transceiver for communication with IR products that comply with 
the IrDA protocol. However, you must also be sure that the 
operating system of your personal computer offers IrDA 
compatibility and either a built-in IR port (available on most 
laptops) or an IR dongle (IR to RS232 adapter for PCs without a 
built-in IR port). If your PC does not have an IR dongle, GE 
Sensing recommends the ActiSys ACT-IR220L+ infrared to RS-
232 adapter, which has been tested for compatibility with the 
PT878GC.  Be sure to position the interface in a way that permits 
transmission between the interface and the infrared sensor on the 
PT878GC, shown in Figure 2-2 on page 2-2.

Table B-1 on the next page lists IrDA compatibility for various 
past and current Microsoft Windows operating systems. 
IrCOMM is an infrared standard supported by Microsoft, while 
OBEX is a newer infrared standard which allows more 
straightforward use and faster file transfers, while tolerating IR 
interruptions better.
Establishing IR Communications with the PT878GC B-1
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*May require QuickBeam installation under some circumstances 
when Windows built-in support fails. QuickBeam is a recom-
mended infrared file software transfer utility from Extended Sys-
tems, Inc. Since Windows NT4.0 has no built-in support for IR file 
transfer, QuickBeam is necessary with this operating system.

Windows 2000/XP

Both Windows 2000 and XP include infrared drivers in their 
operating systems. From the Control Panel, click on Add New 
Hardware and select the appropriate IR port, whether built-in or 
using an external dongle.

Table B-1:  IrDA Compatibility of Windows Operating 
Systems

Operating System IrCOMM OBEX
Windows XP No Yes

Windows 2000 No Yes
Windows NT 4.0 QuickBeam* QuickBeam*
Windows Me* Yes Yes

Windows 98 SE* Yes Yes
Windows 98* Yes Yes
Windows 95* Yes Yes
Windows 3.1 No No

DOS 6.22 No No
B-2 Establishing IR Communications with the PT878GC
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Windows NT4.0

For IR use, Windows NT4.0 requires installation of QuickBeam 
software from Extended Systems (www.extendedsystems.com). 
Desktop PCs and laptops without built-in IR ports also require 
adding an IR dongle. While laptops with a built-in IR port 
normally do not require a dongle, its addition might be necessary 
in some cases.

Windows Me/98SE/98/95

The Windows 98SE and Me operating systems include IR 
drivers. However, in most cases, the IR port has not been installed 
or configured. From the Control Panel, click on Add New 
Hardware and select Choose Device From List. Select Infrared 
from the list and then select the appropriate infrared port, whether 
built-in or external.

Note: In some instances, the infrared port must be enabled in the 
BIOS of your PC. Consult your computer documentation, 
manufacturer or MIS department. Assistance is also 
available from the Microsoft Support Knowledge Base at 
http://support.microsoft.com.
Establishing IR Communications with the PT878GC B-3
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Appendix C
Ultrasonic Thickness Gauge Theory 
of Operation

All ultrasonic thickness gauging involves timing the round trip of 
a sound pulse in a test material. Because solid metal has an 
acoustic impedance that differs from that of gases, liquids, or 
corrosion products such as scale or rust, the sound pulse will 
reflect from the far surface of the remaining metal. The test 
instrument is programmed with the velocity of sound in the test 
material, and computes the wall thickness from the simple 
formula 

                        Distance = Velocity × Time

Single element transducers use one element as both transmitter 
and receiver. Dual element transducers incorporate separate 
transmitting and receiving elements. These elements are mounted 
on delay lines that are usually cut at an angle to the horizontal 
plane (the roof angle), so that the transmitting and receiving beam 
paths cross beneath the surface of the test piece. This crossed-
beam design of duals provides a pseudo-focussing effect that 
optimizes measurement of minimum wall thickness in corrosion 
applications. Duals are more sensitive than single element 
transducers to echoes from the base of pits that represent 
minimum remaining wall thickness. Also, duals may often be 
used more effectively on rough outside surfaces. Couplant 
trapped in pockets on rough sound entry surfaces can produce 
long, ringing interface echoes that interfere with the near surface 
resolution of single element transducers. With a dual, the receiver 
element is unlikely to pick up this false echo. Finally, duals may 
be designed for high temperature measurements that would 
damage single element contact transducers.
Ultrasonic Thickness Gauge Theory of Operation C-1
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Factors Affecting Performance and Accuracy

A. Surface Condition - Loose or flaking scale, rust, corrosion or 
dirt on the outside surface of a test piece will interfere with the 
coupling of sound energy from the transducer into the test 
material. Thus, any loose debris of this sort should be cleaned 
from the specimen with a wire brush or file before measurements 
are attempted.  Generally it is possible to make corrosion 
measurements through thin layers of rust, as long as the rust is 
smooth and well bonded to the metal below. Some very rough 
cast or corroded surfaces may have to be filed or sanded smooth 
in order to insure proper sound coupling. It may also be necessary 
to remove paint if it has been applied in thick coats, or if it is 
flaking off the metal. While it is often possible to make corrosion 
measurements through thin coats of paint (on the order of a few 
thousandths of an inch or 0.1 - 0.2 mm), thick paint will attenuate 
signals or possibly create false echoes, causing inaccurate 
measurements.

Severe pitting on the outside surface of a pipe or tank can be a 
problem. On some rough surfaces, the use of a gel or grease 
rather than a liquid couplant will help transmit sound energy into 
the test piece. In extreme cases it will be necessary to file or grind 
the surface sufficiently flat to permit contact with the face of the 
transducer. In applications where deep pitting occurs on the 
outside of a pipe or tank it is usually necessary to measure 
remaining metal thickness from the base of the pits to the inside 
wall. There are sophisticated ultrasonic techniques utilizing 
focused immersion transducers that can measure directly from the 
base of the pit to the inside wall, but this is generally not practical 
for field work. The conventional technique is to measure unpitted 
metal thickness ultrasonically, measure pit depth mechanically, 
and subtract the pit depth from the measured wall thickness. 
Alternately, one can file or grind the surface down to the base of 
the pits and measure normally.

As with any difficult application, experimentation with actual 
product samples is the best way to determine the limits of a 
particular gauge/transducer combination on a given surface.
C-2 Ultrasonic Thickness Gauge Theory of Operation
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Factors Affecting Performance and Accuracy 
(cont.)

B. Transducer Positioning/Alignment - For proper sound 
coupling the transducer must be pressed firmly against the test 
surface. On small diameter cylindrical surfaces such as pipes, 
hold the transducer so that the sound barrier material visible on 
the probe face is aligned perpendicular to the center axis of the 
pipe. See Figure C-1 below.

Figure C-1:  Proper Alignment of Transducers for Cylindrical 
Surfaces

While firm hand pressure on the transducer is necessary for good 
readings, the probe should never be scraped along or twisted 
against a rough metal surface. This will scratch the face of the 
transducer and eventually degrade performance. The safest 
technique for moving a transducer along a rough surface is to 
pick it up and reposition it for each measurement, not to slide it 
along.

Transducer
Ultrasonic Thickness Gauge Theory of Operation C-3
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Factors Affecting Performance and Accuracy 
(cont.)

Remember that an ultrasonic test measures thickness at only one 
point within the beam of the transducer, and that in corrosion 
situations wall thicknesses often vary considerably. Test 
procedures usually call for making a number of measurements 
within a defined area and establishing a minimum and/or average 
thickness. Ideally, data should be taken at increments no greater 
than half the diameter of the transducer, to insure that no pits or 
other local variations in wall thickness are missed. It is up to the 
user to define a pattern of data collection appropriate to the needs 
of a given application. 

It is possible that on some severely corroded or pitted materials 
there will be spots where readings cannot be obtained. This can 
happen when the inside surface of the material is so irregular that 
the sound energy is scattered rather than being reflected back to 
the transducer. The lack of a reading may also indicate a 
thickness outside the range of the transducer and instrument 
being used.  Generally, an inability to obtain a valid thickness 
reading at a particular point on a test specimen could be a sign of 
a seriously degraded wall which may warrant investigation by 
other means.

C. Calibration - The accuracy of measurements are only as good 
as the accuracy and care with which the gauge has been 
calibrated. It is essential that the thickness gauge be calibrated (as 
described on page 9-12) whenever the transducer is changed or 
you have a reason to doubt the accuracy of the readings. Periodic 
checks with samples of known thicknesses are recommended to 
verify that the gauge is operating properly.
C-4 Ultrasonic Thickness Gauge Theory of Operation
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Factors Affecting Performance and Accuracy 
(cont.)

D. Taper or Eccentricity - If the contact surface and the back 
surface are tapered or eccentric with respect to each other, the 
return echo again becomes distorted and the accuracy of 
measurement is diminished.

E. Acoustic Properties of the Material - There are several 
conditions found in engineering materials that can severely limit 
the accuracy and thickness range that can be measured.

1. Sound Scattering
In some materials, notably certain types of cast stainless steel, 
cast irons, and composites, the sound energy is scattered from 
individual crystallites in the casting or from dissimilar 
materials within the composite. This effect reduces the ability 
to discriminate a valid return echo from the back side of the 
material and limits the ability to gauge the material 
ultrasonically.

2. Velocity Variations
A number of materials exhibit significant variations in sound 
velocity from point-to-point within the material. Certain types 
of cast stainless steels and brass exhibit this effect due to a 
relatively large grain size and the anisotropy of sound velocity 
with respect to grain orientation. Other materials show a rapid 
change in sound velocity with temperature.  This is 
characteristic of plastic materials where temperature must be 
controlled in order to obtain maximum precision in the 
measurement.

3. Sound Attenuation or Absorption
In many organic materials, such as low density plastics and 
rubber, sound is attenuated very rapidly at the frequencies 
used in normal ultrasonic thickness gaging. Therefore, the 
maximum thickness that can be measured in these materials is 
often limited by sound attenuation.
Ultrasonic Thickness Gauge Theory of Operation C-5
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Appendix D
Material Safety Data Sheets for 
Couplants

A variety of couplants are available for use with GE Sensing 
transducers. To obtain a material safety data sheet (MSDS) for 
any couplant GE Sensing supplies, go to the GE Sensing web site 
and enter the Technical Support portal.
Material Safety Data Sheets for Couplants D-1
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GE
Sensing DECLARATION

OF
CONFORMITY
CERT-DOC-H5 August 2004)

TÜV ESSEN
ISO 9001

U.S.

TÜV

We, Panametrics Limited
       Shannon Industrial Estate

       Shannon, County Clare
      Ireland

declare under our sole responsibility that the

TransPort™ PT878 Portable Ultrasonic Flowmeter
TransPort™ PT878GC Clamp-On Portable Ultrasonic Flowmeter

to which this declaration relates, are in conformity with the following standards:

• EN 61326:1998, Class A, Annex C, Continuous Unmonitored Operation

following the provisions of the 89/336/EEC EMC Directive.

The units listed above and any transducers supplied with them (spoolpieces are addressed 
under a separate declaration of conformity) do not bear CE marking for the Pressure 
Equipment Directive, as they are supplied in accordance with Article 3, Section 3 (sound 
engineering practices and codes of good workmanship) of the Pressure Equipment 
Directive 97/23/EC for DN<25.

Shannon - June 1, 2002
Mr. James Gibson

GENERAL MANAGER



GE
Sensing DECLARATION

DE
CONFORMITE
CERT-DOC-H5 August 2004)

TÜV ESSEN
ISO 9001

U.S.

TÜV

Nous, Panametrics Limited
         Shannon Industrial Estate

         Shannon, County Clare
        Ireland

déclarons sous notre propre responsabilité que les

TransPort™ PT878 Portable Ultrasonic Flowmeter
TransPort™ PT878GC Clamp-On Portable Ultrasonic Flowmeter

rélatif á cette déclaration, sont en conformité avec les documents suivants:

• EN 61326:1998, Class A, Annex C, Continuous Unmonitored Operation

suivant les régles de la Directive de Compatibilité Electromagnétique 89/336/EEC.

Les matériels listés ci-dessus ainsi que les transducteurs pouvant être livrés avec (les 
manchettes faisant l'objet d'une déclaration de conformité séparée) ne portent pas le 
marquage CE de la directive des équipements sous pression, car ils sont fournis en accord 
avec la directive 97/23/EC des équipements sous pression pour les DN<25, Article 3, section 
3 qui concerne les pratiques et les codes de bonne fabrication pour l'ingénierie du son.

Shannon - June 1, 2002
Mr. James Gibson

DIRECTEUR GÉNÉRAL



GE
Sensing KONFORMITÄTS-

ERKLÄRUNG
CERT-DOC-H5 August 2004)

TÜV ESSEN
ISO 9001

U.S.

TÜV

Wir, Panametrics Limited
        Shannon Industrial Estate

        Shannon, County Clare
       Ireland

erklären, in alleiniger Verantwortung, daß die Produkte

TransPort™ PT878 Portable Ultrasonic Flowmeter
TransPort™ PT878GC Clamp-On Portable Ultrasonic Flowmeter

folgende Normen erfüllen:

• EN 61326:1998, Class A, Annex C, Continuous Unmonitored Operation

gemäß den Europäischen Richtlinien, Niederspannungsrichtlinie EMV-Richtlinie
Nr.: 89/336/EG.

Die oben aufgeführten Geräte und zugehörige, mitgelieferte Schallwandler (Messrohre 
werden in einer separaten Konformitätserklärung behandelt) tragen keine
CE-Kennzeichnung gemäß der Druckgeräte-Richtlinie, da sie in Übereinstimmung mit 
Artikel 3, Absatz 3 (gute Ingenieurpraxis) der Druckgeräte-Richtlinie 97/23/EG für DN<25 
geliefert werden.

Shannon - June 1, 2002
Mr. James Gibson

GENERALDIREKTOR
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